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Introduction

This documentation covers the following Steinberg product: Cubase Pro.
Cubase Pro is a powerful audio production system for composing, recording, mixing and editing
music. It comes with an extensive set of functions and tools for music notation and score
printing.

Platform-Independent Documentation
The documentation applies to the operating systems Windows and macOS.
Features and settings that are specific to one of these platforms are clearly indicated. In all other
cases, the descriptions and procedures in the documentation are valid for Windows and macOS.
Some points to consider:
●

The screenshots are taken from Windows.

●

Some functions that are available on the File menu on Windows can be found in the
program name menu on macOS.

About the Documentation
The documentation consists of several documents. You can read them online or download them
from steinberg.help. To visit steinberg.help, do one of the following:
●
●

Enter www.steinberg.help in the address bar of your web browser.
In the program, select Help > Cubase Help.

Quick Start Guide
Covers the following areas without going into details:
●

System requirements, installation procedure, and license activation.

●

Setting up your system for audio and MIDI work.

Operation Manual
The main Cubase reference documentation, with detailed descriptions of operations,
parameters, functions, and techniques.
Score Layout and Printing (Cubase Pro only)
Describes the professional music notation, score editing, and printing features
included in the Score Editor.
Remote Control Devices
Lists the supported MIDI remote control devices.
Plug-in Reference
Describes the features and parameters of the included VST plug-ins, VST
instruments, and MIDI effects.
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HALion Sonic SE
Describes the features and parameters of the included VST instrument HALion Sonic
SE.
Groove Agent SE
Describes the features and parameters of the included VST instrument Groove Agent
SE.
Retrologue
Describes the features and parameters of the included VST instrument Retrologue.
MIDI Devices
Describes how to manage MIDI Devices and device panels.
VST Connect SE (Cubase Pro only)
Describes how to work with the VST Connect SE features.

Conventions
In our documentation, we use typographical and markup elements to structure information.

Typographical Elements
The following typographical elements mark the following purposes.
PREREQUISITE
Requires you to complete an action or to fulfill a condition before starting a
procedure.
PROCEDURE
Lists the steps that you must take to achieve a specific result.
IMPORTANT
Informs you about issues that might affect the system, the connected hardware, or
that might bring a risk of data loss.
NOTE
Informs you about issues that you should consider.
EXAMPLE
Provides you with an example.
RESULT
Shows the result of the procedure.
AFTER COMPLETING THIS TASK
Informs you about actions or tasks that you can perform after completing the
procedure.
RELATED LINKS
Lists related topics that you can find in this documentation.

Markup
Bold text indicates the name of a menu, option, function, dialog, window, etc.
EXAMPLE
To open the Functions menu, click Functions Menu in the top right corner of the MixConsole.
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If bold text is separated by a greater-than symbol, this indicates a sequence of different menus
to open.
EXAMPLE
Select Project > Add Track.

Key Commands
Many of the default key commands, also known as keyboard shortcuts, use modifier keys, some
of which are different depending on the operating system.
When key commands with modifier keys are described in this manual, they are shown with the
Windows modifier key first followed by the macOS and the key:
●

Windows modifier key/macOS modifier key-Z

EXAMPLE
Ctrl/Cmd-Z means: press Ctrl on Windows or Cmd on macOS, then press Z.
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How the Score Editor works

About this chapter
In this chapter you will learn:
●

How the Score Editor and MIDI data relate.

●

What Display Quantize is and how it works.

Welcome!
Welcome to scoring in Cubase! The Score Editor has been created to allow you to get any
possible piece of music displayed as a score, complete with all the necessary symbols and
formatting. It allows you to extract parts out of a full orchestra score, to add lyrics and
comments, create lead sheets, score for drums, create tablature, etc. In other words: just about
any type of notation you could ever desire!
There are a few basic principles to how the Score Editor works, which you have to understand to
make full use of it.

How the Score Editor operates
The Score Editor does the following:
●

Reads the MIDI notes in the MIDI parts.

●

Looks at the settings you have made.

●

Decides how the MIDI notes are displayed according to the settings.

The Score Editor takes MIDI data and settings as input and produces a score as output.
The Score Editor does all this in realtime. If you change some of the MIDI data (for example by
moving or shortening a note) this is immediately reflected in the score. If you change some of
the settings (for example the time signature or key signature) this is also immediately apparent.
Do not think of the Score Editor as a drawing program, but rather as an “interpreter” of MIDI
data.

MIDI notes vs. score notes
MIDI tracks in Cubase hold MIDI notes and other MIDI data. As you may know, a MIDI note
in Cubase is only defined by its position, length, pitch and velocity. This is not nearly enough
information to decide how the note is to be displayed in a score. The program needs to know
more: What type of instrument are we talking about, Drums? Piano? What key is the piece in?
What is the basic rhythm? How should the notes be grouped under beams? You provide this
information by making settings and working with the tools available in the Score Editor.
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An example of the MIDI/score relationship
When Cubase stores a MIDI note’s position, it makes the measurement in an absolute value,
called ticks. There are 480 ticks to a quarter note. Have a look at the example below:

A quarter note at the end of a 4/4 measure

The note is on the fourth beat of the measure. Now, let’s say you change the time signature to
3/4. This shortens the length of a “measure” to only three quarter notes – 1440 ticks. Suddenly
our quarter note is in the next measure:

The same note in 3/4

Why? Since you are not changing the MIDI data in the track/part (that would ruin your recording!)
by changing the time signature, the note is still at the same absolute position. It is just that now
each “measure” is shorter, which effectively moves the note in the score.
What we are trying to get across here is that the Score Editor is an “interpreter” of the MIDI
data. It follows rules that you set up by making settings in dialogs, on menus, etc. And this
interpretation is “dynamic”, or in other words, it is constantly updated whenever the data (the
MIDI notes) or the rules (the score settings) change.

Display Quantize
Let’s say you used the Project window to record a figure with some staccato eighth notes. When
you open the Score Editor, these notes are displayed like this:

This does not look anything like what you intended. Let’s start with the timing – obviously, you
were off at a couple of places (the third, fourth and last note all seem to be a 32nd note late). You
can solve this by quantizing the figure, but this would make the passage sound too “stiff”, and
not fit in the musical context. To resolve this problem the Score Editor employs something called
“Display Quantize”.
Display Quantize is a setting which is used to tell the program two things:
●

How precise the Score Editor is to be when displaying the note positions.

●

The smallest note values (lengths) you want displayed in the score.

In the example above, the Display Quantize value seems to be set to 32nd notes (or a smaller
note value).
Let’s say we change the Display Quantize value to sixteenth notes in the example:

With Display Quantize set to sixteenth notes

OK, now the timing looks right, but the notes still do not look like what you intended. Maybe you
can understand that from a computer’s point of view, you did play sixteenth notes, which is why
there are a lot of pauses. But that’s not how you meant it. You still want the track to play back
short notes, because it is a staccato part, but you want something else “displayed”. Try setting
the Display Quantize value to eighth notes instead:
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With Display Quantize set to eighth notes

Now we have eighth notes, as we wanted. All we have to do now is to add staccato articulation
which can be done with one simple mouse click using the Draw tool or using musical
articulations.
How did this work? By setting the Display Quantize value to eighth notes, you give the program
two instructions that would sound something like this in English: “Display all notes as if they were
on exact eighth note positions, regardless of their actual positions” and “Don’t display any notes
smaller than eighth notes, regardless of how short they are”. Please note that we used the word
“display”, which leads us to one of the most important messages of this chapter:
IMPORTANT
Setting a Display Quantize value does not alter the MIDI notes of your recording in any way,
as regular quantizing does. It only affects how the notes are displayed in the Score Editor (and
nowhere else)!

RELATED LINKS
Working with symbols on page 103

Choose your Display Quantize values with care
As explained above, the Display Quantize value for notes puts a restriction on the smallest note
value that can be displayed. Let’s see what happens if we set it to quarter notes:

With Display Quantize set to quarter notes

Oops, this doesn’t look too good. Well of course it doesn’t! We have now instructed the program
that the “smallest” note that occurs in the piece is a quarter note. We have explicitly told it that
there are no eighth notes, no sixteenths, etc. So when the program draws the score on screen
(and on paper) it quantizes the display of all our eighth notes to quarter note positions, which
makes it look like above. But again, please note that when you hit Play, the passage still plays as
it originally did. The Display Quantize setting only affects the score image of the recording.
IMPORTANT
Even if you manually enter notes in the score using perfect note values, it is very important
that you have your Display Quantize settings right! These values are not just used for MIDI
recordings! If you for example set the Display Quantize value for notes to quarter notes and start
clicking in eighth notes, you get eighth notes in the track (as MIDI data), but still only quarter
notes in the display!

Using Rests as Display Quantize setting
Above we used Display Quantize for notes. There is a similar Display Quantize setting called
“Rests” which is used to set the smallest rest to be displayed. Often, this setting is very effective.
Let’s start with the following note example:

As you see, the first note appears one sixteenth note late. If we change the Display Quantize
value for notes to eighth notes, the score is displayed like this:
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With Display Quantize: Notes set to eighth notes

Unfortunately, this moves the first note to the same position as the second, since sixteenth
note positions are not allowed. We can solve this by inserting extra Display Quantize values
within the bar with the Display Quantize tool, but there is a much easier way: Change the Display
Quantize value for notes back to sixteenths, but set the value for rests to eighth notes! This tells
the program not to display any rests smaller than eighth notes, except when necessary. The
result looks like this:

With Display Quantize: Notes set to sixteenth notes, but Rests set to eighth notes.

How did this work? Well, you instructed the program not to display any rests smaller than eighth
notes, except when “necessary”. Since the first note appeared on the second sixteenth note
position, it was necessary to put a sixteenth rest at the beginning of the figure. All other rests can
be hidden by displaying the notes as eighth notes, and were therefore not “necessary”.
This leads us to the following general guidelines:
●

Set the Notes value according to the “smallest note position” you want to be shown in the
score. If you have notes on odd sixteenth note positions, for example, set the Notes to
sixteenth notes.

●

Set the Rests value according to the smallest note value (length) you want to be displayed
for a single note, positioned on a beat.
Common Display Quantize settings would be to have Notes set to 16 (sixteenth notes) and
Rests set to 4 (quarter notes).

RELATED LINKS
Inserting Display Quantize changes on page 34

Handling exceptions
Unfortunately, the guidelines above do not work perfectly in every situation. You may for
example have a mix of straight notes and tuplets of different types, or you may want to display
equally long notes with different note values depending on the context. There are several
methods you can try:

Automatic Display Quantize
If your score contains both straight notes and triplets, you can use Auto Quantize. If this option
is activated, Cubase tries to “understand” whether the notes should be displayed quantized to
straight notes or triplets.
RELATED LINKS
If your music contains mixed straight notes and triplets on page 62

Using the Display Quantize tool
With the “Q” tool, you can insert new Display Quantize values anywhere in the score. Inserted
Display Quantize values affect the staff from the insertion point onwards.
RELATED LINKS
Inserting Display Quantize changes on page 34
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Permanent alteration of MIDI data
As a last resort, you can resize, quantize or move the actual note events. However, this would
result in the music not playing back like it originally did. Often it is possible to get the score to
look the way you want without altering any MIDI data.

Entering notes by hand vs. recording notes
Sometimes you enter and edit notes by hand (or rather using the mouse and/or the computer
keyboard) and at other times you record them from a MIDI keyboard. Most of the time, you do a
combination of both. In real life, even if you have recorded the piece perfectly, you often have to
do some permanent editing to your recording before printing.
RELATED LINKS
Transcribing MIDI recordings on page 32
Entering and editing notes on page 38
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About this chapter
In this chapter you will learn:
●

How to open the Score Editor.

●

How to switch between Page Mode and Edit Mode.

●

How to set up the page size and margins.

●

How to hide and show the Symbols Inspector, the toolbar, and the extended toolbar.

●

How to set up the ruler.

●

How to set a zoom factor.

●

How to make initial settings for clef, key, and time signature.

●

How to transpose instruments.

●

How to print and export your score.

Preparations
PROCEDURE
1.

In the Project window, create a MIDI track for each instrument.
You can prepare a piano (split) staff from a single track, that is, there is no need to create
one track for the bass clef and one for the treble clef.

2.

Name each track after the instrument.
This name can later be used in the score if you like.

3.

Record on the tracks or create empty parts on all tracks.
You can make very long parts that cover the entire project, or you can start out with
shorter parts to begin with. If you choose the latter option, you can always go back later
and add new parts or copy existing parts.

Opening the Score Editor
Editing one or several parts
To open one or several parts in the Score Editor, select the parts (on the same or on different
tracks) and select “Open Score Editor” from the MIDI menu or from the Scores menu. The default
key command for this is Ctrl/Cmd-R.
●

You can also select the Score Editor as your default editor, allowing you to open it by
double-clicking parts.
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This is done with the Default MIDI Editor pop-up menu in the Preferences dialog (Editors
page).

Editing whole tracks
When preparing a score for printing, you probably want to open whole MIDI tracks in the Score
Editor. To do this, select the tracks in the track list and make sure no parts are selected – then
open the Score Editor.

Editing parts on different tracks
If you have selected parts on two or more tracks (or several entire tracks – no parts) and open the
Score Editor, you get one staff for each track. However, you can split a staff in two when scoring
for piano, for example. Think of the Project window as an overview of your entire score and the
tracks as representing one instrument each.

Editing predefined combinations of tracks
You can open the Score Editor for a certain combination of tracks that you edited before.
RELATED LINKS
Layout operations on page 155

Displaying single voices or the complete score
If the Double-click on staff flips between full score/part option is activated in the Preferences
dialog (Scores–Editing page), double-clicking on the rectangle to the left of a staff switches
between display of either the whole score or the current voice.

The project cursor
The project cursor appears as a vertical line across the staff. When you open the Score Editor, the
view is automatically scrolled so that the project cursor is visible in the window. This means you
do not always see the beginning of the edited part when you first open the Score Editor.
●

Hold down Alt and Shift and click anywhere in the score to move the project cursor there.
This is handy when the project cursor is not visible. This is not possible if Computer
Keyboard Input mode is activated.

RELATED LINKS
Entering notes using the computer keyboard on page 42
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Playing back and recording
You can play back and record MIDI in the Score Editor using the standard transport commands,
just like in the other MIDI editors.

Page Mode
When you are preparing a score for printout, you should set the Score Editor to Page Mode. This
is done by selecting Page Mode from the Scores menu. If Page Mode is activated, a checkmark
appears next to this menu option.

In Page mode, the window switches to display one page at a time, as it appears on printout.

Page Mode vs. Edit Mode
If Page Mode is not activated, the Score Editor is in Edit Mode. All you can do in Edit Mode, you
can also do in Page Mode. But Page Mode offers lots of additional features which are directly
related to how the score is displayed and printed.
IMPORTANT
This section of the manual assumes you are in Page Mode. It is mentioned explicitly if something
in this text specifically relates to Edit Mode.

Changing the Background in Page Mode
In Page Mode, you can specify different background textures for the score by selecting an option
from the Background Texture pop-up menu on the toolbar.
NOTE
The background texture only affects the display and is not used for printing.

Using the scrollbars in Page Mode
In Page Mode, the scrollbars are used to scroll the image of the page inside the window.

Moving between pages in Page Mode
If your score takes up more than one page, you use the page number indicator in the lower right
corner to move to another page in your score. The number can be adjusted using the standard
editing techniques.

The page number indicator – adjust it to move to another page.

Also, if Auto-Scroll is activated on the toolbar, the score display follows the project cursor
position. This way you can scroll the score by using fast forward or rewind.
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Editing individual parts in Page Mode
When you view a single part in Page Mode, the bars before and after the part is normally shown
as empty measures in the Score Editor. This is to preserve the layout of the track, that is, the
spacing between staves and barlines, number of bars per staff, etc.
If you want to view and print a single part, without any surrounding empty bars, activate the
“Unlock Layout when editing single parts” option in the Preferences dialog (Scores–Editing page).
Note, however, that if you adjust the layout when editing the part in this mode, this erases the
layout for the whole track!

Changing the zoom factor
There are two ways to change the zoom in Page Mode: by setting a zoom factor on the zoom
pop-up menu or by using the Zoom tool.

Using the Zoom pop-up menu
Above the vertical scrollbar to the right you can find a pop-up menu allowing you to set the zoom
factor.

By zooming in you can make detailed adjustments to symbols, etc. By zooming out you get a
better overview.
●

If you select “Fit Page”, the zoom factor is adjusted according to the window size so that
the whole page becomes visible.

●

If you select “Fit Width”, the zoom factor is adjusted according to the window width so that
the full width of the page becomes visible.

NOTE
This pop-up menu can also be opened by right-clicking in the ruler.

Using the Zoom tool
The Zoom tool in the Score Editor works much like in the Project window:
●

Click once with the Zoom tool to zoom in one step.

●

Hold down Alt and click once with the Zoom tool to zoom out one step.

●

Drag a rectangle with the Zoom tool to set a custom zoom factor.
The section encompassed by the rectangle is zoomed to fill the window.
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●

Hold down a modifier key and right-click with the Zoom tool to open the Zoom context
menu, and select the desired Zoom setting.

Using the Mouse wheel
You can also zoom by holding down Ctrl/Cmd and moving the mouse wheel. The mouse position
is kept (if possible) when zooming in or out.

The active staff
Only one staff at a time can be active, and it is indicated by a rectangle to the left of the clef
symbol.

This staff is active.

NOTE
To make a staff active, click anywhere on it. By default, you can also use the Up Arrow and Down
Arrow keys to step between staves.

Making page setup settings
Before preparing the score for printout, you have to make some page settings for your project.
This does not have to be the first thing you do, but it is a good working habit, because it also
affects the on-screen display of the score.
PROCEDURE
1.

On the File menu, select Page Setup.
The Page Setup dialog appears. This is the regular operation system Page Setup dialog,
described in detail in your system’s documentation. The only things that Cubase adds to
this are the margin settings.

2.

Select the preferred printer, paper size, orientation, etc.

3.

If you need to, change the margins by setting the left, right, top and bottom settings.
To make the settings permanent, save the project.
If you want new projects to always start with certain page setup settings, you can create
project templates.

Designing your work space
You can design your work space according to your needs by showing/hiding different areas
using the Window Layout function and by showing/hiding different options of these areas using
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the Setup options dialogs. Which areas and options to show or hide depends on what kind of
project you are working on, how large your monitor is, and so on.

Window layout

1

Status line

2

Info line

3

Extended toolbar

4

Filter bar

5

Symbols Inspector

Configuring the window layout
PROCEDURE
1.

On the toolbar, click the “Set up Window Layout” button.

2.

Activate the desired options.

The status line
The status line features the Mouse Time and the Mouse Note Position displays as well as the
Current Chord Display, which helps you identify chords in the Score Editor note display. It can be
hidden/displayed using the “Status Line” option in the “Set up Window Layout” pane.
The status line has its own Setup dialog where you can specify exactly which properties you want
to see.
●

Right-click on the status line and select “Setup…” from the context menu.
In the dialog that appears you can configure where the separate items will be placed and
save/recall different setup configurations.

The info line
The info line displays information about the selected note. It can be shown and hidden using the
“Info Line” option in the “Set up Window Layout” pane.
The info line has its own setup dialog where you can specify exactly which properties are shown.
●

Right-click on the info line and select “Setup…” from the context menu.
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In the dialog that appears you can configure where the separate items will be placed and
save/recall different setup configurations.

The extended toolbar
The extended toolbar contains additional tools for your score. It can be hidden/displayed using
the Tools option in the “Set up Window Layout” pane.

The filter bar
This area contains checkboxes determining which indicators, handles, and other non-printed
elements are shown in the score. It can be hidden/displayed using the Filters option in the “Set
up Window Layout” pane.

Showing and hiding elements
Some of the elements in the score are not printed, but rather serve as indicators for layout
changes, handles, etc. These elements can be hidden or shown in any combination by using the
Filters options.
The following options are available:
Bar Handles
Displays the bar handles, used for copying bars.
Hidden Notes
Displays any notes you might have hidden.
Hide
Displays markers in the score for each hidden element (except notes).
Quantize
Displays markers in the score where you have made Display Quantize “exceptions”.
Layout Tool
Displays markers in the score where you have made adjustments with the Layout
tool.
Grouping
Displays markers in the score where you have made beam groupings.
Cutflag
Displays markers in the score where you have inserted cutflag events.
Split Rests
Displays markers in the score wherever you have split multiple rests.
Stems/Beams
Displays markers in the score where you have made any stem or beam adjustments.
RELATED LINKS
Moving and duplicating with the bar handles on page 121
Hiding/showing objects on page 166
Inserting Display Quantize changes on page 34
Graphic moving of notes on page 96
Grouping on page 88
The Cut Notes tool on page 95
Splitting multi-rests on page 168
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Setting stem direction on page 80
Manual adjustment of beams on page 93

The Symbols Inspector
This area allows you to add symbols to the score. It can be hidden/displayed using the Symbols
option in the “Set up Window Layout” pane.
The symbol sections can also be opened as free-floating palettes by opening them, right-clicking
any of the buttons and selecting “Open as Palette” from the context menu. This way you can
move symbol palettes around on the screen by clicking and dragging their title bars. Rightclicking on a symbol palette brings up a pop-up menu:
●

Select “Toggle” to switch between a vertical or horizontal view of the palette.

●

Select one of the options on the pop-up menu to bring up the corresponding palette
instead of the current palette.

●

Hold down Ctrl/Cmd and select a palette from the pop-up menu to open the selected
palette in a new window (without closing the existing one).

●

Click the close button to close a symbol palette.

In the Symbols Inspector setup dialog you can specify exactly which symbol sections are shown.
RELATED LINKS
The Symbols Inspector Setup dialog on page 105
Working with symbols on page 103

The ruler
In the Score Editor there are no meter/time position rulers as in the other editors. Instead, there
are horizontal and vertical “graphic rulers” in Page Mode. These help you to position symbols and
graphical objects in the score.

●

To specify which units to show on the rulers, open the Zoom pop-up menu and select one
of the options.
You can choose between points, inches, and centimeters.

●

To hide the rulers, select “Off” from the pop-up menu.
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The Position Info window
To help you when positioning objects in the score, the Page Mode has a special Position Info
window, in which you can view and adjust object positions numerically, in the unit selected for
the ruler. To display the Position Info window, click in the ruler.

About the Score Editor context menus
Many functions and settings of the Score Editor can be accessed via context menus, opened
by right-clicking on certain elements of the score. For example, if you choose a note, the note
context menu opens, listing note-related functions.
If you open the context menu on an empty area of the score, it lists all available tools (allowing
you to quickly switch between tools) and it contains many functions of the main menus.

About dialogs in the Score Editor
There are two types of dialogs available in the Score Editor:
●

Non-modal dialogs can remain open while you continue working in the score.
In a non-modal dialog, clicking the Apply button applies the settings in the dialog to the
selected objects in the score. This means you can select different elements in the score and
change their settings, without having to close the dialog in between.
The dialog is closed by clicking the standard close button in the window title bar. The Score
Settings dialog is an example for a non-modal dialog.

●

Regular dialogs have an OK button instead of an Apply button.
Clicking OK applies the settings you have made and closes the dialog. You cannot continue
working in the score (or select other objects) until you close the dialog.

NOTE
If the “Apply closes Property Windows” option is activated in the Preferences dialog (Scores–
Editing page), clicking the Apply button in a non-modal dialog closes the dialog. In other words,
this makes a non-modal dialog work a bit more like a regular dialog.

Setting clef, key, and time signature
When preparing to enter notes into a score, you probably want to start out by setting the desired
clef, key, and time signature for the staff. The text below assumes you are working on one track
only. If you have multiple staves, you either make this setting independently for each staff or for
all staves at once.
Normally, all these symbols appear at the beginning of each staff. However, you can control this
by using the Real Book option and by hiding objects.
IMPORTANT
In the Score Settings dialog on the Project–Notation Style subpage (Keys category) you can find
the “Key Changes for the entire Project” option. If this option is activated, all changes made to the
key always affect every staff in the project, that is, it is not possible to define different keys for
different staves.
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RELATED LINKS
Staff settings on page 58
Real Book on page 165
Hiding/showing objects on page 166

Using the Symbols Inspector to set the initial clef, key, and time
signature
PROCEDURE
1.

Click the “Set up Window Layout” button on the toolbar and activate the Symbols option.
The Symbols Inspector is displayed.

2.

Open the Clefs section of the Inspector and click on the symbol for the clef that you want
to use in your score.

3.

Click anywhere in the first bar of the staff to set the clef for this track.

4.

Open the Keys section and click on the symbol for the key that you want to use.

5.

Click anywhere in the first bar of the staff to set the key for the track.

6.

Open the Time Signature section of the Inspector and click on the symbol for the time
signature value that you want to use.
If you cannot find the desired time signature, you can use the Edit Time Signature dialog.

RESULT
The settings you have made so far are valid for the entire track.

Editing the time signature
PROCEDURE
1.

Double-click on the time signature symbol at the beginning of the staff.
A dialog opens.

2.

If the project is in 4/4 or 2/2, you can select common time/cut time directly by clicking one
of the two symbols on the right.
This sets the time signature to 4/4 or 2/2, respectively and also inserts a common/cut time
symbol on the staff.

3.

If the project is in any other time, set the numerator and denominator above and below
the line, respectively.
The numerator can consist of several numbers for composite time signatures. However, if
the project is in a simple time signature you only need to fill in the first number above the
line. The more advanced options are described below.

4.

Click OK or press Return.
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IMPORTANT
All tracks share the time signature! In other words, when you set the time signature, you
do this for all tracks in the project.
If you need to enter half a bar somewhere, you must make a time signature change from
4/4 to 2/4 and back again, for example.

RELATED LINKS
By using the Pickup Bar feature on page 170
Inserting and editing clefs, keys, or time signatures on page 55

Composite time signatures and the For Grouping Only option
For composite signatures, the numerator can be made up of up to 4 groups. For example,
“4+4+3+/” on the upper line and 8 on the lower means the time signature is 11/8.
The reason for dividing the numerator into several numbers is to get beaming and tied notes
displayed correctly automatically. This does not affect the metronome or anything else, only
beams and ties.
If “For Grouping Only” is not activated, the numerator shows all the numbers entered. If it is
activated, it shows the sum of the numbers entered, as for “simple” time signatures.

“For Grouping Only” off and on

Note that Cubase tries to preserve the denominator when you insert a composite signature with
“For Grouping Only” activated. This means that if you have a 4/4 time signature, and change it to
a composite value (3+3+2 eighths for example), the time signature still is displayed as 4/4 instead
of 8/8.
RELATED LINKS
Handling beaming on page 88

Setting the time signature on the Transport panel

You can also set the time signature directly on the Transport panel. Please note that you cannot
create composite time signatures from the Transport panel.

Setting the time signature using the signature track/Tempo Track Editor
You can also add, edit, and delete time signatures using the signature track or the Tempo Track
Editor.
Please note the following:
●

The score always shows the time signature events set in the signature track/Tempo Track
Editor, regardless of whether or not the Tempo button is activated. Likewise, any time
signatures you create in the Score Editor are shown in the signature track/Tempo Track
Editor.

●

You cannot create composite time signatures using the signature track/Tempo Track
Editor.
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Editing the clef
On the clef context menu
When you right-click on a clef symbol, a context menu with a list of all available clefs opens. This
menu also contains the following options:
●

Display Clef Changes as Small Symbols
If you activate this option and insert a clef change in the score, the clef is displayed with a
smaller symbol.

●

Warnings for new Clefs at Line Breaks
If you activate this option and insert a new clef at a line break, the Clef change symbol is
inserted in the last bar before the staff break. If this option is deactivated, the symbol is
inserted in the first bar of the next staff line.

●

Hide
If you select this function, the clef is hidden.

●

Properties
If you select this function, the Edit Clef dialog opens.

In the Edit Clef dialog
PROCEDURE
1.

Double-click on the current clef.
A dialog appears.

2.

Use the scrollbar to select a clef.
IMPORTANT
This does not work if Auto Clef is activated on the Staff page of the Score Settings dialog.

3.

Repeat the steps above for all staves in the system.

On the Staff page of the Score Settings dialog
PROCEDURE
1.

Click on a staff to make it the active staff.

2.

On the Scores menu, select “Settings…” to open the Score Settings dialog. Select the Staff
page at the top to open the Main tab, showing the current settings for the active staff.
You can also double-click to the left of a staff to make it active and bring up the Score
Settings dialog in one go. If this does not work, the “Double-click on staff flips between full
score/part” option in the Preferences dialog (Scores–Editing page) may be activated.
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3.

In the Clef/Key section, use the scrollbar on the left to select one of the available clefs.

4.

Click Apply.
NOTE
You can select another staff in the score and make settings for it without having to close
the Score Settings dialog first.

RELATED LINKS
Displaying single voices or the complete score on page 14
Inserting and editing clefs, keys, or time signatures on page 55

In a split system
If you have a split system you can set different clefs for the upper and lower staff.
PROCEDURE
1.

Open the Score Settings dialog on the Staff page.

2.

Select a clef for the upper staff.

3.

Activate the “Lower Staff” checkbox.

4.

Set a clef for the lower staff.

RELATED LINKS
Split (piano) staves on page 53
Strategies: How many voices do I need? on page 72

Using Auto Clef

On the Staff page of the Score Settings dialog you also find the Auto Clef option. If this option is
activated, the program automatically selects a treble clef or a bass clef for the staff, depending
on the range of the notes in the part.
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Editing the key
IMPORTANT
In the Score Settings dialog on the Project–Notation Style subpage (Keys category), you can find
the “Key Changes for the entire Project” option. If this option is activated, all changes made to
the key always affect every staff in the project. You cannot define different keys for different
staves other than the relative display transpose settings for instruments made on the Staff page.
Furthermore, on the Staff page, you can set any staff to not show key signatures.
Therefore, when you want to edit the key, decide if you want the key change to apply to the
entire project, or if you want to use different keys on different staves:
●

If the key set at the beginning of the track is to be used on all staves, and if any
subsequent key changes are also valid for all staves, then leave the “Key Changes for the
entire Project” option activated.

●

If you want to use different keys on different staves, make sure that the “Key Changes for
the entire Project” option is deactivated.

On the key context menu
When you right-click on a key symbol, a context menu with a list of all available keys opens. This
menu also contains the following options:
●

Key Changes for the entire Project
If this option is activated, all changes made to the key always affects the entire project, so
that it is not possible to define different keys for different staves.

●

Hide
If you select this, the key is hidden.

●

Properties
If you select this, the Edit Key dialog opens.

In the Edit Key dialog
If the current key is anything but C major/A minor (no accidentals), you can set the key directly in
the score:
PROCEDURE
1.

Double-click on the accidentals at the beginning of a staff.
The “Edit Key” dialog opens.

2.

Use the scrollbar to select a key and click OK.

RELATED LINKS
Transposing instruments on page 28

On the Staff page of the Score Settings dialog
PROCEDURE
1.

Make the desired staff active, open the Score Settings dialog and select the Staff page.
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The Clef/Key section on the Staff page

2.

Use the right scrollbar in the Clef/Key section to select the desired key.

3.

Click Apply.
NOTE
You can select other staves in the score and make settings for these, without having to
close the Score Settings dialog.

Setting the key for a split system
If you have a split system with two staves you can set different keys for the upper and lower staff.
PROCEDURE
1.

Click in the system to make one of its staves the active staff.

2.

Open the Score Settings dialog on the Staff page.

3.

Set a key for the upper staff.
This automatically sets the lower staff to the same key.

4.

If you need to set a different key for the lower staff, activate the “Lower Staff” checkbox
and set a key for this.

RELATED LINKS
Split (piano) staves on page 53
Strategies: How many voices do I need? on page 72

Setting a local key
You can also set a different key for the selected staff only. This is useful for instruments like oboe
and English horn that change display transpose and therefore also the key.
PROCEDURE
1.

Make the desired staff active, open the Score Settings dialog and select the Staff page.

2.

Activate the “Local Keys” option on the Main subpage in the Clef/Key section.
NOTE
This option is only available if “Key Changes for entire Project” is activated in the Score
Settings dialog, on the Project–Notation Style subpage (Keys category).

3.

Use the scrollbar to the right to set the desired key.

4.

Click Apply to set the selected key for the staff.
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Transposing instruments
Scores for some instruments, for example a lot of brass instruments, are written transposed.
Therefore, the Score Editor provides a Display Transpose function. With this function notes are
transposed in the score without affecting the way they are played back. This allows you to record
and play back a multi-staff arrangement, and still score each instrument according to its own
transposition.

Setting Display Transpose
PROCEDURE
1.

Make the desired staff active, open the Score Settings dialog and select the Staff page.

2.

In the Display Transpose section, select your instrument from the Transpose pop-up menu
or adjust the value directly in the Semitones field.

Transpose pop-up menu

3.

Click Apply.
IMPORTANT
Display Transpose does not affect MIDI playback!

Display Transpose in the Edit Key dialog
If you want to change the Display Transpose setting in the middle of the score, you can do this by
inserting a key change. In the Edit Key dialog, which is opened by double-clicking a key symbol,
you can find a Transpose field, in which you can enter a transposition value in semitones. This is
useful if you are for example writing a saxophone part and want the player to switch from alto to
tenor saxophone.
NOTE
Note that you enter an absolute Display Transpose value that is used from this point on. In other
words, this setting is not relative to any Display Transpose settings you made on the Staff page of
the Score Settings dialog.

RELATED LINKS
Inserting and editing clefs, keys, or time signatures on page 55

Disabling Display Transpose
You can also disable Display Transpose by deactivating the “Display Transpose” button on the
Score Editor toolbar. This can be useful if you work with transposing instruments and want to
show the concert key and not the scored key.
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Printing from the Score Editor
When you have made all necessary changes to the score display and you are satisfied with the
result, you can print your score.
PROCEDURE
1.

On the Scores menu, activate “Page Mode”.
Printing is only possible from within Page Mode.

2.

Select Page Setup from the File menu and make sure all your printer settings are correct.
Close the dialog.
IMPORTANT
If you change your setting for paper size, scale, and margins now, the score may change
its look.

3.

Select Print from the File menu.

4.

A standard print dialog appears. Fill out the options as desired.

5.

Click Print.

Exporting pages as image files
You can export a section of a page or a complete page in various file formats. This allows you to
import your scores into desktop publishing and drawing applications.

Selecting a section of a page for exporting
If you only want to export a part of a certain page, proceed as follows:
PROCEDURE
1.

Make sure that you are in Page Mode.

2.

Select the Export tool (“Select Export Range”).
The pointer turns into a cross-hair cursor.

3.

Drag over the section of the score you want to include.
The area is indicated by a rectangle.
●

You can adjust the size of the rectangle by clicking and dragging its handles with the
Object Selection tool.

●

You can move the rectangle to another position in the score by clicking and
dragging.

To export the selected range, you have two possibilities:
●

Double-click inside the rectangle while it is selected.
This opens the Export Scores dialog, where you can make settings for the file to be
created.

●

Use the Export Scores function.

Exporting
To export the score, proceed as follows:
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PROCEDURE
1.

Make sure that you are in Page Mode.

2.

Select the page that you want to export.

3.

Open the File menu, open the Export submenu and select “Export Scores…”.
The Export Scores dialog appears.

4.

Select a picture format.

5.

Specify a resolution for the file.
This determines the accuracy with which the image is created. 300 dpi, for example, is the
resolution many laser printers use for printing. If the image file is only displayed on screen
in other programs, select 72 or 96 (depending on screen resolution) and it has the same
size as it had in Cubase.

6.

Specify name and location for the file and click Save.
The page of the score is exported and saved as a file. It can now be imported into any
program supporting the selected file format.

Working order
When you prepare a score, we suggest you do things in the following order, since this minimizes
the time needed if you make a mistake somewhere and need to redo a step.
●

Preferably work on copies of recorded tracks.
If the parts are fairly complex you might have to change them permanently, after which
they do not play back as they originally did.

●

If memory is an issue, break the score up into segments.
You might for example use the Split Loop function from the Functions submenu on the
Edit menu to split the parts across all tracks.

●

Arrange the tracks in the Project window in the order you want them displayed in the
score.
You cannot rearrange the order of systems in the Score Editor. However, you can go back
and change the order in the Project window at any time.

●

When opening the Score Editor, begin with the adjustments described above.
You should always begin by setting page margins, etc.

●

If you have recorded music into tracks already, try adjusting the graphic display of the
score as much as possible without permanently editing the notes.
Use the Score Settings, Display Quantize, Grouping, etc.

●

If the tracks are empty, make basic staff settings, enter the notes and then make detailed
adjustments, add Display Quantize, etc.

●

If needed, use polyphonic voicing to resolve overlapping notes, create piano systems,
handle crossing voices, etc.

●

When all this is done, decide if you need to perform “destructive” editing.
You might for example have to permanently alter the length or position of some of the
recorded notes.

●

Hide unwanted objects and add note-dependent and note-related symbols.
This includes accents, dynamic symbols, crescendo, slurs, lyrics, “graphic rests”, etc.

●

Work through the score and adjust the number of bars across the page.

●

Adjust the vertical spacing between staves and grand staves.
The last two steps can be performed automatically by the program using the Auto Layout
features.
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●

Add layout symbols like endings, page text, etc.

●

Print or export the score.

●

Go back and create alternative layouts to extract voices, for example.

Force update
If for some reason the screen is not redrawn properly (as a result of the computer’s recalculation
of the appearance of the page), you can select “Force Update” from the Functions submenu on
the Scores menu or click the Force Update button on the extended toolbar. This forces a redraw
of the whole page.
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About this chapter
In this chapter you will learn:
●

How to prepare your parts for score printouts.

●

How to use the Display Quantize tool to handle “exceptions” in the score.

●

How to resolve parts that contain mixed notes and triplets.

About transcription
This chapter assumes you have a MIDI recording that you want to transform into a printable
score. However, if the parts are fairly complicated, you probably need to perform some manual
editing of the notes.
IMPORTANT
Before starting, make sure that you understand the basic principles behind the score notes/MIDI
notes relationship and also what Display Quantize is.

RELATED LINKS
Entering and editing notes on page 38
How the Score Editor works on page 8

Getting the parts ready
PROCEDURE
1.

Record the music.
You must definitely play in time with the click.

2.

Play back to check that the music was recorded as intended.
If not, you might need to re-record or perform some editing.

3.

Decide how much permanent alteration to the recording you can accept to make the score
look good.
If the answer is “none”, you should prepare your score from a copy of the track. See the
section below.

4.

Select all parts (on all tracks) that you want to work on.

5.

Open the Score Editor.

6.

Activate Page Mode.
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Preparing parts for score printout
Below follow a few tips to note when preparing a score for printout:
●

If a part is complex, you may have to do some manual editing of notes, like moving them
or changing their lengths. This means that the recording does not play back exactly as it
originally did. If this is a problem, we suggest you work on a copy of the recording. Use the
Duplicate Track function on the Project menu to create a version of the track for scoring.
Rename the track and mute the original track while you are preparing the score. You can
of course also work on a copy of the entire project file.

●

For reasons described in the previous chapter, quantizing the track might be a good idea.
This reduces the amount of detailed adjustments needed in the Score Editor.

●

If you need to quantize, always play back your tracks afterwards to make sure timing was
not disrupted due to inappropriate quantize settings. You might have to quantize some
sections with one value and others with another.

●

If the project contains many repetitions, it might be quicker to record just one instance of
each to start with. If you then finish the score work on each section, you can assemble the
entire project by working with parts in the Project window. This might save you some time
since the detailed adjustments to each section have to be performed only once.

●

A similar approach can also be used when you create sections where several instruments
play the same rhythm, a horn section for example. Record the first instrument and make
adjustments so that it looks like it should in the Score Editor. Then copy the part to the
other tracks, and change the pitches of the notes using MIDI input. Finally, go through the
copied parts and make fine adjustments, change display transpose settings, etc. This can
be a very fast way to create polyphonic parts with complicated rhythms.

●

There also may be situations when the quickest way to record a part for several
instruments is simply to record it in one go, by playing the chords on your MIDI
instrument. If you later want to split the recording into separate tracks or polyphonic
voices, you can use the Explode function.

RELATED LINKS
Entering and editing notes on page 38
The Explode function on page 36

Staff settings
The first thing to do after opening the Score Editor is to make initial staff settings. This is done in
the Score Settings dialog, on the Staff page.
There are three ways to open the Score Settings dialog:
●

Make the staff active, open the Scores menu and select “Settings…”.

●

Double-click on the rectangle to the left of the staff.
If this does not work, the “Double-click on staff flips between full score/part” option may be
activated in the Preferences dialog (Scores–Editing page).

●

Make the staff active and click the “i” button on the extended toolbar.
For this to work, make sure no notes or symbols are selected – otherwise, clicking the “i”
button may open a dialog with settings for the selected object instead.

Click the Staff button to open the Staff page of the Score Settings dialog. The Staff page shows
the current settings for the staff on four tabs.
RELATED LINKS
Displaying single voices or the complete score on page 14
Staff settings on page 58

33

Transcribing MIDI recordings
Situations which require additional techniques

Situations which require additional techniques
The notes may not always appear in the score as you expect them to, initially. This is because
there are a number of situations which require special techniques and settings.
Below you can find a list of some of these and where to find more information about handling
them:
●

Notes at the same position are considered to be part of a chord. To get independent
voicing notes with different stem directions, such as for vocal material, you need to use the
polyphonic voicing feature.

Without and with polyphonic voicing

●

If two notes beginning at the same position have different lengths, the longer one is
displayed as a number of tied notes. To avoid this, you can either use the No Overlap
feature or polyphonic voicing.

●

One note is often displayed as two notes with a tie. Please note that this is merely the way
the program displays this note; only a single note is “stored”.

This single note in the Key Editor is displayed as two tied notes in the Score Editor.

●

Normally the program adds ties where necessary (if a note stretches over a beat), but
not always. For a “modern” notation of syncopated notes (fewer ties) use the Syncopation
feature.
The same note, without and with syncopation

●

If you find that you want a long note to be displayed as two or more tied notes, you can
achieve this with the Cut Notes tool.

●

If two notes on the same position are too close to each other or if you want their order in
the part reversed, you can do this without affecting playback.

●

If a note has the wrong accidental, this can be changed.

●

Stem direction and length are automatic, but you can change them manually if you want.

●

If you are scoring for piano, for example, and you need a split staff, there are special
techniques for this.

RELATED LINKS
Polyphonic voicing on page 199
No Overlap on page 63
Syncopation on page 62
The Cut Notes tool on page 95
Graphic moving of notes on page 96
Accidentals and enharmonic shift on page 82
Background: Note stems on page 79
Split (piano) staves on page 53

Inserting Display Quantize changes
Some situations may require different staff settings on different sections of the track. The staff
settings are valid for the entire track, but you can insert changes wherever you like:
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PROCEDURE
1.

Select the Display Quantize tool on the toolbar or the context menu.
The Display Quantize dialog opens.

Select the Display Quantize tool to open the Display Quantize dialog.

2.

Activate the flags you need and set the quantize values as desired.

3.

If you want to restore the settings to the ones used in the Score Settings dialog (Staff
page), click the “Restore To Staff” button.

4.

Move the mouse over the staff where you want to insert a new Display Quantize value.
Use the Mouse Time Position display in the status line to find the exact location. The
vertical position is of no relevance as long as you click somewhere in the staff.

5.

Click the mouse button to insert a Display Quantize event.

RESULT
The new quantize settings are now inserted into the staff at the position where you clicked. The
settings are valid until a new change is inserted. Display Quantize events is always inserted for all
voices.
If you are using polyphonic voices, you can insert a Display Quantize event for all voices by
pressing Alt and clicking with the tool.
If the “Display Quantize Tool affects all Voices” option is activated in the Score Settings dialog
on the Project page (Notation Style subpage, in the Miscellaneous category), Display Quantize
events is always inserted for all voices.
RELATED LINKS
Display Quantize and Interpretation Options on page 60
The status line on page 18
Polyphonic voicing on page 199

Viewing and Editing Display Quantize Changes
If you activate the “Quantize” checkbox on the filter bar, a marker is shown under the staff for
each Display Quantize setting you have entered with the tool.
This allows you to edit your settings in the following ways:
●

To edit a Display Quantize change event, double-click on its marker.
This opens the Display Quantize dialog again – adjust the settings and click Apply.

●

If the Display Quantize dialog is already open, you can select any Display Quantize change
event, adjust its settings in the dialog and click Apply.

●

To remove a Display Quantize change, either click its marker to select it and press
Backspace or Delete, or click on it with the Erase tool.
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RELATED LINKS
Showing and hiding elements on page 19

Adding Display Quantize changes
Very often, the score is fine except for a few bars somewhere. To remedy the problem, insert
two Display Quantize changes with the tool (one at the beginning of the section, one after it to
restore to the current staff settings).
If you have mixed triplets and straight notes, it can be tempting to insert many Display Quantize
changes. Before you do so, try the Auto Quantize options and their additional settings.
RELATED LINKS
If your music contains mixed straight notes and triplets on page 62

The Explode function
This function allows you to “split” the notes on a staff into separate tracks. It is also possible to
use this function to convert a polyphonic staff into polyphonic voices.
IMPORTANT
Create a copy of the original track first, because it will be changed by the operation.

PROCEDURE
1.

Open the Scores menu, open the Functions submenu and select “Explode”.
The Explode dialog opens.

2.

Make sure that “To New tracks” is selected at the top of the dialog.

3.

Enter the desired number of new tracks.
Note that this is the number of new tracks to be created! For example, if you have a threepart polyphonic section and want to split this into three separate tracks, you must specify 2
new tracks, since the original track holds one of the parts.

4.

Use the options in the bottom section to set up the criteria for the split.
Choose from the following options:
Option

Description

Split Note

Use this to move all notes below a certain
pitch to another track. When this is
selected, it is pointless to specify more than
1 new track.

Lines To tracks

Use this when you want all musical “lines”
to be put on one track each. The notes with
the highest pitch remains on the original
track, the notes with the second highest
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Option

Description
pitch are put on the first new track, and so
on.

Bass To Lowest Voice
5.

If this option is activated, the lowest notes
always end up on the lowest track.

Click OK.

RESULT
A number of new tracks are now added to the score and the Project window.
RELATED LINKS
Automatically – the Explode function on page 74

Using "Scores Notes To MIDI"
For very complicated scores, there may be situations where you have tweaked the parameters
for Display Quantize and Interpretation as best you can, and you still cannot get the score exactly
as you want it. Perhaps one setting works fine in one section of the track and another is needed
for another section.
In such a case, “Scores Notes To MIDI” helps you out. It changes the lengths and position of
some or all the MIDI notes in the edited parts so that they have exactly the values shown on
screen.
PROCEDURE
1.

For safety, go back to the Project window and make a copy of the track.

2.

Open the parts again in the Score Editor.
If you only want some sections of your score to be “converted”, make sure to only open
those parts.

3.

Make sure that the notes you want to affect are not hidden.

4.

Select “Scores Notes To MIDI” from the Functions submenu on the Scores menu.
The notes are now “converted”.

5.

Make whatever adjustments are needed to make the score read as intended.

RESULT
Now that the notes have the exact lengths and positions that were previously only displayed, you
can probably deactivate many of the options on the Staff page of the Score Settings dialog and
delete Display Quantize settings, etc.
If you find the operation did not give you the result you were after, you can undo your settings or
go back to the original track, make a copy of that, and start over.
RELATED LINKS
Hiding/showing objects on page 166
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About this chapter
In this chapter you will learn:
●

How to make various settings for how notes are displayed.

●

How to enter notes.

●

How to use tools and settings to make the score as legible as possible.

●

How to set up a split (piano) staff.

●

How to work with multiple staves.

Score settings
Before you start entering notes, you need to make some initial staff settings.
There are three ways to open the Score Settings dialog:
●

Make the staff active, open the Scores menu and select “Settings…”.

●

Double-click on the rectangle to the left of the staff.
If this does not work, the “Double-click on staff flips between full score/part” option may be
activated in the Preferences dialog (Scores–Editing page).

●

Make the staff active and click the “i” button on the extended toolbar.
For this to work, make sure no notes or symbols are selected – otherwise, clicking the “i”
button may open a dialog with settings for the selected object instead.

The Score Settings dialog shows the current settings for the active staff.
RELATED LINKS
The basics on page 13
How the Score Editor works on page 8
Displaying single voices or the complete score on page 14
Staff settings on page 58

Applying settings and selecting other staves
To make settings for another staff, simply make it active in the score (by clicking anywhere in the
staff or by using the Up Arrow/Down Arrow keys).
NOTE
Always click Apply before making another staff active – otherwise your settings are lost!
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Staff presets
When you want to reuse settings made for one track in other tracks, you can save some time by
creating a staff preset.
NOTE
There are a number of staff presets available, set up to suit various instruments, etc. These are
accessed via the Presets pop-up menu on the Staff page of the Score Settings dialog, or from the
Staff context menu, opened by right-clicking on the rectangle to the left of the staff. Use them as
they are, or as starting points for your own settings.

RELATED LINKS
Working with staff presets on page 59

Suggested initial settings
When you start out entering notes, your staff settings should make your score display the notes
as entered. We suggest the following:
Option

Suggested setting

Display Quantize: Notes

64

Display Quantize: Rests

64

Auto Quantize

Activated

Syncopation

Off

Consolidate Rests

Off

Clean Lengths

Off

No Overlap

Off

Shuffle

Off

Key

As required

Clef

As required

Auto Clef

Activate this if you want the program to select
a treble or bass clef automatically.

Display Transpose value

0

Options tab settings

As is

Polyphonic tab settings

Staff Mode: Single

Tablature tab settings

Tablature Mode deactivated
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NOTE
It is very important that you understand how the Display Quantize values for notes and rests
interact with the score. If you select too large a notes/rests value, the notes you “click in” may not
appear as intended.

RELATED LINKS
Split (piano) staves on page 53
How the Score Editor works on page 8
Display Quantize and Interpretation Options on page 60

Note values and positions
Two of the most important settings for entering notes are the length of the note (the note value)
and the minimum spacing between notes (the Quantize value).

Selecting a note value for input
You can choose the length for entering notes as follows:
●

By clicking the note symbols on the extended toolbar.
You can select any note value from 1/1 to 1/64 and activate/deactivate the dotted and
triplet options by clicking the two buttons to the right.
The selected note value is displayed in the Length Quantize field on the toolbar and also reflected by
the cursor shape of the Insert Note tool.

●

By selecting an option from the Length Quantize pop-up menu on the toolbar.

●

By assigning key commands to the different length values.
This is done in the Key Commands dialog (in the category “Set Insert Length”).

About unusual note values
Not all note values can be selected directly, for example double dotted notes. Such notes are
created by changing the length of the note after you have entered it, by gluing notes together or
by using the Display Length feature.
RELATED LINKS
Changing the length of notes on page 51
Lengthening a note by gluing two notes together on page 52

Selecting a Quantize value
When you move the mouse pointer over the score the Mouse Time Position display in the status
line tracks your movement and shows the current position in bars, beats, sixteenth notes, and
ticks.
Positioning on screen is controlled by the current Quantize value. If you set this to 1/8, for
example, you can only insert and move notes to eighth note positions, at quarter notes, at half
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bars or at bar positions. It is a good strategy to set the Quantize value to the smallest note value
in the project. This does not stop you from inputting notes at “coarser” positions. However, if you
set the Quantize value to too small a note value, it is easier to make mistakes.
With the Quantize value set to 1/8, you can only input notes at eighth note positions:

The Quantize value is set on the toolbar on the “Quantize Presets” pop-up menu:

●

You can also assign key commands to the different Quantize values.
This is done in the Key Commands dialog (in the category “MIDI Quantize”).

●

Just like in the other MIDI editors, you can use the Quantize Panel to create other Quantize
values, irregular grids, etc.
However, this is not often used when inputting score notes.

The mouse position info
While you often use the graphical position in the actual score to determine where the notes go,
there are instances when you want to verify the position numerically using the mouse position
info displayed in the status line.

The Mouse Note Position display shows the pitch according to the vertical position of the pointer
in a staff. The Mouse Time Position display shows the “musical position” in bars, beats, sixteenth
notes, and ticks:
●

The relation between beats and bars depends on the time signature: In 4/4 there are 4
beats to a bar. In 8/8 there are eight, in 6/8 there are six, etc.

●

The third number is the sixteenth note within the beat. Again, the time signature
determines the number of sixteenth notes to each beat. In a quarter note based time
signature (4/4, 2/4, etc.) there are four sixteenth notes to each beat, in an eighth note
based time signature (3/8, 4/8, etc.), there are two sixteenth notes, etc.

●

The last value is in ticks, with 480 ticks per quarter note (and thus 120 ticks per sixteenth
note).

The figures below show some note positions and their corresponding position values:
Eighth note positions

2/2

1.1.1.0

1.1.3.0

1.1.5.0

1.1.7.0

1.2.1.0

1.2.3.0

1.2.5.0

1.2.7.0

4/4

1.1.1.0

1.1.3.0

1.2.1.0

1.2.3.0

1.1.3.0

1.3.3.0

1.4.1.0

1.4.3.0
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8/8

1.1.1.0

1.2.1.0

1.3.1.0

1.4.1.0

1.5.1.0

1.6.1.0

1.7.1.0

1.8.1.0

Eighth note triplet positions

2/2

1.1.1.0

1.1.2.40

1.1.3.80

1.1.5.0

1.1.6.40

1.1.7.80

4/4

1.1.1.0

1.1.2.40

1.1.3.80

1.2.1.0

1.2.2.40

1.2.3.80

8/8

1.1.1.0

1.1.2.40

1.2.1.80

1.3.1.0

1.3.2.40

1.4.1.80

Sixteenth note positions

2/2

1.1.1.0

1.1.2.0

1.1.3.0

1.1.4.0

1.1.5.0

1.1.6.0

1.1.7.0

1.1.8.0

4/4

1.1.1.0

1.1.2.0

1.1.3.0

1.1.4.0

1.2.1.0

1.2.2.0

1.2.3.0

1.2.4.0

8/8

1.1.1.0

1.1.2.0

1.2.1.0

1.2.2.0

1.3.1.0

1.3.2.0

1.4.1.0

1.4.2.0
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Entering notes using the computer keyboard
A quick and easy way to enter notes, without having to decide on the pitch, position and note
value first is using the computer keyboard. To enter a note, proceed as follows:
PROCEDURE
1.

On the toolbar, activate the “Computer Keyboard Input” button.
Now you can enter notes using the computer keyboard.

2.

Hold down Alt.
NOTE
If the “Computer Keyboard Note Entry: Require ALT-Key” option is deactivated in the
Preferences dialog (Scores–Editing page), you can insert notes without holding down Alt.
A note with the note value specified on the extended toolbar appears. By default, the
insert position is the first position of the bar and the pitch is C3.
●

To change the pitch, press the key that corresponds to the note on your computer
keyboard (c, d, e, f, etc.). If “Computer Keyboard Note Entry: Use On-Screen
Keyboard Keys” option is activated in the Preferences dialog (Scores–Editing page),
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you can press the key that corresponds to the note on the on-screen keyboard
(qwerty) instead.
●

To transpose the note in semitone steps, use the Up Arrow and Down Arrow keys.

●

To transpose the note in octave steps, use the Page Up/Page Down keys.

●

To change the insert position of the note, use the Left Arrow and Right Arrow keys.
Note that for position changes, the Quantize value is taken into account.

●

To change the length of the note, hold down Shift and use the Left Arrow and
Right Arrow keys.
This changes the note value step by step, passing from one Quantize value to the
next.

NOTE
If the “Computer Keyboard Note Entry: Legato” option is activated in the Preferences
dialog (Scores–Editing page), the length of the previous note is changed on inserting
notes.
3.

Insert the note with the computer keyboard.
The note with the specified pitch and note value is inserted at the selected position and
the insert position for the next note changes according to the Quantize value. If you press
Shift-Return, the insert position does not change, allowing you to enter chords.

Entering notes with the mouse
To add a note to the score using the mouse, proceed as follows:
PROCEDURE
1.

Make the staff active.
Notes are always inserted on the active staff.

2.

Select the desired note value.

3.

If you select the note value by clicking on a symbol on the extended toolbar, the Insert
Note tool is automatically selected – otherwise select the Insert Note tool on the toolbar or
context menu.

4.

Select a Quantize value.
The Quantize value determines the spacing between notes. If you set Quantize to 1/1 you
only can add notes at downbeats. If you set Quantize to 1/8, you can add notes at eighth
note positions, etc.

5.

Click in the staff and keep the mouse button pressed.
The Insert Note tool changes into a note symbol (showing the note exactly as it would be
inserted in the score).

6.

Move the mouse horizontally to find the correct position.

7.

Move the mouse vertically to find the correct pitch.

Accidentals are shown beside the note to indicate the current pitch.

NOTE
If the “Show Note Info by the Mouse” option is activated in the Preferences dialog (Scores–
Editing page), the position and pitch of the note is also shown in a “tooltip” next to the
pointer while you are dragging. If you find that screen redraws are too sluggish, you may
want to deactivate this option.
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8.

Release the mouse button.
The note appears in the score.
IMPORTANT
If you activate the “Animate Note Cursor” option in the Preferences dialog (Scores–Editing
page), you do not need to keep the mouse button pressed to see the note as it would be
inserted in the score.

RELATED LINKS
The active staff on page 17
Selecting a note value for input on page 40

Adding more notes
PROCEDURE
1.

If you want the next note to have a different length value, select the corresponding note
symbol.

2.

If you need finer positioning, or if the current value is too fine, change the Quantize value.

3.

Move the mouse to the desired position, and click.
Notes input at the same position are automatically interpreted as chords.

About the interpretation
The notes may not always appear in the score as you initially expect them to. This is because
there are a number of situations that require special techniques and settings. Below you can find
a list of some of these and where to find more information about handling them:
●

Notes at the same position are considered parts of a chord. To get independent voicing
(for example notes with different stem directions), such as for vocal material, you need to
use polyphonic voicing.

Without and with polyphonic voicing

●

If two notes beginning at the same position have different lengths, the longer is displayed
as a number of tied notes. To avoid this, you can either use the “No Overlap” feature or
polyphonic voicing.

●

One note is often displayed as two notes with a tie. This is only how the program displays
the note, there is still only a single note “stored”.

This single note in the Key Editor is displayed as two tied notes in the Score Editor.

●

Generally the program adds ties where necessary (if a note stretches over a beat), but not
always. For more “modern” notation of syncopated notes (fewer ties), you need to use the
syncopation feature.
The same note, without and with Syncopation

●

If you want a long note to be displayed as two (or more) tied notes, you can use the Cut
Notes tool for this.
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●

If a note has the wrong accidental, this can be changed.

●

If two notes on the same position are too close to each other or if you want their “graphical
order” in the score reversed, you can do this without affecting playback.

●

Stem direction and length is normally automatic, but you can set it yourself.

●

If you are scoring for piano and therefore (or for other reasons) need a split staff, there are
special techniques for this.

RELATED LINKS
No Overlap on page 63
Syncopation on page 62
Accidentals and enharmonic shift on page 82
Graphic moving of notes on page 96
Background: Note stems on page 79
Split (piano) staves on page 53
Polyphonic voicing on page 68

Selecting notes
In the operations described in the rest of this chapter, you often work on selected notes. The text
below describes how to select notes:

By clicking
To select a note, click on the note head with the Object Selection tool. The note head gets colored
to indicate that it is selected.

●

To select more notes, hold down Shift and click on them.

●

To deselect notes, hold down Shift and click on them again.

●

If you hold down Shift and double-click on a note, this note and all the following notes in
the same staff are selected.

Using a selection rectangle
PROCEDURE
1.

Click in an empty area in the score with the Object Selection tool and keep the mouse
button pressed.

2.

Drag the mouse pointer to create a selection rectangle.

You can drag to select notes on several voices or staves.
3.

Release the mouse button.
All notes with note heads inside the rectangle are selected.
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If you want to deselect one or more of the notes, hold down Shift and click on them.

Using the keyboard
By default, you can step through (and select) the notes in the staff using the Left Arrow and
Right Arrow keys. If you press Shift, you can select a series of notes as you step through them.
●

If you are working with polyphonic voices, you step through the notes on the current track,
that is, in a split system, you step through the staves.

●

If you want to use other keys for selecting notes, you can customize the settings in the Key
Commands dialog (in the Navigate category).

Selecting tied notes
Longer notes are often displayed in the score as one note with a tie. If you intend to select the
entire note, you must select the first note, not the tied note.
IMPORTANT
There is a setting for this in the Preferences dialog (Scores–Editing page): If you activate “Tied
Notes selected as Single Units”, the whole note is selected, even if you click on one of the tied
notes.

Deselecting everything
To deselect everything, simply click in an empty area of the score with the Object Selection tool.

Moving notes
In the following, you can find descriptions of the various methods to move notes, as well as
related features.

Moving by dragging
PROCEDURE
1.

Set the Quantize value.
The Quantize value restricts your movement in time. You cannot place notes on positions
smaller than the Quantize value.

2.

Select the notes you want to move.
You can select notes across several staves.

3.

Click one of the selected notes and drag it to a new position.
The horizontal movement of the note is “magnetically attracted” to the current Quantize
value. The Mouse Time Position and Mouse Note Position displays in the status line show
the new position and pitch for the dragged note.
NOTE
If the “Show Note Info by the Mouse” option is activated in the Preferences dialog (Scores–
Editing page), the position and pitch of the note is also shown in a “tooltip” next to the
pointer while you are dragging. If you find that screen redraws are too sluggish, you may
want to deactivate this option.

4.

Release the mouse button.
The notes appear at their new position.
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●

If you press Ctrl/Cmd and drag, movement is restricted to vertical or horizontal
(depending on the direction in which you drag).

●

If you move notes vertically and the “Keep moved Notes within Key” option is
activated in the Preferences dialog (Scores–Editing page), the notes are transposed
within the current key only.

RELATED LINKS
Selecting a Quantize value on page 40

Moving by using key commands
Instead of dragging the note with the mouse, you can assign key commands for this:
●

The corresponding commands can be found in the Nudge category in the Key Commands
dialog.

●

When moving notes to the left or right using key commands, the notes are moved in steps
according to the Quantize value.
The keys assigned for up/down nudging transpose notes in semitone steps.

Moving across staves – the Lock button
If you are editing several tracks, you may want to move notes from one staff to another.
PROCEDURE
1.

Make the desired Quantize settings and select the notes.
Make sure to only select notes on the same staff.

2.

Make sure that the “L” (Lock) button on the extended toolbar is deactivated

.

If this button is activated, you cannot move notes and other objects from one staff to
another, which is handy if you need to transpose a note very high or low, for example.
3.

Click on one of the notes and drag them to the new system.
The active staff rectangle indicates on which staff the dragged notes appears.

The Snap mode
The notes you move (or copy) snap to positions defined by the note length and Quantize values.
Using the Snap Type pop-up menu on the Score Editor toolbar you can select the Snap mode
used when moving or copying notes:

●

When using the “Grid” mode, notes you move (or copy) always snap to exact grid positions.

●

When using the “Grid Relative” mode, a note with a certain position relative to a grid line
always maintains that relative position to the grid when moved (or copied).

Acoustic Feedback
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To hear the pitch of the note while moving, activate the speaker icon (Acoustic Feedback) on the
toolbar.

About the lock layers
When you are moving and editing notes in the score, you might accidentally move other objects
nearby. To avoid this, assign different types of objects to different “lock layers” (up to three) and
instruct Cubase to “lock” one or two of these layers, making them unmovable.
There are two ways to set up which type of object should belong to which lock layer:
●

Open the Preferences dialog from the File menu and select the Scores–Note Layer page.
This page lets you adjust the layer setting for each object type.

●

Right-click one of the layer buttons, (1-2-3), on the extended toolbar to bring up a pop-up
menu, showing which object types are associated with that layer.
A checkmark for an object type means it belongs to that layer. If no checkmark is shown,
you can select the object type on the menu to move it to that layer.

To lock a layer, click the corresponding layer button, so that it is disabled and not highlighted. You can
only select or move objects whose Layer button is activated.

NOTE
There are also “L” and “P” layer buttons, for the layout and project layer. Clicking these buttons
allows you to lock the layout and project layers.

RELATED LINKS
Using the lock layers on page 118
Background: The different layers on page 103

Displaying layers
To see which score objects you assigned to which layer, you can activate and deactivate the Layer
buttons on the extended toolbar.

●

To display all the score objects that you assigned to the different note layers, activate
layers 1, 2, or 3.

●

To display all the score objects that are associated with the layout layer, activate the Layout
Layer (L) button.

●

To display all the score objects that are associated with the project layer, activate the
Project Layer (P) button.
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●

To get an overview of all layers, activate the Colorize Layer (A) button. This deactivates all
other layer buttons and displays the score objects in different colors, where each color
stands for a specific type of layer.

Duplicating notes
To duplicate notes in the score, proceed as follows:
PROCEDURE
1.

Set the Quantize value and select the desired notes.
You can duplicate any block of notes, even on several systems at the same time. The Snap
mode applies.

2.

Press Alt and drag the duplicate notes to their new position.
●

If you want to restrict movements to one direction, press Ctrl/Cmd.
This works just as for moving.

●

3.

If you want to restrict the pitch to inside the current key only, make sure that the
“Keep moved Notes within Key” option is activated in the Preferences dialog (Scores–
Editing page).

Release the mouse button to insert the notes.
Alt is the default modifier key for copying/duplicating. If you like, you can change this in
the Preferences dialog (Editing–Tool Modifiers page).
The entry for this is found in the Drag & Drop category (“Copy”).
NOTE
You can also move or copy whole bars by dragging the bar handles.

RELATED LINKS
The Snap mode on page 47
Moving and duplicating with the bar handles on page 121

Cut, copy, and paste
●

To cut notes, select them and choose Cut from the Edit menu (or use a key command, by
default Ctrl/Cmd-X).
The notes are now removed from the score and put on the clipboard.

●

To copy notes, select them and choose Copy from the Edit menu (or use a key command,
by default Ctrl/Cmd-C).
A copy of the notes is made, and put on the clipboard. The original notes remain where
they were.

IMPORTANT
The clipboard can only hold one set of notes. If you cut or copy and then cut or copy again, the
notes copied to the clipboard first are lost.
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Inserting notes from the clip board to the score
Notes that you have put on the clipboard by cutting or copying can be inserted into the score
again as follows:
PROCEDURE
1.

Activate the desired staff.

2.

Move the project cursor to the position where you want the first note to appear.
This is done by holding down Alt and Shift and clicking at the desired position in the score.

3.

Select Paste from the Edit menu (or use a key command, by default Ctrl/Cmd-V).
The notes are pasted in, beginning at the project cursor. If the cut or copied notes come
from different staves, they are also inserted on different staves. Otherwise, the notes are
inserted on the active staff. They keep the pitch and relative positions they had when you
cut or copied them.

Editing pitches of individual notes
By dragging
The simplest way to edit the pitch of a note is to drag it up or down. Remember to hold down
Ctrl/Cmd to avoid moving the note sideways as well.
●

If the “Keep moved Notes within Key” option is activated in the Preferences dialog (Scores–
Editing page), notes are transposed within the current key only.

●

To avoid accidentally moving the note into another staff, activate the Lock button.

●

When you drag the mouse up and down before releasing the button, accidentals are
shown beside the note to indicate the current pitch.
This helps you verify the vertical position for the note.

RELATED LINKS
Moving across staves – the Lock button on page 47

Using the Transpose Palette
The Transpose Palette on the toolbar contains buttons for transposing the selected notes up or
down in steps of one semitone or one octave.
●

To show the Transpose Palette, right-click the toolbar and activate “Transpose Palette” on
the context menu.

Using key commands
Instead of transposing the note with the mouse, you can assign key commands for this.
●

The commands for which you can assign key commands are found in the Nudge category
in the Key Commands dialog.
Transpose commands are, for example, “Up” (transpose one semitone up) and
“Down” (transpose one semitone down).
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Using the info line
You can use the info line to change the pitches (and other properties) of one or several notes
numerically.
●

If you have several notes selected and change the pitch on the info line, the changes are
relative.
That is, all selected notes are transposed by an equal amount.

●

If you have several notes selected, hold down Ctrl/Cmd and change the pitch on the info
line, the changes are absolute.
That is, all selected notes are set to the same pitch.

Via MIDI
PROCEDURE
1.

On the toolbar, activate the MIDI Input button and the Record Pitch button to the right.
If you also want to change the note-on and/or note-off velocity of the notes via MIDI, this
can be done by also activating the corresponding velocity buttons. To edit notes via MIDI
(pitches only), set up the buttons like this.

2.

Select the first note that you want to edit.

3.

Press a key on your MIDI keyboard.
The note takes on the pitch of the key you pressed. The program then selects the next
note.

4.

To change the pitch of the next selected note, simply press the desired key.
You can change note pitches by simply pressing the relevant keys. You can also use key
commands (by default the Left Arrow and Right Arrow key) to pass from one note to
the other. For example, if you make a mistake, you can step back to the previous note by
pressing the Left Arrow key.

Changing the length of notes
When it comes to note lengths, the Score Editor is special in that it does not necessarily display
the notes with their actual length. Depending on the situation, you may want to change the
“physical length” of the notes or the “display length”.

Changing the “physical” length
This changes the actual length of the notes. The change is audible when you play back the music.
IMPORTANT
Remember that the appearance of notes and rests in the score is determined by the Display
Quantize settings on the Staff page of the Score Settings dialog. Depending on the Notes and
Rests values, notes may be displayed as if they were longer than they really are.

RELATED LINKS
Display Quantize on page 9
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By using the extended toolbar
Using the extended toolbar is another quick way to set a number of notes to the same length:
PROCEDURE
1.

Select the notes that you want to change.

2.

Hold down Ctrl/Cmd and click on one of the note icons on the extended toolbar.
All the selected notes now get the note value on which you clicked.

By using the info line
You can also edit length values numerically on the info line. The same rules apply as when
changing the pitch of notes.

Lengthening a note by gluing two notes together
You can create unusual note length values by gluing notes of the same pitch together.
PROCEDURE
1.

Insert the notes that you want to glue together (if they do not already exist).

2.

Select the Glue tool on the toolbar or context menu.

3.

Click on the first note.
This note is now tied to the first following note with the same pitch.
IMPORTANT
Make sure that you have Display Quantize values for notes and rests that allow you to
display notes of the created note value.

4.

If you want to glue more notes, click again.
By gluing together a quarter note, an eighth note and a sixteenth note, you get a double
dotted quarter note.

Changing the display length
If you want to change the displayed length of notes without affecting how they play back, the
first thing to try is to adjust Display Quantize, either for the whole staff or for a separate section,
using the Display Quantize tool.
But you can also make display length adjustments to individual notes in the Set Note Info dialog:
PROCEDURE
1.

Double-click on the note.
The Set Note Info dialog opens.

2.

Locate the “Length” setting.
By default, this is set to “Auto”, which means that the note is displayed according to its
actual length (and the Display Quantize settings).
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3.

Double-click in the value field and enter a new length value (displayed in bars, beats,
sixteenth notes, and ticks).
To set the display length to “Auto” again, scroll the value down to zero.

4.

Click Apply and close the dialog.
The note is now displayed according to its display length setting. However, the Display
Quantize settings still apply!

RELATED LINKS
Inserting Display Quantize changes on page 34

Splitting a note in two
If you have two notes strung together by a tie, and click on the “tied” note head with the Split
tool, the note is divided into two, with the length of the “main” and the tied note, respectively.

Before and after splitting a tied note

Working with the Display Quantize tool
There are instances when you want different staff settings for different sections of the track. The
settings on the Staff page of the Score Settings dialog are valid for the entire track, but by using
the Display Quantize tool you are able to insert changes and exceptions wherever you like.
RELATED LINKS
Inserting Display Quantize changes on page 34

Split (piano) staves
Setting up the split staff
PROCEDURE
1.

Make a staff active.

2.

Open the Score Settings dialog on the Staff page and select the Polyphonic tab.

3.

From the Staff Mode pop-up menu, select Split.

4.

Set the Split Point value to a suitable note.
All notes below this note value are put on the lower clef, all above are put on the upper
clef.

Split mode selected.

If the default piano clef settings for the upper and lower staff are not what you want, you
can adjust these settings now (or you can make key and clef adjustments directly in the
score).
5.

Make whatever additional staff settings you need.
These apply to both the upper and lower staves of the split system.

53

Entering and editing notes
Strategies: Multiple staves
6.

Click Apply.

Before and after setting a split at C3

RELATED LINKS
Setting clef, key, and time signature on page 21

Changing the split point
PROCEDURE
1.

Make sure that the system you are working on is active.

2.

Open the Score Settings and select the Staff page.

3.

Select the Polyphonic tab.

4.

Change the Split Point value.

5.

Click Apply.

RESULT
Now, some notes that were previously on the lower staff are on the upper, or vice versa.

Strategies: Multiple staves
When you have parts on several tracks selected in the Project window, these are put on one staff
each, when you open the Score Editor. This allows you to work on several staves in parallel.
Working with several staves is not much different from working with one. Below follow some
guidelines that apply specifically to working with multiple staves.

Score settings dialog, Staff page
The settings on the Staff page of the Score Settings dialog are local to each staff. You can have
the Score Settings dialog open and select each staff in turn to make settings – just remember to
click Apply before selecting another staff, otherwise your changes are lost.
If several staves share settings, you can save some time by using staff presets. Set up the staff
settings for the first staff, and save them as a preset. This preset can then be applied to any of
the other staves, one at a time.
RELATED LINKS
Working with staff presets on page 59
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Selecting notes
You can select notes from one or several staves at the same time, using any of the selection
methods.
RELATED LINKS
Selecting notes on page 45

Adding notes
This is done just as on a single system. Please note the following:
●

When you enter a note, use the Mouse Note Position display (in the status line) to
determine the pitch. Whether it ends up on the upper or lower staff has nothing to do with
where you aim with the mouse. The Split Point setting always decides if a note goes on the
upper or lower staff. If you change the split point, this affects existing notes.

●

Sometimes a fixed split point is not good enough. You might want to put two notes with
the same pitch on different staves in different parts of the score. To achieve this you need
to use polyphonic voicing.

●

You can add notes to any staff by clicking on it with the Insert Note tool. The active staff
rectangle moves to the staff where you input the note.

●

If you need to enter a note with a very high or low pitch, which makes it wind up on the
wrong staff when you click, first enter a note with the wrong pitch, and then edit its pitch.

RELATED LINKS
Adding and editing notes on page 42
Polyphonic voicing on page 68
Editing pitches of individual notes on page 50

Inserting and editing clefs, keys, or time signatures
It is possible to insert a change of clef, key, or time signature anywhere in the score.

Inserting a symbol on one staff
PROCEDURE
1.

In the Symbols Inspector, open the “Clefs etc.” section.
This contains clef, key, and time signature symbols.

2.

Select the symbol that you want to insert.
When you move the mouse over the score display, the pointer takes on the form of a
pencil.

3.

Move the mouse over the staff where you want to insert a new symbol.
Use the Mouse Time Position display in the status line to find the exact location. The
Mouse Note Position, that is, the vertical position is of no relevance as long as you click
somewhere in the staff. Time signature changes can only be inserted at the beginning of a
bar.

4.

Click the mouse button to insert the symbol.
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IMPORTANT
Inserting a symbol at position 1.1.1.0 is the same as changing the staff settings which are
stored in the track. Inserting anywhere else adds the change to the part.

RELATED LINKS
About the Draw tool on page 108

Inserting a symbol on all staves
If you hold down Alt when you insert a symbol with the Draw tool, it is inserted at this position
on all staves being edited in the Score Editor.
●

Time signature changes are always inserted on all tracks in the score.
Or rather, they are inserted on the signature track, which affects all tracks.

●

For key changes, Display Transpose is taken into account.
This allows you to set all staves to a new key and the staves set to Display Transpose still
show the correct key after the key change.

NOTE
If some of the staves are bracketed (straight brackets only, as set up in the Score Settings dialog
on the Layout page), inserting a symbol for one of these staves inserts it for all other staves
within the bracket. Staves outside the bracket are not affected.

RELATED LINKS
Adding brackets and braces on page 176

Editing clefs, keys, and time signatures
If you double-click on a symbol, a dialog appears allowing you to change the settings for it.
If you hold down Alt when double-clicking, all symbols at the same position are changed
accordingly. With key signatures, the Display Transpose value is taken into account.
●

In the Score Settings dialog on the Project page (Notation Style subpage), you can find
several options for how clef, key, and time signature changes are displayed.
You can also adjust the automatic spacing between these symbols in the Spacings
subpage. See the dialog help for details.

Moving clefs
Clefs inserted into the score have an effect on how notes are displayed. If you for example insert
a bass clef in the middle of a treble staff, the staff switches to show bass pitches. Therefore it is
very important where you insert the clef.
If you want to move the clef graphically, without disturbing the relation between the clef and the
notes, proceed as follows:
PROCEDURE
1.

Select the Layout tool on the toolbar or context menu.
Note that this tool is available in Page Mode only.
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2.

Click on the clef and drag it to the desired position.
Note that this tool is available in Page Mode only.
NOTE
When you insert a clef change in the score, you can decide whether this has the same size
as the first (default) clef symbol or whether it is displayed with a smaller symbol. Simply
right-click the symbol and activate or deactivate “Display Clef Changes as Small Symbols”.
NOTE
If “Warnings for new Clefs at Line Breaks” is activated on the Clef context menu and you
inserted a clef change at a line break in the score, the Clef change symbol is inserted in the
last bar before the staff break. If this option is deactivated, the symbol is inserted in the
first bar of the next staff line.

Deleting notes
Using the Erase tool
PROCEDURE
1.

Select the Erase tool on the toolbar or context menu.

2.

One at a time, click on the notes you want to erase, or enclose them in a selection
rectangle, and click on any of the notes.

Using the Delete menu option or the keyboard
PROCEDURE
1.

Select the notes that you want to delete.

2.

Select Delete from the Edit menu, or press Delete or Backspace on the computer
keyboard.
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About this chapter
In this chapter you will learn:
●

How to make staff settings.

●

How to work with staff presets.

Staff settings
Below follows a run-through of all staff settings, more detailed information about the ones
already described and references to other places in the manual for some options.
The Staff page has four tabs – here, the Main tab is selected:

Making settings
PROCEDURE
1.

Open the Score Settings and select the Staff page.

2.

With the dialog open, make the desired staff active.
Click anywhere in a staff to make it active, or use the Up Arrow and Down Arrow keys to
step from staff to staff.

3.

Select the desired tab and make all necessary settings.
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The settings for regular staves are found on the Main and Options tab, the Polyphonic tab
contains settings for split systems and polyphonic voices while the Tablature tab lets you
set up tablature scores.
4.

When you have made the desired settings, click Apply.
NOTE
If the “Apply closes Property Windows” option is activated in the Preferences dialog
(Scores–Editing page), clicking Apply also closes the dialog.
To make settings for another staff, simply make it active in the score (by clicking anywhere
in the staff or by using the Up Arrow/Down Arrow keys).
However, please note that you need to click Apply before making another staff active –
otherwise your settings are lost!
IMPORTANT
Staff settings can be saved in the track presets.

Working with staff presets
Making staff settings for your scores can be time-consuming. Staff presets allow you to reuse
those settings whenever you work with a staff similar to one you have worked on before. A staff
preset contains all the settings from the Staff page of the Score Settings dialog, except for the
key.
●

To save the current settings (including the settings on the Options tab) click the Store
button in the Presets section of the Staff page.
Enter a name for the preset in the name dialog that appears, and click OK. The preset is
now available on the Presets pop-up menu (in all projects).

●

There are a number of staff presets available, set up to suit various instruments, etc.
The presets are accessed from the Presets pop-up menu on the Staff page of the Score
Settings dialog or from the staff context menu, opened by right-clicking on the rectangle
to the left of a staff.
Use them as they are, or as starting points for your own settings. Note that this loads the
settings in the preset into the dialog – to apply these to a staff you must click the Apply
button as usual. You can also apply staff presets directly in the score.

●

To remove a preset, select it from the pop-up menu and click the Remove button.

Applying a preset directly in the score
If you right-click on the rectangle to the left of a staff, a context menu appears, listing all
available presets. Select one to apply it to the staff.

How staff presets are stored
The staff presets are stored as individual files in the Presets–Staff Presets folder within the
Cubase program folder. The presets are available for selection in any project you create or edit.
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Staff names

These fields allow you to specify a “long” and a “short” name for the staff. The long name is
shown for the very first system for this staff in the score (at the start of the project), while the
short name is shown for the remaining systems.
●

Whether the names are shown at all is set in the Score Settings dialog on the Layout page.

●

If you only want the “long name” to be shown, that is, if you do not want a name shown for
each system in the score, simply delete the short name.

●

If the “Show Long Staff Names on new Pages” option is activated in the “Staff Names”
section of the Score Settings dialog (Project page), the long name is shown at the
beginning of each new page.

●

You can also specify two separate subnames by double-clicking the staff name and
entering them in the upper and lower text entry fields in the dialog that appears.
Note that this is only displayed correctly if you are in Page Mode and if “Show Staff Names
to Left of Staff” is activated in the Score Settings dialog, on the Project–Notation Style
subpage (Staff Names category).

RELATED LINKS
Staff names on page 150

Key and clef

The basic key and clef settings are described in detail in another section. There is also a Lower
Staff checkbox which is only used in conjunction with split (piano) staves and polyphonic voicing.
●

If you score a French horn, for example, and you want to set a different key symbol,
activate the “Local Keys” option.

RELATED LINKS
Setting clef, key, and time signature on page 21
In a split system on page 25

Display Quantize and Interpretation Options
These two sections of the dialog contain a number of settings used to determine how the notes
are interpreted. While these settings are more critical to making MIDI recorded music appear as
legible as possible it is still important to have them set correctly when entering notes using the
mouse. Below you can find descriptions of the settings.
There are “fixed” Display Quantize values plus an “Auto” option which should only be used when
your music contains mixed straight notes and triplets.
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RELATED LINKS
Adding Display Quantize changes on page 36
Display Quantize on page 9

Display Quantize values

Notes and Rests
●

Generally, the Notes value should be set to a value equal to, or smaller than, the “smallest
note position” that you want to be shown in the score.

●

The Rests value should be set to a value equal to, or smaller than, the smallest note value
(length) you want to be displayed for a single note, positioned on a beat.

●

If the score contains only triplets, or mostly triplets, select one of the Triplet options.

Auto Quantize
●

If the project contains no triplets or only triplets, deactivate this option.

●

If the project contains mixed triplets and straight notes, activate this option.

Deviation and Adapt
●

If Deviation is activated, triplets/straight notes are detected even if they are not exactly
“on the beat”. However, if you know your triplets/straight notes are perfectly recorded
(quantized or entered by hand), deactivate this option.

●

If Adapt is activated, the program “guesses” that when one triplet is found, there are
probably more triplets surrounding it. Activate this option if not all of your triplets are
detected.

If your music only contains “straight” notes or triplets
PROCEDURE
1.

Specify a Notes value.
For example, if you have notes on odd sixteenth note positions, the Notes value should be
set to 16 (sixteenth notes). The “T” values on the pop-up menu are for triplets.

2.

Specify a Rests value.
For example, if you want a single short note on a beat (quarter note position) to be
displayed as a quarter note, set the Rests value to 4 (quarter notes).

3.

Deactivate the Auto Quantize option.

4.

Set all the Interpretation Options.

5.

Examine the score.

6.

If necessary, use the Display Quantize tool to insert “exceptions” to the staff settings.

RELATED LINKS
Inserting Display Quantize changes on page 34
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If your music contains mixed straight notes and triplets
PROCEDURE
1.

Examine the score and decide if it mainly contains triplets or mainly “straight” notes.

2.

Set the Notes value accordingly.
If the score is mainly triplets, select the smallest triplet note position used in the score. If it
is mainly straight notes, select the smallest “ordinary” note position.

3.

Set the Rests value.

4.

Activate the Auto Quantize option.

5.

Activate the Deviation and Adapt flags if you need them.

Interpretation Options

Syncopation
Activate Syncopation when the program adds more ties to notes crossing beats and barlines
than you prefer. The following options are available:
Relax
When Syncopation is “relaxed”, the program applies syncopation in a number of
common cases.
Full
Syncopation is on.
Off
Syncopation is off, with no exceptions.
For a “modern” notation of syncopated notes, activate Syncopation.
Without and with Syncopation:

Without and with Syncopation:

Note that you can insert “exceptions” to the Syncopation setting in the Score Settings dialog
on the Staff page, by using the Display Quantize tool. You can also create tied notes in various
combinations by using the Cut Notes tool.

Consolidate Rests
Activate this when you want small consecutive rests joined into one (an eight note rest and a
sixteenth note rest joined to a dotted eighth note rest for example).
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Consolidate Rests deactivated and activated

Clean Lengths
If this option is activated, the program interprets the length of your notes differently. A note’s
length (in the display only) might be extended to the beginning of the next note or to the next
Rests “position” for Display Quantize. An example:
●

If a note is too short, you may get a rest just after it.

●

If Clean Lengths is activated, the rest disappears.

A slightly short eighth note without and with “Clean Lengths”.

If using Clean Lengths does not help in a particular situation, you can manually resize the
offending notes or use the Display Quantize tool.
RELATED LINKS
Inserting Display Quantize changes on page 34

No Overlap
When notes starting at the same position have different lengths, the program tends to add more
ties than you may want. This can be avoided by using No Overlap.

This recording in the Key Editor…

…is displayed like this when No Overlap is deactivated…

…and like this when No Overlap is activated.

You can insert “exceptions” to the No Overlap setting on the Staff page of the Score Settings
dialog, by using the Display Quantize tool.
IMPORTANT
Please note that there may be situations when neither of these alternatives is ideal. If you run
into such a situation, it can probably be resolved by using polyphonic voicing.

RELATED LINKS
Polyphonic voicing on page 68
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Shuffle
In jazz it is very common to score a shuffled beat as straight notes, simply to make it more
legible.
If the Shuffle flag is activated, the program searches for eighth note or sixteenth note pairs
where the second note is played late (with a “swing feel” or as the third note in a triplet). Such
pairs are displayed as regular eighth or sixteenth notes instead of triplet-based figures.

Without and with Shuffle

Display Transpose
This is used when preparing parts for instruments that are not scored at the actual concert key.
For example, if you want the note C3 to be played by an alto sax, you have to score it as an A3 –
nine semitones up. Luckily, the Display Transpose setting takes care of this for you:
●

Use the pop-up menu to select the instrument for which you are scoring.

●

If the pop-up menu does not list your instrument, you can set the desired transposition
with the Semitones value field.

NOTE
The Display Transpose setting does not affect playback or the actual pitch of the notes – it only
changes how they are displayed and printed.
You can also insert Display Transpose changes anywhere in the score, by inserting a key change
symbol and using the Transpose setting in the Edit Key dialog.
●

In the Score Settings dialog, on the Project page (“Chord Symbols” subpage), deactivate
the “Use Display Transpose” option if you do not want the chord symbols to be affected by
the Display Transpose setting.

●

You can disable Display Transpose by deactivating the “Display Transpose” button on the
toolbar of the Score Editor.

RELATED LINKS
Display Transpose in the Edit Key dialog on page 28
Chord Symbols on page 138
Transposing instruments on page 28
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The Options tab

Clicking the Options tab in the dialog brings up another page with additional settings. Below
follows a brief description of these, with references to more detailed explanations.

Switches
This section allows you to make beam settings.
Flat Beams
Activate this when you want the beams over notes to be flat (as opposed to slanted).
No Beams
Activate this when you do not want any beaming at all on the staff (for example for
vocal scoring).
Beam Subgroups
Use this when you want sixteenth notes displayed under a beam to be divided into
groups of four notes.

Without and with Beam Subgroups.

16th Subgroups
Use this when you want even smaller subgroups of sixteenth notes. This setting has
no effect if Beam Subgroups is deactivated.

As above, but with 16th Subgroups activated.

RELATED LINKS
Beam appearance and slant settings on page 92
Turning beaming on/off on page 88
Handling beam groups on page 92

System Sizes
This section allows you to set the number of system lines and to control spacing between the
lines:
System Lines
The number of lines in a system. For regular scoring, this should be set to 5.
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Add Space
Allows you to increase or decrease the space between the lines in a system.
Size
Allows you to set a size for the systems, as a percentage (with 100 % being the
default value). In effect, this setting scales the score vertically.

Score Drum Map
When scoring for drums, you can assign a unique note head to each pitch. There is even the
possibility to set up different note heads for different note values!
RELATED LINKS
Scoring for drums on page 182

Fixed Stems
Activate this if you want all note stems to end at the same vertical position. This feature is
perhaps most often used when scoring for drums.

A drum pattern with Fixed Stem length activated

The Up and Down parameters determine which position (relative to the top of the staff) is used
for up and down stems, respectively. The graphical display helps you get your settings right.
RELATED LINKS
Setting up a staff for drum scoring on page 185

Note Limits
Use the Low and High fields to specify a note range. In the active staff, any notes outside this
range are displayed in a different color. When writing a score for a specific instrument, this
makes it easy to find notes that are outside of this instrument’s note range.
NOTE
If the “Hide Notes beyond limits” option is activated in the Preferences dialog (Scores–Editing
page), any notes outside the Note Limits range are hidden.

The Polyphonic tab
This is where you activate and set up split (piano) systems or polyphonic voices (several
independent score lines in the same staves).
RELATED LINKS
Polyphonic voicing on page 68

The Tablature tab
This tab contains settings for creating tablature scores.
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RELATED LINKS
Creating tablature on page 187
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About this chapter
In this chapter you will learn:
●

How to decide when to use polyphonic voicing.

●

How to set up voices.

●

How to automatically convert your score to polyphonic voicing.

●

How to enter and move notes into voices.

Background: Polyphonic voicing
Polyphonic voicing allows you to resolve a number of situations impossible to score properly
otherwise:
●

Notes starting at the same position, but with different lengths. Without polyphonic voicing
you get unnecessary amounts of ties.

Without and with polyphonic voicing

●

Vocal scoring and similar. Without polyphonic voicing, all notes starting at the same
position are considered parts of a chord. With polyphonic voicing you can give each voice a
stem direction, you can have individual rest handling for each voice, etc.

Without and with polyphonic voicing

●

Complicated piano systems. Without polyphonic voicing, you have to resort to a fixed split
note setting to decide which notes go on which clef. With polyphonic voicing, the split
point can be “floating”. The program can even automatically put a bass line on the lower
clef for you.

With a split system and with polyphonic voicing

How voices are created
Cubase allows for up to eight voices. The first thing you do is to set them up. This includes
“telling” the program which voices belong to the upper clef and which belong to the lower, how
you want rests displayed for each voice, etc.
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Background: Polyphonic voicing
The second thing you do is to move or enter notes into the voices. If you have a recording done
already, the program can do much of this work for you, automatically. You might then want to
fine-tune by moving one or more notes into another voice, or you might want to add notes to a
certain voice.
IMPORTANT
Each voice is polyphonic. In other words, one voice can contain chords.

RELATED LINKS
Adding and editing notes on page 42

Overlapping notes
Throughout this chapter you encounter the term “overlapping notes”. Two notes are considered
overlapping when they are on the same staff and:
●

They start at the same position, but have different note values (for example whole note
and a quarter note both at the beginning of a bar).

Notes starting at the same position, without and with polyphonic voices.

●

One note starts before another has ended. For example a half note at the beginning of a
bar and an eighth note at the second beat.

A note that starts before another has ended, without and with polyphonic voices.

Voices and MIDI channels
Internally the program organizes the notes into voices by changing their MIDI channel values.
Normally you set it up so that notes with MIDI channel 3 belong to voice 3 etc. Most of the time
the link between MIDI channels and voices is totally transparent to you as a user. Sometimes you
can take advantage of this relationship.
There are also a few important things to note:
NOTE
When you make a note part of a voice, you are in fact changing its MIDI channel value. However,
when you change the voice’s MIDI channel values in the setup dialog, this does not affect the
notes’ MIDI channel setting. This can lead to serious confusion, since the relationship between
the notes and the voices is affected. It might even make notes disappear (the program warns
if this happens). In other words, do not change the MIDI channels on the Polyphonic tab of the
Staff page in the Score Settings dialog after you have put your notes into voices, unless you are
absolutely sure of what you are doing.
NOTE
When you open a part that contains notes on different MIDI channels, these notes are in fact
already assigned to voices (since notes are assigned to voices using their MIDI channel setting).
While this fact can be put to good use, it can also create confusion, and even disappearing notes.
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Setting up the voices
To set up your score for polyphonic voicing, proceed as follows:
PREREQUISITE
The staff is active.
PROCEDURE
1.

Open the Score Settings dialog and select the Staff page.

2.

Select the Polyphonic tab.

3.

Open the Staff Mode pop-up menu and select Polyphonic.
This makes the voice list in the lower part of the dialog available. It consists of eight rows,
one for each voice. They are numbered and therefore we refer to them as voices 1 to 8.

IMPORTANT
Do not confuse the voice numbers with the MIDI channel setting for each voice.
4.

To activate a voice, click in its “On” column, so that a checkmark appears.
There are four voices on each staff, for a total of eight. If you activate one “upper” voice
and one “lower” voice, you get a split (piano) staff.

5.

If you have particular reasons to use specific MIDI channels, change the “Chan” settings for
the voices.
The program automatically sets each voice to a different MIDI channel. If you do not have
good reasons to make changes, leave the settings as they are.
IMPORTANT
If two voices are set to the same MIDI channel, the lower voice is treated as if it were
turned off.

6.

Optional: If Reduce Rests is set to Off, you can click in the “Rests–Show” column to decide
for which voices you want rests displayed.
A checkmark indicates that rests are shown for a voice. You may only want rests to be
shown for one voice per staff.
NOTE
If you have activated “Rests–Show” for a voice, but do not want rests to be shown in empty
bars, select an option from the “Reduce Rests” pop-up menu. This is especially useful for
cue voices.
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7.

Click in the “Rests–Center” column to determine at which vertical positions rests are shown
(for voices with “Rests–Show” activated).
If this option is activated for a voice, the rest is put in the vertical center of the staff, when
it is not, the rest gets a vertical position based on the pitch of the notes.

8.

Decide on a stem direction for each voice by selecting from the pop-up menu in the Stems
column.
If you select Auto, the program makes decisions about which stems go in which direction
(just as when not using polyphonic voices). You can always force stem direction for
individual notes by using the Flip Stem function.
IMPORTANT
There is a special stem feature for voice 1: If you set this to Auto, the stem direction
depends on the pitch of the note as usual – except if there are voice 2 notes in the bar,
because then the voice 1 stems are automatically set to Up!

9.

If you want the notes in a voice to be smaller than regular notes, put a checkmark in the
Cue column for the voice.

10.

Click Apply.
The staff is changed to polyphonic voicing, and the program distributes the existing notes
into voices according to their MIDI channel values.
At this point, you may want to use the Explode function to automatically move notes into
the proper voices.

RELATED LINKS
Cue notes on page 97
Flipping the stem of one or several notes on page 80
Automatically – the Explode function on page 74
Handling rests on page 75

If the “Some Notes Do Not Belong To Voices…” dialog appears
When you click Apply, a warning may appear saying “Some notes do not belong to any voice and
may be hidden. Correct these notes?”.
This warning appears when the staff contains notes with MIDI channel settings which do not
match any of the active voices.
If you click the “Correct” button, these notes are moved to active voices. If you click “Ignore”,
nothing is changed, and some notes are hidden. However, they are not lost, they appear in all
other editors and can be made to appear again in the Score Editor if you change the channel
settings for the notes or voices, activate more voices, etc.

About the polyphonic presets
The Presets pop-up menu on the Polyphonic tab (below the list of voices) contains three very
useful setups. Instead of making settings by hand, you can select one of the presets, saving some
time. The presets are:

Variable Split
This sets up the dialog for two voices, one on each staff, each with auto stem direction. This is a
good starting point for a piano staff when the fixed split option does not suffice.

Optimize Two Voices
In this preset, only voices 1 and 2 are activated, and set up like this:
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This way the first voice behaves as in single staff mode, but if there are notes in the second voice,
the stems of the first one are set to Up.

Optimize Four Voices
This is like “Optimize Two Voices”, but with two staves. Voices 5 and 6 are activated as well, with
the same settings as voices 1 and 2. This is the recommended way to write piano music.

Strategies: How many voices do I need?
●

If you are scoring for vocals, you simply need one voice for each voice, so to speak.

●

If you use voices for resolving the problem of overlapping notes, for example when
scoring for piano, you need two voices each time two notes overlap. If three notes overlap,
you need three voices. In other words you need to check for the “worst case” (largest
number of overlapping notes at a certain position) and activate that many. If you do not
know how many voices you need when starting out to prepare a score, do not worry, you
can add more voices later.

●

Voices 1 and 2 on the upper staff and 5 and 6 on the lower are special. These handle
“collisions” (notes with small intervals, accidentals that otherwise would come too close,
etc.) automatically which the other voices do not. Always use these voices first!

An example: in the situation below, three voices are required. The lowest note overlaps both
the “melody” and the chords, so it cannot share a voice with the chords. The chords overlap the
melody, so they cannot share a voice either.

RELATED LINKS
Overlapping notes on page 69

Entering notes into voices
When you add new notes, you need to decide which voice they go into:
PROCEDURE
1.

Make sure that the extended toolbar is visible.

2.

Select the Object Selection tool.

3.

If you have a split system, check the voice Insert buttons.
These are displayed after the text “Insert” on the left side on the extended toolbar. Only
the voices that are activated on the Polyphonic tab are shown. If the upper staff is active,
the voice Insert buttons are numbered 1, 2, etc., otherwise they are numbered 5, 6, etc.

4.

If you need to switch the voice icons to the right “clef”, click somewhere in the system you
want to insert notes in.

5.

Select one of the voices by clicking on the corresponding button.
Any notes you enter from now on are inserted into that voice.
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Voice 3 activated for insertion

6.

Insert the notes as usual.

7.

To switch to another voice, click the corresponding button.

8.

To insert notes into a voice on the other clef, click on that clef and then select a voice using
the buttons.

RELATED LINKS
Adding and editing notes on page 42

Checking which voice a note belongs to
When you select one single note, the corresponding voice button on the extended toolbar is
selected. This allows you to quickly find out which voice a certain note is in (after you have used
the Move To Voice function, for example).
●

When you step through the notes using the Left Arrow/Right Arrow keys, you only step
through the notes in one voice at a time.
This can be used as a quick way to check which notes belong to the same voice as some
other note.

Moving notes between voices
Manually
To manually move notes to another voice, proceed as follows:
PROCEDURE
1.

Select the notes you want to move to a particular voice.

2.

Right-click on one of the notes and select “Move to Voice” from the context menu.

3.

On the submenu, select the voice to which you want to move the notes.
Only the activated voices are available on the menu.
You can also press Ctrl/Cmd and click a voice Insert button on the extended toolbar to
move the selected notes to the corresponding voice.
You can also assign key commands for this in the Score Functions category of the Key
Commands dialog on the File menu.

73

Polyphonic voicing
Moving notes between voices

Automatically – the Explode function
The Explode function distributes notes, either onto new tracks or into polyphonic voices:
PROCEDURE
1.

Open the Scores menu and select “Explode” from the Functions submenu.

The Explode dialog, set to create polyphonic voices.

2.

Make sure that “To Polyphonic Voices” is selected at the top of the dialog.

3.

Use the options in the lower half of the dialog to set up the criteria for the split.
Choose from the following options:

4.

Option

Description

Split Note

Use this to move all notes below a certain
pitch to another voice.

Lines To Tracks

Use this when you want all musical “lines”
to be put in one voice each. The notes with
the highest pitch goes to the first voice, the
notes with the second highest pitch goes to
the second, and so on.

Bass To Lowest Voice

If this option is activated, the lowest notes
always ends up in the lowest voice.

Click OK.
The notes are distributed to different voices.

RELATED LINKS
The Explode function on page 36

Alternative ways of handling voices
Below we suggest further “advanced” ways of putting notes into voices. This is based on the
relation between voices and MIDI channels, so please make sure that you understand how this
connection works.
●

You can use the Logical Editor to put notes into voices, based on other more complex
criteria, like for example their pitch and length. This is done by setting up the Logical Editor
so that the notes that meet the criteria get their MIDI channel changed to that of their
voice.

●

When you enter notes using step input you can change the MIDI channel on your input
device and directly enter notes into separate voices.

●

You can play back each voice on a different MIDI channel, simply by setting the track to
Any. This can be used as a convenient way of “proof-hearing” each voice separately.

●

You can use the Input Transformer to assign a certain key range to a MIDI channel, and
thereby automatically put notes into voices when recording.
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●

For brass and vocals, you might record each voice on its own track, and use the “Merge All
Staves” function to automatically copy each recording to a separate voice on a new track.

●

When you have assigned parts to voices, you can use the Extract Voices function to create
one track out of each voice.

RELATED LINKS
Automatic polyphonic voicing – Merge All Staves on page 77
Converting voices to tracks – Extract Voices on page 78

Handling rests
With polyphonic voices, you often get more rest symbols than desired.
●

If a voice does not need any rests at all, you can deactivate rests separately for this voice
on the Polyphonic tab of the Staff page in the Score Settings dialog.

●

If you only need rests from one voice on a staff, activate Rests–Center for that voice (this
is done in the same dialog). If two or more voices have rests, deactivate Rests–Center. The
program then automatically makes sure the rests do not “collide” in the score, by adjusting
their vertical position.

●

To hide rests in empty bars, you can open the “Reduce Rests” pop-up menu and select “All”.
If you only want whole rests to be hidden, select “Whole rests only”.

●

You can use the Hide feature to remove individual superfluous rests from the score.

●

You can use the Object Selection tool to manually move rests up/down or sideways.

●

If needed, you can add “rest symbols” (rests that do not affect the playback data in any
way) by using the symbols.

RELATED LINKS
Hiding/showing objects on page 166

Voices and Display Quantize
When you insert Display Quantize changes, you can either apply the settings to all voices (by Altclicking with the tool) or to the current voice only.
IMPORTANT
If “Display Quantize Tool affects all Voices” is activated in the Score Settings dialog on the Project–
Notation Style subpage (Miscellaneous category), the Display Quantize settings always affects all
voices (even if you do not press Alt and click).
Making Display Quantize settings for one single voice allows you to do two things:
●

Make each voice have its own Display Quantize settings by inserting a Display Quantize
event for each voice, at the beginning of the staff. This is valid for the entire staff, until
another Display Quantize event is inserted.

●

Insert Display Quantize “exceptions” anywhere in the score, independently for each voice.

PROCEDURE
1.

Make sure that the “Display Quantize Tool affects all Voices” option is deactivated.

2.

Select the voice for which you want to insert a Display Quantize event.
This is done by clicking at the corresponding voice button on the extended toolbar, or by
selecting a note that belongs to this voice.

3.

Select the Display Quantize tool.
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4.

Click at the position at which you want to insert the event.
The Display Quantize dialog appears.

5.

Fill out the dialog.

6.

Click Apply.

RELATED LINKS
Inserting Display Quantize changes on page 34
Display Quantize and Interpretation Options on page 60

Creating crossed voicings
Often, for example in vocal scoring, you have crossed voicings on one system. You can of course
move notes manually into voices to get the stem direction and other note properties right, but
there is a quicker way. Let’s explain how to do this by example. Without using polyphonic voicing,
you have entered this:

PROCEDURE
1.

Open the Score Settings dialog on the Staff page and select the Polyphonic tab.

2.

From the Staff Mode pop-up menu, select Polyphonic.

3.

Activate voice 1 and 2 only, and make settings for them as in the picture below.

4.

Click Apply.
The staff is in Polyphonic staff mode, but all notes are still in the same voice.

5.

Open the Scores menu and select “Explode” from the Functions submenu.

6.

In the dialog that appears, select the “To Polyphonic Voices” option and activate “Lines To
Tracks”.
Leave the other options off.

7.

Click OK.
The notes have now been split in two “lines”, each in a separate voice. However, from the
middle of the bar, notes that are in voice 1 should be in voice 2 and vice versa.

8.

Select the two notes that you want to be moved from voice 1 to voice 2.
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9.

Move the notes to voice 2.
The quickest way to do this is to press Ctrl/Cmd and click the voice Insert 2 button on the
extended toolbar.

10.

Select the two notes that you want to be moved to voice 1 and move them, too.

All notes in the right voices.
RESULT
The voicing is now correct, as you can tell from the stem directions. However, there is still some
work to do on the notes graphical positions and the display of stems and beams for some of the
notes. When you have made those adjustments, the score may look like this:

RELATED LINKS
Graphic moving of notes on page 96
Manual adjustment of beams on page 93

Automatic polyphonic voicing – Merge All Staves
If you have already created some tracks which look and play back as they should, and you want
to combine these into one track with polyphonic voices, there is a special function on the Scores
menu for this:
PROCEDURE
1.

Open the tracks (up to four) in the Score Editor.

2.

Open the Scores menu and select “Merge All Staves” from the Functions submenu.
Now a new track is created and shown in the score. The track has polyphonic voices
activated, and the four original tracks are assigned to one voice each (voices 1, 2, 5 and 6
are used).
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Before…

…and after merging the staves

Furthermore, all non-linked symbols that belong to the staff that become the first
polyphonic voice in the merged staff are copied. They have the same positions as the
original symbols.
IMPORTANT
When you later play back the music, you need to mute the four original tracks, or you get
double notes.

Converting voices to tracks – Extract Voices
This function does the opposite of “Merge All Staves” – it extracts polyphonic voices from an
existing track and creates new tracks, one for each voice.
PROCEDURE
1.

Open a track containing 2 to 8 polyphonic voices in the Score Editor.

2.

Open the Scores menu and select “Extract Voices” from the Functions submenu.
A number of new tracks is created and added to the display of the Score Editor. Each track
contains the music from one polyphonic voice. If there were non-linked symbols in the
original track, each new track gets a copy of these symbols.

IMPORTANT
When you later play back the music, you need to mute the original track (the one with
polyphonic voices), or you get double notes.
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About this chapter
In this chapter you will learn:
●

How to control stem direction.

●

How to control beaming, and create cross-staff beaming.

●

How to make detailed adjustments to note appearance.

●

How to perform “graphic moving” of notes.

●

How to create grace notes.

●

How to create tuplets.

Background: Note stems
The direction of stems is governed by five things:
●

How notes are grouped under beams.

●

Any manual manipulation of beams.

●

The Flip Stems function.

●

How the note information is set for each note.

●

How the Polyphonic tab on the Staff page of the Score Settings dialog is set up (if you use
polyphonic voices).

The order of this list corresponds to the priority of the settings. On conflict, the grouping under
beams has the highest priority and the settings made on the Polyphonic tab the lowest.
IMPORTANT
If you have edited the stem length of a note and then flip it, the stem is reset to default length.
IMPORTANT
If you have activated the “Fixed Stems” option on the Staff page of the Score Settings dialog
(Options tab), a lot of the automatic stem length settings are ignored. However, you can still edit
the stem length and direction of individual notes.

RELATED LINKS
Fixed Stems on page 66
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Setting stem direction
In polyphonic voices

In the Score Settings dialog, on the Staff page (Polyphonic tab), the stem direction can be set
separately for each voice.

Using Flip Stems
Flipping the stem of one or several notes
PROCEDURE
1.

Select the notes.

2.

Click the Flip icon on the extended toolbar.
All the stems in the selection are now flipped. Those that pointed up now point down and
vice versa.

The Flip icon

You can also assign a key command for this. In the Key Commands dialog on the File
menu, the command is called “Flip” and is found in the Score Functions category.
You can also right-click a note or a selection of notes and select the Flip option from the
context menu.

Flipping the stems of notes grouped under a beam
PROCEDURE
1.

Select any note in the group.

2.

Invoke Flip.
The entire group is now flipped.

Before and after the flip. No matter which note you select, the entire group is flipped.
IMPORTANT
This does not work if you have adjusted the slanting of the beam by dragging. If you have,
you must first reset the beam.

RELATED LINKS
Stem length on page 81
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Independent stem direction under a beam
If you need stems attached to the same beam to go in different directions, this is achieved by
dragging the beam’s start and end points. This feature is available in Page Mode only.

Independent stem direction under a beam

RELATED LINKS
Manual adjustment of beams on page 93

Stem direction in the Set Note Info dialog
The Set Note Info dialog can be opened by double-clicking on a note head. In its lower left corner
you can find a pop-up menu for setting stem direction.

●

Setting this pop-up menu to Up or Down is the same as using Flip Stems.

●

Setting this pop-up menu to Auto makes the program set the stem direction automatically.

RELATED LINKS
Using Flip Stems on page 80

Stem length
Adjusting stem length (Page Mode)
PROCEDURE
1.

Click on the end of the stem so that a handle appears.

2.

If you want to change the lengths of several stems at the same time, hold down Shift and
select these stems as well.

3.

Drag the stem handle (on one of the selected stems) up or down.
All selected stems are lengthened or shortened by the same amount.
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Resetting stem length and beam slants
PROCEDURE
1.

Make sure that the filter bar is visible.
If the filter bar is not visible, click the “Set up Window Layout” button on the toolbar and
select the Filters option.

2.

Make sure that the “Stems/Beams” checkbox is activated on the filter bar.
Now, below the notes where stems have been changed or beam slant adjusted manually,
the word “Stem” appears.

3.

Click on the “Stem” text to select it.

4.

Press Backspace or Delete to remove it.

Before and after deleting the “Stem” item.

Accidentals and enharmonic shift
Making global settings
In the Score Settings dialog, on the Project page (Accidentals subpage), you can find a number of
options for how accidentals are displayed in the score. Once set, these are valid for all tracks in
the project. Proceed as follows:
PROCEDURE
1.

Open the Score Settings dialog on the Project page and select the Accidentals subpage
from the Pages list.

You have the following options:
●

Activate the “Courtesy Acc Distance” option and enter a value in the Bars field.
This determines after how many measures courtesy accidentals are shown. If you
set this to “0”, notes outside the scale get accidentals and no courtesy accidentals
are shown.

●

Activate one of the following options:

Option

Description

Force

Notes outside the scale get accidentals, and
accidentals are repeated even within the
same bar.

Force all

Every single note in the score gets an
accidental.
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2.

In the “Outside the Scale” area, you can decide how five of the most common intervals
outside the scale are displayed, as sharps or as flats.
IMPORTANT
If you activate the “Accidentals for Each Note” option in the Score Settings dialog, on the
Project–Notation Style subpage (in the “H.W. Henze Style” category), all notes are displayed
with accidentals (even tied notes).
IMPORTANT
If you activate “Use Chord Track for Accidentals”, the chord track is used to determine the
accidentals.

Enharmonic Shift
If one or several notes are not displayed with the accidentals that you want, you can perform an
Enharmonic Shift operation on them.
PROCEDURE
1.

Select the notes to be shifted.

2.

Click the desired option on the extended toolbar.

3.

If you want the enharmonic shift to be repeated in the whole bar, activate the “Enharmonic
shift for entire bar” option in the Score Settings dialog (Project–Accidentals subpage).

Extended Toolbar

Use these buttons when you want regular Enharmonic Shifting (select one option).

Use this button when you want to deactivate Enharmonic Shifting for the notes.

Use this button when you want to hide the accidental completely.

Use this button when you want to create a “help accidental” for the selected notes
only.

Use this button when you want to enclose the accidental in parentheses. To remove
these, select “off”.

Changing the note head shape
PROCEDURE
1.

Select the notes for which you want to change the note head shape.
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Make sure not to select the stems, only the note heads.
2.

Open the Set Note Info dialog.
To do so, double-click one of the notes, click the “i” button on the extended toolbar, or
right-click on a note head and select “Properties” from the context menu.

3.

Open the “Note Head” pop-up menu in the top left corner of the dialog.
The pop-up menu contains all the available head shapes and an “Auto” option, which
selects the normal default shape for the note.

4.

Select one of the note heads.

5.

Click Apply.
The settings are applied to the selected notes.

6.

If you like, select other notes and make settings for them.

7.

When you are done, close the dialog.

Other note details
Each note has a number of settings in the Set Note Info dialog.

The Set Note Info dialog contains the following settings:
Note Head
Used for selecting custom note head shapes.
Tablature on/off and number
Used for creating or editing tablature. This feature can be used for individual notes
or together with the automatic tablature function.
Bows
Used for adding bow up/bow down articulation. When selecting “Off”, bow symbols
are not displayed for the selected notes.

Bow up and down
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Length
This allows you to change the displayed length of notes, without affecting playback.
Note that the display quantize settings still apply. To reset this value to “Auto” (so
that notes are displayed according to their actual length), scroll the value down to
zero.
Accidental Distance
Use this to specify how far from the note, horizontally, you want the accidental. The
higher the number the greater the distance.
No Ledger Lines
Turns off ledger lines for notes with high or low pitches.

With and without ledger lines

No Stem
Hides the note stem completely.
No Dot
Hides the dot from a dotted note.
No Flag/Beam
Activate this to hide the flags or beams of the selected notes.
Bracket Head
If this option is activated, notes are displayed with brackets:

Bracket Head on and off

X Stem (Spoken)
If this option is activated for a note, it is displayed with an x across its stem. This is
normally used to indicate spoken words.

Hide Note
Activating this checkbox hides the selected notes.
Stem
Determines the stem direction.
Tie
Determines the direction of ties. When this is set to “Auto”, the program chooses a tie
direction depending on the stem direction of the tied notes.
Type
Determines the note type. There are four options:
●

Normal. This is how notes usually are displayed.

●

Grace. When this is selected, notes are displayed as grace notes.

●

Cue. When this is selected, notes are displayed as cue notes (smaller notes,
often used as “guide notes” or optional lines).

●

Graphic. These are special notes, useful for example for guitar notation (pulloffs) and trills (as “help notes”, indicating which notes to trill between). In both
these cases the “No Stems” option could be useful.
Graphic notes are not included in the “automated cutting”. They are positioned
after the notes they “belong to” (as opposed to grace notes).
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Crossed
Activate this option, when you want the stem to be crossed by a slanted line (to
indicate that the note is a grace note).
Grace note options
These options are available when Grace is selected on the Type pop-up menu.
RELATED LINKS
Changing the note head shape on page 83
Creating tablature on page 187
Display Quantize values on page 61
Using Flip Stems on page 80
Grace notes on page 98
Cue notes on page 97
The Cut Notes tool on page 95

Coloring notes
You can assign colors to notes using the Event Colors pop-up menu on the toolbar.
PROCEDURE
1.

Simply select the notes for which you want to use colors, open the Event Colors pop-up
menu on the toolbar and pick a color.
Only the note heads are colored. Note that the color is only visible once the notes have
been deselected.

2.

On the far right on the Score Editor toolbar you can find the Hide Colors button.
If you assigned colors to some or all of the notes in your score, this button allows you to
switch between display of colored or uncolored notes. This may help you to find selected
notes among other colored notes.

Scores Colors for Additional Meanings
If the Preferences dialog (Scores–Colors for Additional Meanings page) you can specify different
colors for elements in the score in order to indicate that they are “special” in any way. You can
for example choose a color for a “Moved Graphic” or a “Moved Slur”. These objects are colored
accordingly when they are moved from their default positions.
PROCEDURE
1.

Open the Preferences dialog (Scores–Colors for Additional Meanings).
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2.

Click in the Active column to activate this function for the corresponding element.

3.

Click in the Color field to the right to select a color.
When color-printing a score, you get the colors you selected for the notes. When you
are using a black-and-white printer, the notes appear in black (notes that have not been
assigned a color) and different shades of gray (depending on how bright/dark a color was
used for the note).

RELATED LINKS
Moving note symbols on page 123

Copying settings between notes
If you have made various settings in the Set Note Info dialog for a note, and want to use these
settings for other notes as well, there is an easy way to do this:
PROCEDURE
1.

Set up the first note as desired.
This includes the settings in the Set Note Info dialog, but also any note-related symbols
such as accents, staccato, articulation, etc.

2.

In the score, select the note and select “Copy” from the Edit menu.

3.

Select the notes to which you want to copy the attributes.

4.

Right-click the notes to which you want to copy the attributes, and select “Paste Attributes”
from the context menu.
The selected notes now get the attributes of the first, copied note, but their pitches and
note values remain unchanged.
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RELATED LINKS
Adding note symbols on page 108

Handling beaming
Turning beaming on/off
Beaming is enabled/disabled independently for each staff.
PROCEDURE
1.

On the Staff page in the Score Settings dialog, click the Options tab.

2.

To turn off beaming, activate No Beams and click Apply.
Even if beaming is deactivated for the staff, you can put some notes under beams.

Grouping
When beaming is on, the program automatically groups notes under beams. However, there are
a number of ways to determine how notes are grouped.

Using the Edit Time Signature dialog
The time signature for the score naturally affects grouping. But you can control this yourself by
creating a composite time signature used only for grouping:
PROCEDURE
1.

Open the Edit Time Signature dialog by double-clicking the time signature symbol for the
staff.

2.

Set up the numerator with the grouping you desire.
If you for example want eighth notes in two groups of three and one group of two, enter
3+3+2.

3.

Set the denominator, if necessary.

4.

Activate “For Grouping Only”.

5.

Click OK.
IMPORTANT
Note that the “For Grouping Only” setting only affects the way the numerator is divided.
Any changes you make to the “sum” of the numerator number or the denominator result
in a change of actual time signature in the project. If you need a grouping which cannot be
entered in the current time signature, you have to group notes manually.
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Regular grouping of a number of eighth notes or smaller (“Beam”)
If the grouping the program assigns is not the one you want, you can put any selection of eighth
notes or smaller under a beam:
PROCEDURE
1.

Select at least two notes, where you want the beam to begin and end.
All notes between these two notes are grouped under a beam.

2.

Click the Group Notes icon on the extended toolbar or right-click on one of the notes to be
grouped and select “Beam” from the “Group/Ungroup” submenu of the context menu.
The Group Notes icon

Before and after grouping

Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust
the “note value” for the symbols.

Grouping quarter notes or larger under a beam (“Brillenbass”)
It is also possible to use the grouping feature for notes that are not displayed with beams
(quarter notes, half notes, etc.). The result are so called “Brillenbass” symbols, commonly used for
indicating repeated accompaniment patterns, etc.

●

Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust
the “note value” for the symbols.

Grouping notes using Repeats
To show Repeats for the grouped notes, proceed as follows:
PROCEDURE
1.

Make sure that the filter bar is visible in the Score Editor.
If the filter bar is not visible, click the “Set up Window Layouts” button on the toolbar and
select the Filters option.

2.

Activate the “Grouping” checkbox in the filter bar.
Now, you see the text “Grouping” below all groups you have created.

3.

Select the desired notes.

4.

Right-click on one of the notes and from the Group/Ungroup submenu, select “Repeat...”
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5.

In the dialog that appears, use the radio buttons to select the desired note value for the
repeats.
In this example, the “Repeat” feature is used to display two pairs of sixteenth notes as two eighth
notes with “repeat bars”. Note that the second and fourth sixteenth note have only been hidden –
playback is not affected!

6.

Click OK.
Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to adjust
the “note value” for the symbols.

Creating an accelerando/ritardando
To create an accelerando/ritardando, proceed as follows:
PROCEDURE
1.

Select the notes and select “Accelerando” from the Group/Ungroup submenu.
A dialog appears.

2.

Use the radio buttons to select the desired combination, that is, define whether you want
an accelerando or a ritardando and specify the desired note values and click OK.

Example for accelerando (left) and ritardando (right)

Double-clicking on the “Grouping” text opens the Grouping dialog, allowing you to select
another combination.

The Grouping dialog
The Grouping dialog can also be opened by double-clicking an existing grouping text in the
score.
●

Which Grouping dialog appears depends on the grouping option you used for the notes
(Beam, Repeats or Accelerando, see above).

Removing groups
If you have created a group and want to remove it, proceed as follows:
PROCEDURE
1.

Make sure that the “Grouping” checkbox is activated in the display filter bar.

2.

Select a group by clicking on its “Grouping” text.

3.

Press Backspace or Delete.
The grouping is removed.
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If you need to remove all groups from the score, hold down Shift and double-click on the
first “Grouping” text.
This selects all “Grouping” symbols, so you can delete them all at once by pressing
Backspace or Delete.

Removing a note from a group
There is no dedicated “ungroup” command, simply because it is not needed. A group can consist
of one note.
●

To remove one note at the end of a group, select it and proceed with grouping as above.

●

If you select notes in the middle of a beam and then group, three groups are created.

Before and after grouping

Automatic grouping
The program can also go through the selected notes and automatically create grouping for you,
where it is deemed suitable.
PROCEDURE
1.

Select the notes that you want checked for auto-grouping.
Typically, you would select all notes on the track by using the Select All command on the
Edit menu.

2.

Right-click on one of the notes and select “Auto Group Notes” from the context menu.
Before and after using auto grouping in 4/4

In 4/4 you get for example two groups of eighth notes per bar, in 3/4 you get one group
per bar, etc.

Cross-staff beaming
To create a beam that extends from one staff to another, proceed as follows:
PROCEDURE
1.

Set up a split or polyphonic voicing system or open the Score Editor with more than one
track.

2.

Set up a beam of notes (using the group command) and adjust their pitches so that they
are correct even though some of the notes are on the wrong staff.
Use the info line to edit the pitches if they are very low or high.

3.

Select the notes that should appear on the other staff.

4.

Select “Display in Staff” from the context menu for a selected note and select a staff from
the submenu.
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The notes are “graphically” moved to the selected system, but keep their actual pitch.

Before and after moving a note to the lower staff

5.

If needed, adjust the beam appearance.

Cross-staff beaming with the beam in the middle

This does not move the affected notes to another track, but merely displays them as if they
belonged to the other staff.

RELATED LINKS
Manual adjustment of beams on page 93

Handling beam groups
There are two settings for groups under a beam, Beam Subgroups and 16th Subgroups, both
found on the Options tab on the Staff page of the Score Settings dialog. If “Beam Subgroups” is
activated, the program displays subgroups after four sixteenth notes under a beam. If you also
activate “16th Subgroups”, subgroups appear after only two sixteenths.

Beam Subgroups off

Beam Subgroups on

On with 16th Subgroups activated

Beam appearance and slant settings
Global settings
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In the Score Settings dialog, on the Project page (Notation Style subpage), you can find the
following three options for beam appearance in the Beams category:
●

Thick Beams
Activate this if you want beams to be displayed as thick lines.

●

Show Small Slants as Flat Beams
If this option is activated, beams that would be only slightly slanted are displayed flat.

Without and with “Show Small Slants as Flat Beams”

●

Slanted Beams only Slightly Slanted
Activate this if you only want a slightly slanted beam even though there might be a
significant pitch difference between the notes under the beam.

Without and with “Slanted Beams only Slightly Slanted”

IMPORTANT
These settings are global for all staves.

Staff settings
In the Score Settings dialog, on the Options tab of the Staff page, you can find a couple of
settings for beams as well:
Flat Beams
Activate this when you do not want any slant at all, no matter the pitch difference of
the notes under the beams.
No Beams
Activate this when you do not want any beams at all.

Manual adjustment of beams
For very detailed control you can manually adjust the beam slant:
PROCEDURE
1.

Group and flip notes and adjust the settings described above until the beams are as close
as possible to how you want them.

2.

Click on the corner made up by the beam and the stem.
A handle appears on the corner of beam and stem.

A beam handle

3.

Drag the handle up or down.
The slant of the beam changes.

Dragging a handle and the effect it has.
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NOTE
You can adjust the distance between notes and their beam without changing the beam
slant. Select both handles of a beam (by pressing the Shift key while selecting the second
handle) and drag one of the handles up or down.

Mixed stem direction
By dragging the beam handles you can put the beam between the note heads:

Putting the beam between the notes

About tied notes
Sometimes, notes are displayed as two or more notes tied together. Generally, there are three
different occasions when this happens:
●

When a note is of an “uneven” length that cannot be displayed without tying together two
or more notes of different note values.

●

When a note crosses a barline.

●

When a note crosses a “group line” within a bar.

The last case requires some explanation: Cubase uses a “cutting mechanism” that automatically
creates tied notes depending on the length and position of the notes. For example, a quarter
note is cut in two and tied if it crosses a half note beat, and an eighth note is cut in two and tied if
it crosses a quarter note beat:

1

This quarter note is cut.

2

This eighth note is cut.

However, this is not always what you want.
RELATED LINKS
Syncopation on page 94
Time signature changes on page 95
The Cut Notes tool on page 95

Syncopation
If the Syncopation option is activated on the Main tab of the Staff page in the Score Settings
dialog, Cubase is less prone to cut and tie notes. For example, the second quarter note in the
figure above would not have been cut if syncopation had been activated.
The Syncopation setting affects the whole track, but you can also make syncopation settings for
separate sections in the score, by inserting display quantize events.
RELATED LINKS
Inserting Display Quantize changes on page 34
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Time signature changes
By inserting time signature changes, you can change the way notes are cut. This is done in the
same way as when you specify how beamed notes are grouped.

With a regular 4/4 time signature

With a composite time signature (3+2+3 eighth notes)

RELATED LINKS
Grouping on page 101

The Cut Notes tool
By using the Cut Notes tool, you can disable the automatic cutting mechanism in a bar, and
insert manual cuts at any given position in the score.
PROCEDURE
1.

Select the Cut Notes tool.

2.

Select a suitable quantize value from the “Quantize Presets” pop-up menu.
As usual, this determines where you can click.

3.

When you are using polyphonic voices, select the voice you want to make settings for.

4.

Click in the bar containing the notes that you want to cut manually, at the position you
want them cut.
This inserts a cutflag event in the bar at the position you clicked. If you hold down Alt, a
cutflag event is inserted for all voices in a polyphonic staff.
A half note, placed at 2.1.3. This is by default cut at 2.3.1 (the middle of the bar). When you
click at the position 2.2.1, a cutflag event is inserted.

As a result, the regular cutting mechanism is disabled and the note is cut at the position
you clicked instead.
The following rules apply to cutflag events:
●

If a bar contains a cutflag event, the automatic cutting mechanism is disabled within
that bar.

●

All notes or rests that start before and end after a cutflag event are cut at the
position of the event.

●

To display cutflag events, make sure that “Cutflag” is activated on the filter bar.

●

To remove a cutflag event, either click again with the Cut Notes tool at the same
position, or select it and press Backspace or Delete.

95

Additional note and rest formatting
Graphic moving of notes

Other options for tied notes
Tie direction
You can set the direction of the tie manually in the Set Note Info dialog.
RELATED LINKS
Other note details on page 84

Flat ties
If you prefer ties to be displayed as flat lines, rather than regular “curved” ties, activate the “Flat
Ties” option in the Score Settings dialog, on the Project–Notation Style subpage (H.W. Henze Style
category).

Graphic moving of notes
There might be instances where the “graphical” order of the notes is not the one you want. In
this case, you can move notes without affecting the score or playback in any way. This can be
done with the Layout tool or using your computer keyboard.

By using the Layout tool
PROCEDURE
1.

Select the Layout tool on the Score Editor toolbar.

2.

Click again on the tool button to open the Mode pop-up menu and select the desired
option.

3.

Click on the note and drag it to the desired position.
Note that movement is restricted to horizontally only.
NOTE
You can also automatically select all notes making up a chord, by holding down Alt and
clicking on one of the notes with the Layout tool.

Modes for the Layout tool
The following modes are available:
Move Single Object
In this mode, only the object you move with the Layout tool is affected (moved). Use
this if you want to “correct” the position of one single note in the score, for example.
Move Notes and Context
In this mode, other score objects are moved accordingly when you move a note with
the Layout tool. Use this mode if you want to correct the display of all score objects
within a bar rather than modifying single note positions.

By using the computer keyboard
You can assign key commands for moving objects graphically. In the Key Commands dialog on
the File menu, the commands are found under the Nudge category and called Graphical Left,
Graphical Right, Graphical Bottom, and Graphical Top (only the Graphical Left and Graphical
Right commands apply to notes).
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After assigning key commands, you select the notes that you want to move and press the
assigned keys to adjust their graphical position.

Cue notes
You can create cue notes by using voices or by converting individual notes into cue notes.

Setting a voice to display cue notes
PROCEDURE
1.

Open the Score Settings dialog on the Staff page and select the Polyphonic tab.

2.

Click in the “Cue” column for the voice, so that a checkmark appears.

3.

Decide how to handle rests for the voice.
You might for example leave “Rests–Show” activated and activate “Reduce”. If you do, you
get rests in this voice, but not as many as otherwise. Empty bars, for example, do not have
any rests at all.

“Cue” activated for voice 3

4.

Close the dialog.

5.

Move the notes into the cue voice.

An example of a cue note voice

RELATED LINKS
Setting up the voices on page 70
Polyphonic voicing on page 68

A quick example
Let’s say you have a flute part and want some cue notes for it:
PROCEDURE
1.

Switch on polyphonic voices and activate voice 1 and voice 2.

2.

Set voice 2 to “Auto” stem direction and centered rests.

3.

Set up voice 1 to be a cue voice, with hidden rests and stems pointing up.

4.

Insert the cue notes into voice 1.

Turning individual notes into cue notes
PROCEDURE
1.

Select one or several notes.

2.

Double-click one of the notes.
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The Set Note Info dialog appears. You can also click the “i” button on the extended toolbar,
or right-click on a note head and select “Properties” from the context menu to open this
dialog.
3.

Select Cue from the Type pop-up menu.

4.

Click Apply.
The settings are applied to the selected notes.

5.

Close the dialog.

Grace notes
You can turn any note into a grace note. Grace notes are considered to be notes without lengths.
This means that once a note is turned into a grace note it does not affect the rest of the score
display in any way.

After the conversion, the grace notes no longer “interfere” with the interpretation of the other
notes.
NOTE
Grace notes are always positioned just before the next note on the staff. If there is no note after
a grace note on the staff, the grace notes are hidden!

Creating grace notes manually
PROCEDURE
1.

Locate the note for which you want a grace note.

2.

Insert one or more new notes just before it.
The note value and exact position of the note is not important. However, the pitch of
course is.
From here on there are two ways to go:
●

Select the notes and open the Set Note Info dialog, either by double-clicking on one
of the note heads or by clicking the “i” icon on the extended toolbar.
In the dialog, select the Grace note type.

●

Right-click on one of the notes and select “Convert to Grace Note” from the context
menu.
This turns the note into a grace note without opening any dialog.
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Grace notes and beaming
If two grace notes are at exactly the same position (the same tick), they are put onto the same
stem, as a chord. If multiple grace notes in front of the same note are put on different positions
(even if they are only one tick apart), they are grouped under a beam.
It is possible to have beamed grace notes overlapping a beam of regular notes, as in the example
below:

Grace notes in the middle of a group of regular notes

Editing a grace note
PROCEDURE
1.

Select one or several grace notes and open the Set Note Info dialog.

2.

Select a note value for the stem.

3.

Activate Crossed, if needed.
If this option is activated, the stem is crossed by a slanted line, to further indicate that the
note is a grace note.

4.

Click Apply.
The settings are applied to the selected notes.

5.

Close the dialog.

Converting grace notes to normal notes
PROCEDURE
1.

Select the notes that you want to convert.
If you want to make sure that all notes in the score are normal notes, you can select all
notes (using the Select All command on the Edit menu).

2.

Double-click on one of the selected grace notes.
The Set Note Info dialog appears.

3.

Select “Normal” from the “Type” pop-up menu.

4.

Click Apply.

Tuplets
The regular Display Quantize values do not apply to any other divisions than triplets. To create
quintuplets, septuplets, etc., follow the instructions below.
There are two methods for creating tuplets:

99

Additional note and rest formatting
Tuplets
●

With permanent alteration to the MIDI data. This is the “drawing” mode to use when you
want to build the tuplet from scratch. It does not put any demand on the notes’ positions
before the tuplet is created.

●

As display quantize. This is the method you use when the tuplet is recorded and plays back
as you want it, but is not displayed correctly.

Actually, in the first case, you make permanent alterations and set display quantize settings, all in
one go. In the second case you only make display quantize settings.

With permanent change to MIDI data
PROCEDURE
1.

Insert as many notes as the tuplet consists of.
This would typically be 5, 7 or 9. If the tuplet contains rests, simply leave space for those,
but make sure that the current Display Quantize value allows them to be shown.

Five sixteenth notes, about to be converted to a quintuplet.

2.

Select all the notes that make up the tuplet.

3.

Select “Build N-Tuplet…” from the Scores menu.
The Tuplets dialog appears.

4.

Set the type of tuplet in the Type field.
“5” means a quintuplet, “7” means a septuplet, etc.

5.

Set the length of the entire tuplet using the “Over” field.

6.

Activate Change Length, if needed.
If you do, the program alters the length of all notes so that they are exactly the note value
the tuplet indicates. If you do not, the lengths of the existing notes is not affected in any
way.

7.

If you want any other text than the standard above the tuplet, enter it into the “Text” field.
The standard text is simply the number in the type field. If the tuplet is put under a beam
the text is put just above it. If there is no beam, the text is found in the middle of a bracket.

8.

Click Build.
The tuplet appears. The notes have now been moved to the tuplet positions and their
length might have changed.

9.

If needed, edit the lengths and pitches of the notes in the tuplet.
You can also make various settings for the appearance of the tuplet.

RELATED LINKS
Tuplet display options on page 101

100

Additional note and rest formatting
Tuplets

Without permanent change to MIDI data
PROCEDURE
1.

Select the notes in the tuplet group.
In this case, the notes play back correctly but are not displayed as a tuplet (yet).

2.

Select “Build N-Tuplet…” from the Scores menu to bring up the Tuplets dialog.

3.

Make settings in the dialog.

4.

Click Quantize.
Now the tuplet is displayed correctly. You can make additional settings for how the tuplet
should appear.

5.

If necessary, adjust the notes.
IMPORTANT
Lengths and positions in a tuplet group are probably best edited using the info line.

Editing tuplet settings
PROCEDURE
1.

Double-click on the text above the Tuplet group to bring up the Tuplets dialog.

2.

Adjust the Text setting.

3.

Click Apply.
The changes are applied to the tuplet, without affecting the tuplet type or length.

Grouping
If the Tuplet is a quarter note long or shorter, the notes are automatically grouped under a
beam. If it is longer you have to perform the grouping manually.
RELATED LINKS
Grouping on page 88

Tuplet display options
In the Score Settings dialog, on the Project–Notation Style subpage (Tuplets category), you can
find the following settings for tuplets:
Tuplet Brackets
There are three possible settings for this option:
●

None: Tuplets never have brackets.

●

Always: Tuplets always have brackets.

●

…by the head: Brackets are shown only when the tuplets are displayed on the
“head side”.

Display Tuplet values by the Beams
If this option is activated, tuplets are displayed on the “beam side” of the notes
instead of on the note head side.
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Suppress Recurring Tuplets
If this option is activated, and you have several tuplets of the same type in the same
bar, only the first of these is displayed as a tuplet.
Show Tuplet Brackets as “Slurs”
If this option is activated, the tuplet brackets are “slur-like” (rounded).
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About this chapter
In this chapter you will learn:
●

What the different types of symbols are.

●

How to insert and edit symbols.

●

Details about special symbols.

Background: The different layers
A score page is always made up of three layers – the note layer, the layout layer and the project
layer. When you add symbols, these are inserted into one of these layers, depending on the type
of symbol. The symbols that have a relation to notes – accents, dynamic markings, slurs, lyrics,
etc. – are put in the note layer. Other symbols, such as some types of text, can be inserted either
on the layout layer (which is individual for each layout) or on the project layer (common for all
layouts). You can change the layer type by right-clicking the symbol and selecting the layer type
from the context menu.

1

Layout layer symbols

2

Note layer symbols

Note layer symbols
●

Note symbols
These are each tied to a single note. Examples of note symbols are accents and lyrics.
When you move the note, the symbol moves with it. The same is true if you cut the note
and then paste; the symbol is cut and pasted together with the note.

●

Note-dependent symbols
Only a few symbols belong to this category, for example the arpeggio lines. In one way,
these behave just like grace notes. They always precede a note or chord. If there is no note
“after them” on a staff, they disappear.

●

All other note layer symbols (tempo, dynamics, chords, etc.)
Their position is related to the bar. Whichever way you edit the notes, these symbols
remain unaffected. However, their positions are fixed within a measure. If you for example
change the spacing of the bars across the page, this affects the symbols positions.
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RELATED LINKS
Setting the number of bars across the page on page 171
Grace notes on page 98

Layout layer symbols
Now let’s examine the layout layer symbols. The layout layer is not stored individually for each
track, as the other symbols are. Instead it is common to a “set of tracks”. Let’s illustrate this with
an example:
You have four tracks that make up a string quartet. You edit them all at the same time and add
symbols to the score, both note layer symbols and layout layer symbols.
Now you close the Score Editor and open only one of the tracks for editing. All your note layer
symbols are there just as you left them, but the layout layer symbols have disappeared! Don’t
worry, close the editor again, and open all four tracks for editing and the symbols are back.
This is due to the fact that the layout layer symbols are part of a “bigger entity” called “layout”.
And a layout is something that is stored not per track, but for a group of tracks. Each time you
open the same combination of tracks for editing, you get the same layout.
RELATED LINKS
Working with layouts on page 154

Project layer symbols
Project layer symbols are layout symbols that are present in all layouts.
Using project layer symbols in conjunction with the Arranger mode, you can have playback in the
program follow the score – repeats, Da Capos, and endings are played back properly allowing
you to hear your compositions as they would be played back by live players.

Why three layers?
There are several reasons for this division into layers:
●

Many of the symbols that are in the layout layer can be stretched to span over several
staves, or for other reasons make more sense to think of as belonging to a certain group
of tracks.

●

The layout layer is only one part of the bigger concept of layouts. Layouts allow you to
easily extract parts from a full score and perform automatic formatting.

●

Typically, you want to display some symbols – repeat barlines, endings, score titles, etc. –
for all layouts in a score. To achieve this, insert them on the project layer.

RELATED LINKS
Working with layouts on page 154
The available symbols on page 106

The Symbols Inspector
To display the Symbols Inspector, click the “Set up Window Layout” button on the toolbar and
activate the Symbols option.

Customizing the Symbols Inspector
You can customize the appearance of the Symbols Inspector by showing/hiding sections and by
specifying their order in the Inspector.
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Showing/Hiding Symbols Inspector Sections
If you right-click any Inspector section, a context menu appears. On this menu, you can directly
check (show) or uncheck (hide) elements of the Inspector as desired.
You can also select different preset configurations from the lower half of the menu. To display all
Symbols Inspector sections, select “Show All”.

The Symbols Inspector Setup dialog
If you right-click any closed section in the Symbols Inspector and select “Setup…” from the
context menu, a dialog appears. In this dialog you can configure where the separate sections are
placed in the Inspector and save/recall different configurations of the Inspector.

The dialog is divided into two columns. The left column displays the visible sections in the
Inspector, and the right column displays the hidden sections.
●

You can change the current show/hide status by selecting items in one column and using
the arrow buttons in the middle of the dialog to move them to the other column. The
changes are reflected directly in the editor.

●

You can change the order of the (visible) section in the Symbols Inspector with the “Move
Up” and “Move Down” buttons.
The changes are reflected directly in the Score Editor.

A customized Symbols Inspector
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●

If you click the Save button (disk icon) in the Presets section, you can name the current
configuration and save it as a preset.

●

To remove a preset, select it and click the trash icon.

●

Saved configurations are available for selection from the Presets pop-up menu in the
dialog or directly from the Inspector context menu.

●

To revert back to the default Inspector settings, right-click any of the section and select
“Reset All” from the context menu.

Working with symbol palettes
You can open any of the Symbols Inspector sections as separate symbol palettes.

Opening sections as palettes
PROCEDURE
1.

In the Symbols Inspector, open the desired symbols section.

2.

Right-click on any of the symbols in the section.
Note that you have to right-click on a symbol. Right-clicking a section header opens a
different context menu instead.

3.

Select “Open As Palette” from the context menu.

The selected section is shown as palette.

Moving and handling palettes
Palettes are handled as any window, which means that you can:
●

Move a palette to another position by dragging its title bar.

●

Close a palette by clicking its close button.

In addition, you can select whether the palette is shown horizontally or vertically, by right-clicking
and selecting “Toggle” from the context menu.

The available symbols
The following symbols palettes/tabs are available:
●

Quick Staff Setup

●

Favourites

●

Keys

●

Clefs

●

Time Signature

●

Chord Symbols

●

Guitar Symbols

●

Expression Map

●

Dynamics Mapping

●

Clefs etc.

●

Note Symbols
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●

Dynamics

●

Line/Trill. Note that the arpeggios, hand indication and strum symbols are all “notedependent”!

●

Other

●

Form Symbols. These symbols can be selected for the note layer, the layout layer, and the
project layer.

●

Words

●

User Symbols

When you place the mouse pointer on a symbol, a tooltip shows you information about the
function.
RELATED LINKS
Working with mapped dynamics on page 195
The Words Section on page 149
User Symbols on page 131
Symbol details on page 126

Setting up the Favourites Section
In the Symbols Inspector, you can find a section called Favourites. Cubase allows you to fill this
section with a selection of symbols from other sections. This way, you have instant access to the
symbols you use often:
PROCEDURE
1.

Open the Favourites section.
If it is the first time you are using this section, it is empty.

2.

Open the section from which you want to copy a symbol.
NOTE
Not all symbols can be added to the Favourites section.

3.

Right-click on the symbol that you want to add to the Favourites section and select “Add to
Favourites” on the context menu.
You can also add a symbol to the Favourites section by Alt-clicking on it.

4.

Repeat this procedure for other symbols that you want to add to the Favourites section.
To remove a symbol from the Favourites section, select “Remove from Favourites” from the
context menu or hold down Alt and click on it.

Important! – Symbols, staves, and voices
Most symbols belong to a staff when inserted. Only note symbols, slurs and ties are an
exception. They belong to notes and therefore to voices.
It is extremely important that the correct staff is active when you insert a symbol (if you are
editing multiple staves).
If you for example insert a symbol while the wrong staff is active, the symbol might later
“disappear” because you edit another configuration of tracks (the track you actually inserted the
symbol on might not be opened for editing).
The same is true for note symbols and their relation to voices. Make sure that the correct voice
is active when inserting symbols or they might wind up at the wrong position, fermatas may be
turned upside down, etc.
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Layout symbols work slightly differently. Instead of belonging to a certain staff or voice, they
belong to a layout. Since different track combinations use different layouts, this means that if
you insert a layout symbol in the score when you are editing two tracks (for example a trumpet
and a saxophone part), it is not there when you view each track by itself in the Score Editor. If you
want the same symbols to appear in other layouts as well, you can copy the form of one layout to
another. If you want a symbol to appear in all layouts, use the Project layer.

Adding symbols to the score
Making space and handling margins
●

If you find there is not enough space between staves to add symbols (like for example
text), you can separate the staves.

●

If you find the score looks crammed after adding symbols, you can use the options in the
Auto Layout dialog.

IMPORTANT
Symbols you add outside the margins are not printed!

RELATED LINKS
Dragging staves on page 173
Auto Layout on page 177

About the Draw tool
Unlike the other MIDI editors, the Score Editor toolbar does not contain a Draw tool. Instead, the
Draw tool is “automatically” selected when you insert symbols. The following applies:
●

Normally, the Draw tool is automatically selected when you click on a symbol in the
Inspector. However, if the “Double-Click Symbol to get Draw Tool” option is activated in the
Preferences dialog (Scores–Editing page), you need to double-click the symbol to get the
Draw tool.

●

On the same page of the Preferences dialog, you can find an option called “Display Object
Selection tool after Inserting Symbol”. If this option is activated, the Object Selection tool is
automatically selected after you have inserted a symbol.
If you want to insert a lot of symbols with the Draw tool, you may want to deactivate this
option.

Adding note symbols
Adding a symbol to one note
PROCEDURE
1.

In the Symbols Inspector, open the Note Symbols section.

2.

Click (or double-click) on the desired symbol in the section.
As mentioned above, the “Double-Click Symbol to get Draw Tool” preference determines
whether you need to double-click. In either case, the Draw tool is selected.

3.

Either click on the note or above or below it.
If you click on the note, the symbol is put in at a predefined distance from the note. If you
instead click “above or below” the note, you decide for a vertical position yourself. In either
case, the symbol is aligned horizontally with the note. It can later be moved up/down.
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Clicking on a note inserts the note symbol (in this case a tenuto) at a predefined distance from the
note head.

There are three options in the Accents category of the Score Settings dialog (Project page–
Notation Style subpage) that affect the vertical positioning of note symbols:
●

Accents above Stems
If this option is activated, accent note symbols are displayed at the stem side of
notes instead of the note head.

●

Accents above Staves
If this option is activated, accent note symbols are displayed above the staff,
regardless of the stem direction of the notes. This setting overrides the “Accents
above Stems” option.

●

Center Note-Linked Symbols on Stems
If this option is activated, accents are centered on stems and not on note heads.

Adding a symbol to several notes using the Draw tool
You might for example want to add a staccato symbol to all notes within a few measures.
PROCEDURE
1.

In the Symbols Inspector, open the Note Symbols section.

2.

Select the notes to which you want to apply the symbol.

3.

In the Symbols Inspector, click on the desired symbol.

4.

Click on one of the notes.

The symbol is added to each selected note, at a predefined distance. The symbols can be
moved later.

Adding a symbol without tying it to a note
Note-dependent symbols can be entered freely, too. This allows you to add a fermata to a rest
symbol for example.
PROCEDURE
1.

Make sure that the correct staff is active.

2.

Click the symbol so that the Draw tool is selected.

3.

Hold down Ctrl/Cmd and click where you want to add the symbol.

Adding other symbols
PROCEDURE
1.

In the Symbols Inspector, open the desired symbol section.

2.

Click the symbol that you want to add.

3.

Click once or click and drag somewhere in the score.
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The symbol appears. For many symbols with a length, you can drag to set the length of the
symbol directly. The symbol appears with its handles selected (if it uses handles) so that
you can change its size directly.

Press the mouse button – drag – and release!

You can change the size of most of the note symbols and dynamics in a score by rightclicking the corresponding object and selecting the desired option from the Size submenu
on the context menu.

RELATED LINKS
Changing length, size, and shape on page 123

About note-dependent symbols
Note-dependent symbols like arpeggios and strum directions must be put in front of a note
or they belong to the following note instead (if there is no following note, the symbols are not
inserted at all).

Adding text
There are special methods for working with text.
RELATED LINKS
Working with text on page 139

Adding slurs and ties
Slurs can be drawn in manually or inserted automatically for a group of notes. Ties are usually
added by the program but can also be drawn in as “graphic” symbols.
NOTE
There are two types of slurs – “regular” slurs and Bezier slurs (with which you have full control
over thickness, curve shape, etc.).

Slurs, ties, and the Display Quantize value
Since a slur or tie “musically” always spans from one note (or chord) to another, the beginning
and end of a slur/tie in Cubase is always related to two notes in the score.
When you draw in a tie or slur, the program uses the Quantize value to find the closest two notes
to “attach” the symbol to. In other words, if you want to add the slur/tie to a note at a sixteenth
note position, make sure Quantize is set to 1/16th notes or smaller (this is only true for manual
drawing in of slurs and ties).
Please note that this does not necessarily mean that the symbol has to start or end exactly
above/below two notes. Instead, what it means is that when you use the Layout tool to move the
note graphically to adjust the look of the bar, the slur/tie moves with it. The same is true if you
adjust the width of the measure – the slur/tie is adjusted accordingly.
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NOTE
If you want the end points of the slurs to snap to exact note positions, activate the “Snap Slurs
when dragging” option on the context menu or in the Preferences dialog (Scores–Editing page).

RELATED LINKS
Graphic moving of notes on page 96

Drawing the slur/tie
PROCEDURE
1.

Set the Quantize value depending on the positions of the two notes that the slur/tie should
span.
For example, if one of them is at a quarter note position and the other at an eighth note
position, set Quantize to 1/8 note or a smaller note value.

2.

Click on the correct slur/tie in the Symbols Inspector, so that the Draw tool is selected.

3.

Position the mouse close to the first note and drag to a position close to the second note.
The end points of the slur/tie snap to their default positions – holding down Ctrl/Cmd
allows you to move the end points freely.
There are two special functions for inserting a slur or tie that automatically spans from one
note to another.

Adding a slur/tie between two notes
PROCEDURE
1.

Select two notes.

2.

Click the correct slur/tie symbol in the Inspector, so that the Draw tool is selected.

3.

Hold down Ctrl/Cmd and Shift and click on one of the two notes.
The slur/tie is added between the two selected notes.

Inserting a slur over a selection of notes
PROCEDURE
1.

Select a span of notes.

2.

Open the Scores menu and select “Insert Slur”.

A slur is created, starting at the first selected note and ending at the last.

The Bezier slur
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The Bezier slur is a special slur symbol, found in the Dynamics symbol section. Unlike the regular
slur, this symbol is made up of a bezier curve, allowing you to create more advanced curve
shapes.
To add a Bezier slur, click the symbol in the Inspector so that the Draw tool is selected, and
click or drag in the score. Clicking creates a Bezier slur of the default length and shape, while
dragging creates a straight line.
The default Bezier slur has four curve points – one at each end and two along the curve.

●

To move the slur, click on it (but not on a curve point) and drag.

●

To resize the slur, click and drag the end points.

●

To change the shape of the slur, click on one of the middle curve points and drag in any
direction.

Right-clicking on a curve point brings up a context menu with the following options:
Add Points/Reduce Points
Adds another pair of curve points to the Bezier slur. This allows you to create very
complex slur shapes. After adding points, there is an additional menu item “Reduce
Points” – selecting it removes the additional curve points.
Add Thickness
Makes the Bezier slur thicker.
Reduce Thickness
Makes the Bezier slur thinner.
Hide
This hides the slur symbol.
RELATED LINKS
Hiding/showing objects on page 166

Creating trills
If you have recorded or entered a trill, Cubase can help you display this properly:
PROCEDURE
1.

Select the notes that make up the trill.

2.

Right-click on one of the notes and select “Build Trill…” from the context menu.

3.

Select an option from the dialog that appears.
The radio buttons determine how the trill should look. Activate the “Help Note” option if
you want an extra note to indicate between which notes the trill should be played.

4.

Click OK.

RESULT
●

All notes except the first one (and possibly the second) are hidden.

●

The first note automatically gets a display length matching the length of the whole trill.
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●

If you choose to include a help note, the second note is converted to a “Graphic” note, with
brackets but without stem. Otherwise, the second note is hidden, too.

●

The trill symbols you selected in the dialog are inserted.

Inserting symbols across staves
If you hold down Alt while adding a symbol to one staff in a grand staff, this symbol is put in at
corresponding positions on all staves. This allows you for example to insert rehearsal marks,
repeats, etc. for all instruments at the same time.

Adding a keyboard symbol

The Other section contains a piano keyboard symbol, useful in educational scores, for example.
The symbol has the following properties:
●

To insert the keyboard symbol, select it from the Inspector, click with the Draw tool at the
desired position and drag a box to specify the approximate size of the keyboard.

●

After you have inserted the keyboard symbol, you can drag its edges to resize it vertically
or horizontally.

●

If you right-click on an inserted keyboard symbol and select “Properties” from the context
menu, a dialog opens allowing you to specify further properties for the symbol.
You can also double-click on an inserted keyboard symbol to open this dialog.

Size
Governs the width of the keys.
Start Note
This is the leftmost note in the keyboard symbol.
Show Note Names
If this option is activated, each C key is displayed with note name and octave (C1, C2,
etc.).
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White/Black Keys transparent
Activate these if you want the white and/or black keys to be transparent.

Adding guitar chord symbols
A fretboard symbol of a guitar chord can be inserted anywhere in the score.
Guitar symbols are found in the “Guitar Symbols” section and the Other section in the Symbols
Inspector.
●

The Guitar Symbols section contains all Guitar symbols of the current guitar library. If the
symbol that you want to insert is among these, select it and insert it as you would any
other symbol, see above.

To insert a guitar symbol not present in the guitar library, proceed as follows:
PROCEDURE
1.

Open the other section.

2.

Click on the guitar chord symbol, so that the Draw tool is selected.

3.

Click in the score, at the position where you want the symbol to appear.
The Guitar Symbol dialog appears.

●

To put a dot on any fret and string, click on it.
To remove it, click again.

●

To add a symbol just above the string, outside the fretboard, click there.
Consecutive clicks allow you to select between a ring (open string), a cross (do not
play this string) and no symbol.

●

To add a capodaster number, click to the left of the symbol.
Consecutive clicks allow you to step through the possibilities.

●

You can also add a capodaster symbol (a line over the strings), by setting the “Capo
String” parameter to a value higher than 0.
By adjusting the Capo End and Start values, you can create capodaster symbols that
span fewer strings.

4.

●

Use the “Size” value field to adjust the size of the chord symbol.

●

If you want the symbol to be horizontal, activate the “Horizontal” checkbox.

●

To display more or fewer frets than the default six, change the “Frets” value.

Click Apply.
The guitar symbol appears in the score.
●

Clicking the Insert Notes button inserts the actual notes in the chord into the score.
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You can also right-click on a guitar symbol and select “Insert Notes” from the context
menu.
You can edit the symbol at any time by double-clicking it, changing the settings in
the dialog and clicking Apply. Note that you can also access the symbols that you
defined in the guitar library by right-clicking a guitar symbol.
NOTE
If you select “Make Chord Symbol” from the context menu, the corresponding chord
symbol is displayed above the guitar symbol. This function is very useful when writing lead
sheets, for example.

RELATED LINKS
Using the guitar library on page 115

Using the guitar library
The above method is fine if you only want to add a few chord symbols to your score. If you need
a lot of chord symbols, or if you are using chord symbols in a lot of different scores, you can
gather all your chord symbols in a “guitar library” instead. This way you do not have to recreate
the same chord symbol over and over again.

Defining chord symbols
PROCEDURE
1.

In the Symbols Inspector, double-click on one of the symbols in the Guitar Symbols section
to open the guitar library.
Alternatively, you can open the Score Settings dialog on the Project page and select the
“Guitar Library” subpage.

2.

To add a guitar chord symbol to the library, click the New button.
A chord symbol appears in the list to the left.

3.

To edit the chord symbol, double-click it in the list.
This opens the Guitar Symbol dialog, as when editing a chord symbol in the score.
●

The symbol you create is also “interpreted” and its name is displayed to the right of
the fretboard symbol.
This can also be edited by double-clicking if you like.

●

To sort the available symbols in the library according to their root notes, click the
Sort button.

115

Working with symbols
Adding symbols to the score
●

To remove a symbol from the library, select it in the list and click Remove.

●

To save the current library as a separate file, select “Save…” from the Functions popup menu.
A file dialog appears, allowing you to specify a name and location for the file.

●

To load a guitar library file, select “Load Current Pane…” from the Functions pop-up
menu.
In the file dialog that appears, locate and open the desired guitar library file.

IMPORTANT
Loading a guitar library file replaces the current library!

RELATED LINKS
Using Make Chord Symbols on page 136

Inserting symbols from the library
To insert symbols from the guitar library into the score, proceed as follows:
●

Right-click on a guitar symbol in the score and select a chord symbol from the Presets
submenu on the context menu.

Adding an image file
You can insert image files as symbols into the Score. This allows you to import logos, copyright
symbols, images of finger positions, etc.
PROCEDURE
1.

In the Symbols Inspector, open the Other section.
Image files can be inserted on all three layers.

2.

Click the Image File button to select the Draw tool. Click in the score at the position where
you want to insert the file.
A file dialog opens.

3.

Locate and select the image file you want to insert.
The lower section of the Import dialog contains the following settings:
●

To copy the referenced file into the Project folder, activate the “Copy to Project
folder” option.
This is recommended as it makes it easier to manage all files used in a project.

4.

●

If you modify your score, by adding staves for example, the position of an inserted
image file changes. If this is not what you want, activate “Stick to Page” to keep it at
a fixed position in your staff.

●

The Transparency parameter allows you to set the desired transparency of the
image.

Click Open to insert the file.
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RESULT
The image file is inserted. Its size depends on the printer resolution. However, you can scale the
image by dragging its handles. To restore the printer resolution, right-click on the image to open
the context menu and select “Snap to Printer Resolution”.
You can modify the settings you made on import by right-clicking the image and selecting
“Properties” on the context menu, to open the Image Properties dialog.

RELATED LINKS
Background: The different layers on page 103

Using layout symbols
Layout symbols and texts are inserted on the layout layer. When you are editing a layout
containing several tracks, you can have inserted layout symbols and texts automatically copied to
any combination of tracks in the layout. You decide which staves should display layout symbols
and texts by ticking their “L” column in the Score Settings dialog, on the Layout page.

●

Any editing you perform to layout symbols and texts is automatically duplicated in the
other tracks.

●

The display of layout symbols and texts for different tracks can be deactivated at any time.

●

Layout symbols and texts can be copied between layouts, by using the Get Form function
on the Functions pop-up menu on the Layout page of the Score Settings dialog.

One example of how to use layout symbols and texts:
Let’s say you are editing a full orchestra score, and want rehearsal marks inserted for more than
one staff (typically, above each instrument group – brass, strings, percussion, etc.). Now all you
need to do is insert the rehearsal marks for one of the tracks. To do so, open the Score Settings
dialog on the Layout page, tick the “L” column for the desired tracks/staves, and click Apply.

Using Project symbols
Project symbols are part of the project layer and therefore appear in all layouts. The project layer
also contains changes to barlines, such as repeats and double barlines, and bar number offsets.
Typically you use Project symbols when you know you want these shown for all combinations of
tracks.
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NOTE
You can use Project symbols together with the Arranger mode, if you want the program to play
back according to the score.

RELATED LINKS
Scores and the Arranger mode on page 195

Selecting symbols
Almost all symbols can be selected by clicking on them. For symbols that have a length or size,
one or more handles appear.

A selected crescendo

An exception to this are the slurs and ties which can be selected by clicking on the end points or
by drawing a selection rectangle.

Using the lock layers
Sometimes it can be very hard to click on a symbol or other object in the score without
accidentally selecting other symbols nearby. To remedy this, you can assign different types of
objects to different “lock layers” (up to three) and instruct Cubase to “lock” one or two of these
layers, making them “unmovable”. Furthermore, you can lock the layout and project layers
separately if needed.

Setting up the lock layers
PROCEDURE
1.

Open the Preferences dialog and select the Scores–Note Layer page.

2.

Assign each event type to a layer (1, 2, or 3).
It is a good idea to specify different layers for event types that might conflict “graphically”.
For example, you might want to assign bar numbers and note symbols to different layers
if you find that you accidentally move bar numbers when editing note symbols and vice
versa.

3.

Click OK.
Alternatively, you can right-click on one of the Layer buttons (1-2-3) on the extended
toolbar to bring up a pop-up menu, showing which object types are associated with that
layer.
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A checkmark for an object type means it belongs to that layer. If no checkmark is shown,
you can select the object type from the pop-up menu to move it to that layer.

Locking a layer
To “lock” a layer, click on its lock layer button.

In this figure, layer 2 is locked. Event types assigned to layer 2 cannot be selected, moved, or deleted.

Visual indication of the layers
Objects belonging to locked note layers are “grayed out” in the score. This makes it very easy to
find out which object belongs to which layer – perhaps especially useful for the layout and project
layers. For example, to quickly spot all objects in the layout layer, lock all other layers by clicking
their buttons. Now, only layout layer objects are shown normally; all other objects are grayed
out.

Moving and duplicating symbols
There are four ways to move and duplicate symbols:
●

By dragging them with the mouse.

●

By using the computer keyboard (moving only).

●

By using the bar handles.

●

By using the Paste Attributes function (duplicating note symbols only).

RELATED LINKS
Moving by using the computer keyboard on page 121
Moving and duplicating with the bar handles on page 121
Copying settings between notes on page 87

Moving and duplicating by using the mouse
This is done much as with other objects in Cubase. The following rules apply:
●

Note symbols and note-dependent symbols move with the notes/chords they belong to. In
other words, if you move the note/chord, the symbols move with it/them.

●

Note symbols (like accents and lyrics) can only be moved vertically. Other symbols (like
braces and brackets) can only be moved horizontally.

●

All other symbols without handles can be moved freely. If you hold down Ctrl/Cmd,
movement is restricted to one direction only.
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●

If the symbol has one or more handles when it is selected, do not drag it by the handles, or
you change its shape instead of moving it.

●

Slurs and ties are an exception, as they can only be moved by first dragging one handle
and then the other. However, if you use the Layout tool to move the notes they belong to,
or if you change the measure width, they are adjusted automatically.

●

Duplicating is done by moving with Alt pressed, as always in Cubase. Slurs, ties, and
barlines cannot be duplicated with this method.

There are two features to help you position symbols (and other score objects) correctly: the
rulers and the Position Info window.
RELATED LINKS
Graphic moving of notes on page 96

The rulers
Unlike other editors, the Score Editor does not have a meter/time position-based ruler. Instead,
its rulers are “graphical”, that is, they indicate the actual x-y position of objects (with “zero” at the
upper left corner).

●

The current pointer position is indicated by thin lines in the rulers.

●

To hide the rulers, right-click on a ruler and select “Off”.
This pop-up menu can also be found above the scrollbar at the far right.

●

To display the ruler again, open the pop-up menu above the scrollbar at the far right and
select one of the units (inches, centimeters, or points).
This setting also affects the units used in the Position Info window.

The Position Info window
If you need to fine-tune the graphical positions of symbols and other objects, you should use the
Position Info window. This makes positioning easier in two ways:
●

You get a numerical indication of the exact position of the mouse pointer (and any object
you are dragging).

●

You can move objects or staves by typing in position values.

You display the Position Info window by clicking in the ruler.

The window contains the following settings and values:
Measure in
Click this label to change units for the Position Info window. You can toggle between
inch, cm, and pt. This choice also affects the units used in the rulers.
Abs. Pos./Rel. Pos
Click this label to select whether X-Y position values are “absolute” (referring to the
upper left corner of the current page) or “relative” (referring to the upper left corner
of the active staff).
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X, Y
When a single object is selected, these values show the horizontal and vertical
position of this object.
When no objects or several objects are selected, these values show the current
horizontal and vertical position of the pointer.
When a single object is selected, you can click on these values and type in a new
position for the object.
dX, dY
When you are moving an object, these values indicate the horizontal and vertical
distance you have moved it.
You can click and type in values to move the objects by the specified distances.
Sel. Staff
If “Abs. Pos” is selected, this value shows the distance from the top of the score page
to the top of the active staff.
You can click and type in a value to move the active staff. If “Rel. Pos” is selected, this
value is always 0, since vertical positions are related to the top of the active staff!
To Prev Staff
The distance between the active staff and the staff above it. Clicking and typing in a
value moves the active staff.
To Next Staff
The distance between the active staff and the staff below it. Clicking and typing in a
value moves the staves below the active staff.

Dragging symbols across staves
If you drag a symbol across the staves, you can see how the “active staff” indicator to the left
follows the mouse pointer. Use this as an indication to make sure that symbols end up in the
correct staff.
●

If you are editing several tracks at the same time, and want to make sure that a symbol is
not accidentally moved to another track when you drag it vertically, activate the Lock “L”
button on the extended toolbar.
If this option is activated, you cannot move symbols across staves by dragging.

Moving by using the computer keyboard
In the Key Commands dialog, you can assign key commands for moving symbols, notes, or rests
graphically. The commands are found in the “Nudge” category and are called “Graphical Left”,
“Graphical Right”, “Graphical Top”, and “Graphical Bottom”.
Selecting an object and using one of these commands is the same as dragging them with the
Layout tool, but this method offers higher precision.

Moving and duplicating with the bar handles
This function allows you to move or copy the contents of a whole bar to one or several other
bars. You can select which elements in the bar will be included in the operation.
PROCEDURE
1.

Make sure that the filter bar is visible.
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If the filter bar is not visible, click the “Set up Window Layout” button on the toolbar and
activate the Filters option.
2.

On the filter bar, make sure that the “Bar Handles” option is activated.
Now, each bar in the score is shown with a handle in the upper left corner.

3.

Double-click on the handle of the bar from which you want to copy or move symbols.
The Bar Copy dialog appears.

4.

Make sure that only the symbol types that you want to move/copy are checked.

5.

If you have several subsequent bars to which you want to copy symbols, set the “Repeats”
value to this number of bars.
If you only want to copy symbols from one bar to another, make sure that “Repeats” is set
to 1. This option is only available for copying, not for moving.

6.

If you want this dialog to appear every time you perform the move/copy operation,
activate “Show Dialog”.

7.

Click OK.

8.

To copy the specified event types to another bar, hold down Alt, click on the bar handle of
the first bar and drag it to the “target” bar.
To move the event types instead of copying them, drag the bar handle without holding
down Alt.
If you activated “Show Dialog”, the Bar Copy dialog appears, allowing you to confirm your
settings.
Click OK to close the dialog and perform the operation.

RESULT
If you activated “Note Symbols”, the note symbols are copied from the “source” bar and pasted
onto notes at the same positions in the “target” bar. If there is a note symbol for a certain note
in the “source” bar, but no note at the corresponding position in the “target” bar, the symbol is
ignored.
The actual positions of notes are used as a basis for this operation – not the displayed positions.
If you copy the note symbols from the first bar to the second bar, only symbols that find
corresponding note positions in the second bar are copied.
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●

If you activated other types of symbols, these are simply moved to the same graphical
position in the “target” bar.

●

If you set “Repeats” to a number larger than 1, the same symbols are pasted into that
number of bars (starting from the one you drag the bar handle to).

●

If you do not hold down Alt when dragging the bar handle, the symbols (and other event
types specified in the dialog) are removed from the “source” bar.

IMPORTANT
If there already are symbols (or other objects) of the specified types in the “target” bars, these
are removed.

Moving note symbols
Note symbols, slurs and ties all have “default positions”. This determines the vertical distance
between the note heads and the symbol.
●

You can manually adjust the vertical positions of individual symbols, but if you move or
transpose their notes, the symbols are automatically reset to their default positions.
This also ensures that note symbols and slurs are positioned sensibly when you change
the Display Transpose settings.

●

To reset the vertical positions of note symbols and slurs in a score, right-click on the
corresponding object and select “Default position” from the context menu.

Changing length, size, and shape
You can change the shape of any symbol that has a length.

Changing the length of a symbol
PROCEDURE
1.

Select the symbol.
The handles appear.
Symbols with a length have two handles when selected.

2.

Drag one of the handles.
You may be restricted to vertically or horizontally only, depending on the type of symbol.
IMPORTANT
In the Preferences dialog (Scores–Editing page), there is a preference called “Keep
Crescendo Symbols Horizontal”. If this option is activated, crescendo and diminuendo
symbols are never slanted.

Resizing note symbols and dynamics
PROCEDURE
1.

Right-click on a dynamic or note symbol.

2.

Select the desired option from the Size submenu.
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The size of the symbol changes accordingly.

Altering the shape and direction of slurs and ties
This section describes how to alter the “regular” slur and tie symbols.
There are two types of slurs and ties in the Symbols Inspector. The up/down variation of each
actually represent the same symbol but with different initial direction. You can perform the
following editing to slurs and ties:
●

By dragging the middle handle up/down and left/right you can change the shape of the
curve.

●

By selecting a slur or a tie and clicking the “Flip” symbol on the extended toolbar or by
selecting “Flip Position” on the context menu, you can change the direction and positioning
of the slur or tie.
Actually, there are three “modes” for a slur or tie. You step through these three modes by
clicking the button.

●

By dragging the end points of a slur or tie, you can change its shape without affecting its
“relation” to the notes it belongs to.
In other words, the end point of the slur/tie keeps its relative distance to that note when
the note is moved with the Layout tool or when the measure width is adjusted.

●

By holding down Ctrl/Cmd and dragging the end points of a slur or tie, it can be detached
from the notes it belonged to.
NOTE
To restore the default shape of a symbol, right-click on it and select “Default position” from
the context menu.

●

To change the default shape and spacing of slurs and ties, open the Score Settings dialog
on the Project–Spacings subpage and edit the “Slur’s Start & End Distance from Note Head”
and “Slur’s Middle Distance from Note Head” settings.
These settings are used for all new slurs and ties you create, as well as for all existing slurs
for which you have not manually changed the shape.

RELATED LINKS
The Bezier slur on page 111
Moving note symbols on page 123
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Deleting symbols
This is done as with all other objects in Cubase, either with the Erase tool or by selecting it and
pressing Delete or Backspace.

Copy and paste
All symbols except those on the Layout and Project layers can be copied and pasted just as any
other object in Cubase. The following applies:
●

Symbols that were tied to notes, such as accents, become “free-floating” objects when
pasted.
That is, they are not tied to any note any more. If this is not what you want, consider
copying with the bar handles.

RELATED LINKS
Moving and duplicating with the bar handles on page 121

Alignment
Symbols can be aligned as in drawing programs.
PROCEDURE
1.

Select all objects that you want to align.

2.

Open the Scores menu and select an option from the Align Elements submenu.

IMPORTANT
Note symbols like staccato and accents can only be aligned horizontally.
The “Dynamics” option is a special function for aligning dynamic symbols.

RELATED LINKS
Aligning dynamics on page 128
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Symbol details
This section further describes some of the symbol sections.

The Quick Staff Setup Section

This section combines the basic settings for Display Quantize, staff mode, as well as staff presets
for quick access.
RELATED LINKS
Display Quantize values on page 61
Setting up the voices on page 70
About the polyphonic presets on page 71

The “Clefs etc.” Section

Clefs
You can insert a clef symbol anywhere in the score. This has an effect on the notes,
just as the first clef on the staff has. And just as with the first clef, the type is selected
from the Edit Clef dialog that appears when you select the Clef symbol and click in
the Score.
When you double-click on an existing clef, the Edit Clef dialog appears again,
allowing you to change the type. When you right-click on a clef, you can change the
type from the context menu.
Keys
Inserting a key change is similar to inserting a new clef (see above).
NOTE
In the dialog that appears when you insert a key change, you can also insert Display
Transpose changes.
Time signatures
You can insert a time signature symbol at the beginning of any bar. Inserting a new
time signature inserts a change on the signature track.
When you select the Time Signature symbol and click in the score, the Edit Time
Signature dialog opens, allowing you to specify the time signature. When you
double-click on an existing time signature symbol, the same dialog appears, allowing
you to change the type. When you right-click on a time signature, you can change the
type on the context menu.
●

You can select a font and size for time signatures in the “Font Settings”
subpage of the Score Settings dialog (Project page).
The default font for this is the included “Steinberg Notation” font.
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RELATED LINKS
Inserting and editing clefs, keys, or time signatures on page 55
Setting clef, key, and time signature on page 21
Editing the key on page 26
Editing the time signature on page 22

The Dynamics Section
There are dynamic symbols ranging from ffff to pppp, plus “special” dynamic symbols such as
sforzando, fortepiano, etc.
●

By selecting a dynamic symbol and clicking the “+” and “-” buttons on the extended toolbar,
you can quickly edit dynamics in the score.
Use this feature to step between pppp, pp, p, mp, mf, f, ff, fff, and ffff.

●

You can also right-click on a symbol and select “One up” or “One down” on the context
menu.
As above, these commands can be used to step between pppp, pp, p, mp, mf, f, ff, fff, and
ffff.

●

To change the size of a dynamic symbol, right-click on it and in the context menu, select an
option from the Size submenu.

●

In the Line/Trill section you can find a line symbol which allows you to create the following
type of change in dynamics:

Crescendo and diminuendo (decrescendo)
In the Dynamics section, there are three kinds of crescendo symbols: regular crescendo, regular
diminuendo and a “double” crescendo (diminuendo–crescendo).
●

To insert a crescendo (<) or diminuendo (>), select the corresponding symbol from the
section and drag from left to right.

●

If you draw a crescendo symbol from right to left, the result is a diminuendo symbol, and
vice versa.

●

To insert a crescendo-diminuendo (<>) symbol, select the double crescendo symbol in the
section and drag from left to right.

●

To insert a diminuendo-crescendo (><) symbol, select the double crescendo symbol in the
section and drag from right to left.

●

When you have inserted a crescendo or diminuendo symbol, you can move it and resize it
by dragging its handles.

●

The “dynamic crescendo/diminuendo” symbol (p < f) is special in that it actually affects the
velocity of the notes as they are played back.

●

If the “Keep Crescendo Symbols ‘Horizontal’” option is activated in the Preferences dialog
(Scores–Editing page), crescendo/diminuendo symbols are never slanted when you draw
them, but stay horizontal.
Also, this option prevents you from accidentally dragging an endpoint up or down when
moving the symbol.

●

It is also possible to “flip” crescendo symbols, by selecting the option in the context menu
or by clicking the Flip button on the extended toolbar.
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RELATED LINKS
Working with mapped dynamics on page 195

Aligning dynamics
There is a special command for aligning dynamic symbols (including crescendos) horizontally.
Unlike the regular align function, aligning dynamics takes the “baseline” of the dynamic letters
into account, aligning them as text rather than as graphic symbols.
PROCEDURE
1.

Select the dynamic symbols that you want to align, such as pp and a crescendo.

2.

Right-click on a selected symbol and select the “Align” function on the context menu.
This aligns all selected dynamics (except slurs and beziers) horizontally.
You can also align the dynamic objects by opening the Scores menu and selecting
“Dynamics” from the Align Elements submenu.

RELATED LINKS
Alignment on page 125

The Line/Trill Section
Octave Symbols

The octave symbols (8va and 15va) act as a “local display transpose” – they shift the display of the
score one/two octaves down.
●

By dragging the end of the dotted line, you can specify exactly which notes are affected by
the octave symbol.
Only notes beneath the dotted line are display transposed.

●

You can also right-click on the octave symbol and select the “Extend (+)” or “Reduce (-)”
command to extend it to the next chord or to reduce it.

RELATED LINKS
Transposing instruments on page 28

Tuplet group symbols

These are “graphical” tuplet group symbols, as opposed to the “real” tuplets.
●

After inserting a tuplet group symbol, you can double-click on its number and enter any
number from 2 to 32.

●

In the Score Settings dialog (Project page–Notation Style subpage) you can specify globally
how tuplets are displayed.
You can also select a font and size for the tuplet numbers in the Font Settings subpage.

●

You can also right-click on the tuplet group symbol and select the “Extend (+)” or “Reduce
(-)” command to extend it to the next chord or to reduce it.

Vertical symbols
The vertical symbols in the Line/Trill section are “note-dependent”. This means that they must be
inserted in front of a note.
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RELATED LINKS
Note layer symbols on page 103
Grace notes on page 98

The Other Section

RELATED LINKS
Working with text on page 139
Inserting chord symbols on page 135

Pedal down and up symbols

When you insert a Pedal down or up symbol, you also insert an actual MIDI event (damper pedal,
control change 64) at that position. Similarly, inserting or recording a damper pedal event in
another editor displays a pedal down/up symbol in the score.
●

If the “Hide Pedal Markers” option is activated in the Score Settings dialog, Project–
Notation Style subpage (Miscellaneous category), all pedal markers are hidden.
Use this if you have recorded a lot of damper pedal messages, but do not want these to
show in the score (for example if you are writing for an instrument other than piano).

A pedal down/up symbol combination can be displayed as “Two Symbols”, ““Ped.” + Bracket” or
as “Bracket only”. Just right-click on the pedal symbol and choose an option from the context
menu. You can also set this in the Score Settings dialog, on the Project–Notation Style subpage
(Miscellaneous category).

Repeats

Repeat signs (one and two bars) have a special feature: if you hold down Shift-Ctrl/Cmd when
entering them, notes in the bars they relate to are automatically hidden.
RELATED LINKS
Hiding/showing objects on page 166

Box (rectangle) symbol

This is a “generic” box symbol, which may be useful for different purposes. If you double-click
on a box, a dialog opens in which you can specify whether the box is transparent or not, and
whether the border is visible. This dialog can also be opened by selecting “Properties” from the
context menu.
The box symbol is available in the “Other” and “Layout” sections.
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The keyboard symbol
The Other section contains a piano keyboard symbol, useful in educational scores, for example.
RELATED LINKS
Adding a keyboard symbol on page 113

Additional symbols
If you click the “Other Symbol” button and then into the score, the “Select Symbol” dialog opens.
Here you can choose note heads, accidentals and rests that work only as drawing elements.
These do not insert note data into the track, neither do they affect MIDI playback. You can set the
desired symbol font size directly in the Font Size field.

The Form Symbols Section
Rehearsal marks

The following types of rehearsal marks are available: numbers and letters.
When you place the first of these in the score, it is labeled 1 or A (depending on which you
choose), the second is then automatically labeled 2 or B, the next 3 or C, etc. If you delete one,
the labeling of the others is shifted automatically so that they always make up a complete series
of numbers or letters.
●

You can select a font and size for rehearsal marks in the Project Text section of the Project–
Font Settings subpage in the Score Settings dialog.
Use the Frame option to add a box or an oval around the rehearsal mark.

●

Rehearsal marks can be added automatically at the start position of each Marker in the
project with the “Marker track to Form” function.

Da Capo and Dal Segno symbols

The “D.C.”, “D.S.”, and “Fine” symbols provide a quick way to insert some common play directions
into the score. The symbols are text symbols – you can adjust which font is used on the Project
page (Font Settings subpage) of the Score Settings dialog.
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●

To have these symbols actually affect playback, insert them on the Project layer and use
the Arranger mode.

RELATED LINKS
Settings for other fixed text elements on page 152
Scores and the Arranger mode on page 195

Endings

There are two types of endings, closed (“1”) and open (“2”). Both can be stretched to any length or
height by dragging the handles. You can also double-click or right-click the existing number and
enter any text you like.
You can insert endings in all layers. Which one to choose depends on the score; while it is handy
to insert endings once and for all as Project symbols, this does not allow you to make individual
adjustments for the different parts.
●

You can right-click an ending symbol and select the “Extend (+)” or “Reduce (-)” command
to extend the symbol to the next chord or to reduce it.

Tempo Indicator symbol

This symbol allows you to insert the current tempo according to the tempo track. In other words,
to make this symbol display a certain tempo, insert the value on the tempo track.
Normally this symbol shows the number of beats (quarter notes) per minute, but if you doubleclick or right-click it, you can select any note value. The number then changes accordingly.

Tempo change according to note values symbol

This symbol allows you to specify a tempo change as a change from one note value to another.
The example above would mean “lower the tempo by a third”.
To change the note value for either symbol, double-click or right-click it and select the desired
note value from the context menu.

User Symbols
The User Symbols section lets you create your own graphic symbols and use these in the score.

Creating a user symbol
Initially, the User Symbols section is empty. To create symbols you use the User Symbols editor:
PROCEDURE
1.

Double-click on the empty symbol field in the section.
The User Symbols editor opens. You can also right-click on an empty symbol field and
select “Edit…” to open the same dialog.

131

Working with symbols
Symbol details

2.

Open the Functions pop-up menu and select the desired zoom factor from the View
submenu.
Often you want to work at a reasonably high zoom factor when drawing and editing
symbols.

3.

Use the tools and functions to draw a symbol.
The available tools are listed in the table below.
When you are finished, you can close the editor and insert the symbol into the score, or
you can create more symbols:

4.

Select “New Symbol” from the Functions pop-up menu.
An empty symbol field appears in the section to the left of the drawing area – this section
corresponds to the actual User Symbols section, showing all symbols that you have
created.

5.

Click the new empty symbol field on the left to make sure that it is selected.
The drawing area is cleared.

6.

Continue creating new symbols this way.
●

You can edit existing symbols at any time by selecting them to the left and using the
tools and functions.
Any changes you make are automatically stored in the User Symbols section for the
project. You can also export symbols for use in other projects.

●

To insert a user symbol into the score, click on it in the section and then click at the
desired position in the score.

The User Symbols editor – tools and functions
The toolbar contains the following tools and settings, from left to right:
Object Selection
Use this to select objects – press Shift to select more than one. Click and drag to
move objects – press Ctrl/Cmd to drag vertically or horizontally only or press Alt to
copy.
To delete an object, select it and press Backspace or Delete.
Line
Draws a straight line.
Rectangle
Creates a rectangle. You can fill this with the Fill button if needed.
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Polygon
Creates a polygon – click where each corner of the polygon should be and close the
figure by clicking outside the drawing area.
Circle
Creates a circle. You can fill this with the Fill button if needed.
Ellipse
Creates an ellipse. You can fill this with the Fill button if needed.
Arc
Creates an arc.
Text
Allows you to insert text objects. Clicking with this tool in the drawing area opens a
dialog where you enter the text, specify font, style, etc.
You can double-click on a text object you have inserted to change its text or settings.
Symbol
Clicking with this tool brings up a dialog where you can select any of the existing
score symbols and incorporate this (at the desired font size) into your own symbol.
Set Color of Frame
When this is selected, the Color pop-up menu is used to select the color for the object
frame.
Set Color of Fill
When this is selected, the Color pop-up menu is used to select the fill color for
objects (if Fill is selected).
Fill
Click this if you want the object to be filled – you can then select a Fill Color for it from
the Color pop-up menu.
Don’t Fill
Click this if you do not want the object to be filled.
Color
Selects Frame or Fill Color for objects. The “Select Colors…” menu item brings up a
standard color dialog.
Line Width
Allows you to change the line width used for the selected object.
The Note Linked pop-up menu lets you create symbols linked to note positions. This affects the
whole symbol, not a selected graphic object:
Not Linked
The symbol is not linked to notes.
Linked/Left
The symbol is linked to a note, appearing to the left of the note.
Linked/Center
The symbol is linked and centered to a note.
Linked/Behind
The symbol is linked to a note, appearing to the right of the note.
The Functions pop-up menu contains the following items (some of these can also be accessed on
the context menu for the User Symbols section):
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New Symbol
Adds a new empty symbol to the section (and to the symbol list to the left in the
editor).
Delete Symbol
Deletes the current symbol from the section.
Export User Symbols
Allows you to save the current section with all available symbols as a separate file on
disk.
Import User Symbols
Loads settings for a complete section from disk. Note that this replaces the current
settings.
Export/Import Symbol
Lets you save or load individual symbols to/from disk. Importing a symbol replaces
the current symbol on the section.
Delete
Deletes the selected objects.
Select All
Selects all objects in the current symbol.
Transform – Scale Symbol
Lets you scale (resize) the selected object by specifying a percentage.
Transform – Mirror horizontal/vertical
Mirrors the selected object along the horizontal or vertical axis.
Transform – Flip ±90
Rotates the selected object by + or – 90 degrees.
Draw – Group
Groups the selected objects so that they are treated as one.
Draw – Ungroup
Ungroups the selected group.
Draw – Bring To Front/Send To Back
These items let you arrange the objects by moving them to the front or the back.
Align – Left/Right/Top/Bottom/Center Vertically/Center Horizontally
Aligns the selected objects to each other.
Display
Sets the zoom factor for the drawing area.
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About this chapter
In this chapter you will learn:
●

How to enter chord symbols manually and automatically using the “Make Chord Symbols”
feature.

●

Which settings can be made for chord symbols.

Inserting chord symbols
To insert chord symbols in the score, you can insert them manually by using the Chord Symbol
button in the Inspector. You can also let Cubase analyze an existing recording and create the
chord symbols.

Manually
To specify and enter a chord symbol, proceed as follows:
PROCEDURE
1.

Open the Other section and select the Chord Symbol button.

2.

Click in the score at the position where you want to insert the chord symbol.
The Edit Chord Symbol dialog opens.

3.

Enter the root note in the Root Note field.
You can either type in a chord letter or step through the chord letters using the up/down
arrows to the right.

4.

In the “Chord Type” field, specify a chord type.
You can either enter it directly (for example, by typing a “7”) or select an option from the
pop-up menu (click the arrow button to open it).

5.

Specify a tension in the Tension field.
Again, this can be done by typing or by using the pop-up menu. However, there are some
special display options which you can only get by typing (see the table below). You might
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also want to add some text here (such as “no third”). You can also select the basic tensions
from the pop-up menu, and then add special options by typing.
6.

If you want to have a special bass note, such as a C major with a D bass note, set the Bass
Note pop-up menu to this note (this cannot be the same as the root note).
The program “remembers” the relation between root and bass note, so that if you change
the root note, the bass note follows.

7.

If you want the root note to be displayed in lower case, activate the “Root Note in Lower
Case” checkbox.

8.

If needed, activate the “Enharmonic Shift” option.

9.

Click Apply.
The chord symbol appears in the score.
To open the Edit Chord Symbol dialog for an existing chord, double-click the symbol.
You can also right-click the symbol and select “Properties” on the context menu to open
the dialog.

Tension Field
Character

Description

Example

()

The tensions are
enclosed in brackets.

/

The tensions are
separated by a slash
sign.

|

The tensions are
placed above one
another.

Result

You can also combine several options. This
is a combination of two options, along with a
space to put the “9” above the “5”. Note that
only one “(“ sign is needed when the “|” option
is used.

Using Make Chord Symbols
If you have already recorded the chords for a project, Cubase can analyze them and create chord
symbols:
PROCEDURE
1.

Open the recording in the Score Editor.
If you want the chords to be inserted on another track, you can create an empty part on
that track and open it along with the recording.

2.

If you like, make display settings for the chords. These settings are available in the Score
Settings dialog, on the Project page (Chord Symbols subpage).
You can change all these settings after you inserted the chords as well.

3.

Select the notes for which you want chord symbols to be created.
If you want chord symbols to be created for all chords on the track, use the Select All
function on the Edit menu.
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4.

Use the Up Arrow/Down Arrow keys to make the desired staff active.
This should be the staff on which you want the chord symbols to end up.

5.

On the Scores menu, select “Make Chord Symbols”.
The chords appear. They can be moved, duplicated and deleted as any other symbol. You
can also double-click on a chord symbol to edit it in the Edit Chord Symbol dialog (in the
same way as when creating chords manually – see above).

A staff after using Make Chord Symbols.

Instead of using the “Make Chord Symbols” menu item, you can click the “Make Chord
Symbols” button on the extended toolbar.

RELATED LINKS
Adding guitar chord symbols on page 114

About the analysis
The MIDI chords are expected to be played in their most basic inversion. If not, an extra bass
note is added. For example, the notes CEG are interpreted as C major, but GCE is interpreted as C
major with a G bass note. If you do not want any interpretation of the inversion, that is, no added
bass notes, hold down Ctrl/Cmd while selecting Make Chord Symbols.
All selected notes on all staves are taken into consideration. Whenever there is any change on
any staff, the notes are reinterpreted and a new chord symbol is added. This means you should
probably avoid having the melody track in the Score Editor when you use Make Chord Symbols,
or you get a lot more chords than you expect, possibly with strange tensions.
In addition to the above, the Quantize value is used. At the most, there is a new chord at each
quantize position.
There must be at least three notes at a certain position for the program to interpret it as a chord.
Also some combinations of notes simply do not make any sense to the program and do not
produce any chords.
The analysis method is not perfect since the same set of notes can be interpreted differently
depending on context. Some editing may be required. If you record the track solely to create
chords automatically, play the chord as simple as possible, in the correct inversion, without
added octaves, etc.

The Current Chord Display
Cubase features a handy chord recognition function that helps you identify chords in the Score
Editor note display. To find out which chord is formed by simultaneously played notes, place
the project cursor over the notes. All notes “touched” by the project cursor are analyzed and the
Current Chord Display in the status line shows you which chord the notes form.
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Global chord settings
In the Score Settings dialog on the Project page (Chord Symbols subpage), there are several
global settings that affect how chords are displayed. These settings affect all chords in the
project.
NOTE
There are several options in the Preferences dialog (Event Display–Chords) that also affect how
chords are displayed.

Chord Symbols

Chord Symbols Font
●

Use the four size value fields to select sizes for the root, the type, the tension, and the bass
of a chord.
You can type in values or use the pop-up menus. Normally, you would want the “Root” size
to be the largest and the “Tension” size to be the smallest.

Options
●

If you want the root note to be aligned with the bass note, so that they are both displayed
at the same vertical position, activate “Align Bass Note”.

●

If you want the tensions to be displayed at the same vertical position as the root note
(rather than a bit above the root note), activate “Tension Bottom”.

●

If you want to scale a staff by using the Size setting on the Options tab of the Staff page
in the Score Settings dialog and want the chords to be scaled accordingly, activate “Scale
Chords”.

●

If you want the chord symbols to be affected by the Display Transpose setting on the Staff
page of the Score Settings dialog, activate “Use Display Transpose”.
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About this chapter
In this chapter you will learn:
●

Which different types of text are available.

●

How to enter and edit text.

●

How to set font, size, and style.

●

How to enter lyrics.

Adding and editing text symbols
This section describes the general procedure for adding and editing text symbols. There are
several different types of text symbols, but the basic procedures are the same (except for block
text symbols and page text symbols).
RELATED LINKS
Different types of text on page 143
Block Text on page 146
Page Text on page 147

Inserting a text symbol
PROCEDURE
1.

Make sure that the correct staff is active.

2.

Select a font, size, and style for the text (or select a text attribute).
You can also change these settings after you inserted the text.

3.

In the Symbols Inspector, open a symbol section.
The different text symbols are found in the Other section.

4.

Right-click the text symbol in the section to select the layer for which you want to add text.
Not all text symbols are available for all layers.

5.

Click the text symbol and click in the score at the position where you want the text to
appear.
If you are adding lyrics, you should click above or below a note (lyrics are centered around
each note and positioned vertically to where you clicked).
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6.

Enter the text in the text box that appears.
You can use Backspace to delete letters, and move the cursor with the Left Arrow/Right
Arrow keys.

7.

When you are done, press Return.
The text appears. You can move, duplicate or delete it as with any symbol.

RELATED LINKS
Selecting font, size, and style for the text on page 141
Lyrics on page 143

Importing Karaoke Lyrics as Text
If you activate the “Import Karaoke Lyrics as Text” option in the Preferences dialog (MIDI–MIDI
File page), karaoke lyrics from MIDI files are converted to text on import. You can edit it in the
same way as regular text.

About the melisma lines
When you add a text symbol, you can find a handle at the right edge of the text. By dragging this
handle to the right, you can extend a “melisma line” from the text. This has several uses:
●

If you are adding lyrics and want to indicate that a syllable should be sung over several
notes:

●

If the text is an advice about articulation or playing style, and you want it to apply to a
certain musical phrase only:

●

If the text is an advice about articulation or playing style, and you want it to apply from
that point on in the score:

In the Score Settings dialog (Text tab), you can find two settings that determine the appearance
of the melisma lines for text symbols:
●

The Melisma Style pop-up menu is where you specify whether the line is solid or dotted.

●

The Melisma End pop-up menu allows you to choose whether the end of the line is plain,
has an arrow, or forms a “bracket” up or down.
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Making space
Dragging staves is a way to edit distances within staves or between grand staves. Auto Layout
makes the program “go through“ the score and makes adjustments to measure widths, staff
distances, etc.
RELATED LINKS
Dragging staves on page 173
Auto Layout on page 177

Editing the text
If you made a mistake when typing or for some other reason want to change text, double-click
on a text block with the Object Selection tool, edit the text and press Return to close it.
●

It is also possible to replace all occurrences of a certain word in the score, without having
to edit the texts manually.

RELATED LINKS
Find and replace on page 150

Selecting font, size, and style for the text
PROCEDURE
1.

Select the text that you want to make settings for.
If nothing is selected, the settings you make are the “default settings”. The next time you
insert text, these settings are used.

2.

Open the Score Settings dialog and select the Text page.

3.

Select a font from the Font pop-up menu.
How many and which fonts appear depends on what typefaces you have installed on your
computer.
IMPORTANT
For regular text you should avoid the “Steinberg” fonts. These are the fonts Cubase uses
for all scoring symbols, etc.

4.

Select a text size from the Size pop-up menu (or enter one manually in the text field).

5.

You can also add one or several font options using the checkboxes and pop-up menus.

6.

Click Apply to apply the settings to the selected text.
Note that you can select other text blocks while the dialog remains open – the dialog is
updated to reflect the settings of the selected text.

7.

When you are done, close the Score Settings dialog.

Special style options
Most of the options are common text style variations such as bold, italic, underline, etc. But there
are also a few special style options:
Frame
Allows you to put the text in a rectangular (“Box”) or oval frame.
Melisma options
These determine the appearance of the “melisma line”.
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Positioning
Allows you to select which side of the text block (left or right) is used for calculating
its position. This has an effect in situations where that text block is moved
automatically (as a result of an Auto Layout function, when you move barlines
manually, etc.). If, for example, the text block appears just in front of a note (to the
left of it), it appears in a more sensible position after the adjustment if the “Right”
option is selected.
Alignment: Left/Center/Right
Allows you to specify the alignment of the text. These options are only valid for texts
with more than one line.
RELATED LINKS
About the melisma lines on page 140

Text attribute sets
A text attribute set can be seen as a “preset” containing all font, size, and style settings. By
creating text attribute sets for the settings you use most often, you can save a lot of time.

Creating a text attribute set
PROCEDURE
1.

Open the Score Settings dialog on the Project page and select the Font Settings subpage.

2.

Open the Attribute Sets tab.

3.

On the Font Set pop-up menu, select the “Empty” set.

4.

Select a font, specify a size, and add style options using the checkboxes.
The options are the same as when you make font settings on the Text page in the Score
Settings dialog (see above).

5.

Click in the text field of the Font Set pop-up menu and enter a name for the new text
attribute set.

6.

Click Store to save the new text attribute set.

Using text attribute sets
To apply the settings in the text attribute set to one or several text blocks, select them, select the
set from the Font Set pop-up menu on the Text page in the Score Settings dialog and click Apply.
You can also apply a text attribute set to a text block directly in the score by right-clicking it and
selecting the set from the context menu.
●

If you select a text attribute set on the Text page when no text is selected in the score, the
settings are used the next time you insert some text.

NOTE
After you have selected a set for a text block, there is a “link” between the text and the attribute
set. Any changes to the attribute set affects all texts that use it. You can still edit any font settings
manually (on the Project–Font Settings subpage) but then the “link” to the attribute set is
removed.

Editing text attribute sets
If you edit the settings in a text attribute set, all texts using this particular set are affected. This
is very practical, since it allows you to use the same number of “generic” sets for all your projects
(for titles, comments, lyrics, etc.), and simply change the fonts, sizes, etc. for a different project if
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necessary. This also makes it easier to move projects between computers (which may not have
the same fonts installed).
PROCEDURE
1.

In the Score Settings dialog on the Project–Font Settings subpage, select the Attribute Sets
tab.

2.

From the Font Set pop-up menu, select the attribute set that you want to edit.

3.

Change the settings as desired.
This includes the name of the set.

4.

Click Apply.

Different types of text
You can add various types of text to the different layers of the score. The selected layer specifies
which type of text is available.

Regular text
This type of text is inserted by selecting Text in the Other section. You can insert this type of text
on all layers.

The text is tied to the bar and staff position. If you move the bar or the entire staff, it moves with
it.

Pasting text
You can paste text from another program into a text symbol in the score. To do this, select the
text symbol and right-click it. Then, select “Text From Clipboard” from the context menu. This
option is also available on the Functions submenu of the Scores menu.
Similarly, you can copy selected text by using the “Text To Clipboard” option from the context
menu.

Lyrics
This type of text is inserted by selecting Lyrics in the Other symbol section. You can insert this
type of text only on note layers.

When you insert lyrics, you should click below or above the note the syllable belongs to. The
text then appears horizontally centered around the note and vertically positioned to where you
clicked. You can later move it up or down, as with any symbol.
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Lyrics are tied to the note position. If you move the note, the text moves with it. The spacing
between notes is also adjusted to make the lyrics fit.

Inserting lyrics for a number of notes
PROCEDURE
1.

With lyrics selected, click below or above the first note with the Draw tool.

2.

A text input field opens. Enter the text (the word or syllable) for that note.

3.

Press the Tab key.
The program moves on to the next note.

4.

Input text for this note and press Tab again.

5.

Proceed until the last note and then press Return or click outside the text box.
When you insert lyrics this way, the positions of the notes are automatically adjusted
so that no lyric “block” overlaps another. If this is not what you want, you can activate
the “Don’t Sync Lyrics” option in the Score Settings dialog on the Project–Notation Style
subpage (Lyrics category). If this option is activated, the note positions are not affected,
which may be preferable.
When entering words with several syllables you normally separate the syllables with a
dash (-). By default, the dash signs are automatically centered between the syllables – if
this is not what you want, activate the “Don’t Center Hyphens” option in the Score Settings
dialog, on the Project–Notation Style subpage (Lyrics category).

Lyrics and measure widths
When you first enter lyrics, the result may look crammed, since the words take up more space
than the notes (the lyrics are also selected just after entering the last word, which makes them
look a bit odd when overlapping). To remedy this, use the auto layout function to automatically
adjust the measure widths.
RELATED LINKS
Auto Layout on page 177

Adding a second verse
To insert a second line of lyrics, proceed as follows:
PROCEDURE
1.

Enter the new lyrics above or below the existing verse.

2.

Select all the words that should be in the new verse.

3.

Right-click the selected words to open the context menu.

4.

Select the appropriate verse from the Move To Verse submenu (Verse 1–6).
This assigns the selected lyrics to the selected verse.
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To indicate that the words belong to another verse, they are automatically displayed in
another color. However, all verses are printed in black as usual.
●

To select all words in one verse only, press Shift and double-click on the first word in
that verse.
This selects all following words in the verse.

Inserting lyrics into voices
Each voice can have its own lyrics. If you have a vocal arrangement with several voices, you can
add lyrics to them, one by one.
PROCEDURE
1.

Make sure that the correct voice is selected (on the extended toolbar).

2.

In the Symbols Inspector, open the Other section and click on the Lyrics symbol.

3.

Click on the first note in the selected voice.

4.

Enter the lyrics for this voice, using the Tab key to move from note to note.

5.

Start over, by activating the next voice, clicking on the first note in that voice and
proceeding as with the first voice.

6.

If needed, adjust the position of the lyrics for each voice.

RELATED LINKS
Entering notes into voices on page 72

Moving lyrics
If you want to move the lyrics up or down, for example to make room for a second verse,
proceed as follows:
PROCEDURE
1.

Hold down Shift and double-click on the first word in the lyrics.
All lyric “blocks” are selected.

2.

Drag one of the lyric blocks up or down.
All selected lyric blocks are moved accordingly.

Adding lyrics from the clipboard
If you want to prepare your lyrics in another program, you can import them into Cubase the
following way:
PROCEDURE
1.

Create the lyrics in another program.
Separate words with space as usual, syllables within words with dash signs (-).

2.

Copy the text.

3.

In Cubase, select the first note to which the lyrics will be added.

4.

Open the Scores menu and select “Lyrics from Clipboard” from the Functions submenu.
The lyrics are added, starting at the selected note.
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Block Text
Block Text allows you to import text from a file on disk or from the clipboard. Proceed as follows:
PROCEDURE
1.

Click the Block Text symbol in the Other section to activate the Draw tool.
You can insert block text on the project layer (for text that should appear on all pages,
for example, the score title), on the layout layer (to print a title only for a particular track
layout, for example, for a particular instrument), or on the note layer (this text only
appears in the score for a particular part).

2.

Click in the score where you want to insert the text.
A regular file dialog appears.

3.

Select a file (TXT or RTF) to import.

4.

Click Open.
The text in the file is inserted into the score.

Options for inserted Block Text
Right-clicking on inserted Block Text brings up a pop-up menu with the following options:
Settings
Brings up the RTF Settings dialog. You can also open this by double-clicking the Block
Text.
Import Text
Imports text from a text file or RTF file. The imported text replaces any text inserted
at the position of the Block Text.
Update Text
Reloads the text from the file.
Text From Clipboard
Pastes the text from the clipboard into the Block Text.
Text To Clipboard
Copies the Block Text to the clipboard.
Hide/Show
Hides the inserted block text. To make the text visible again, activate the Hide
checkbox in the filter bar and select “Hide/Show” on the context menu.
Properties
Brings up the RTF Settings dialog.

The RTF Settings dialog
Selecting “Settings” from the context menu (or double-clicking the Block Text) brings up a dialog
with settings for the Block Text. These are:
Font
Lets you select the font to use for the Block Text. If “No Change” is selected, the font
in the original file (if applicable) is used.
Size
The text size, as a percentage.
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Draw Frame
If this option is activated, a frame is shown around the Block Text.
Word wrap
If this option is activated, line breaks are used to fit the text in the Block Text symbol.
Replace mode
In this mode, the Block Text box is opaque, covering what’s under it.
Trans mode
In this mode, the Block Text box is transparent.

Lay Text
The Lay Text symbol allows you to insert layout text for multiple staves. This is available only on
the layout layer.
To hide or show the inserted text for different staves in the layout, deactivate or activate the “L”
column for the corresponding tracks on the Layout page of the Score Settings dialog. The text
appears in all staves for which you have activated the “L” column. This means that the text is tied
to the bar and staff position. If you move the bar or the entire staff, the text moves with it.
To enter layout text, proceed as follows:
PROCEDURE
1.

In the Project window, select the tracks for which you want to enter text.

2.

Open the Score Editor.

3.

On the Other section of the Symbols Inspector, activate the Lay Text symbol and click at
the position in the score where you want to insert the text.

4.

Enter the text that you want to display for the Layout.
As with regular text, you can copy and paste text from external sources to this symbol.

RELATED LINKS
Regular text on page 143

Page Text
The page text symbols are found in the Other section. If you insert page text on the project layer,
it is part of the project layout and appears in all layouts.
The position of page text is not tied to a note, bar or staff position. In other words, it does not
matter if you move other objects on the page, the page text stays where you inserted it. Typically,
it is used for score titles, page numbers, copyright information and other text elements that you
want displayed with all parts (on all pages if you like).

Entering page text
PROCEDURE
1.

Open the Other section of the Symbols Inspector.

2.

Click the Page Text symbol and click in the score.
It does not matter where you click – the positioning is specified in the Page Text dialog.

3.

Enter the text that you want displayed in the field at the top of the dialog.
You can use special characters to add “variables” such as page numbers.

4.

Adjust the positioning settings for the text.
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5.

Select a text attribute set for the text, or make manual settings for font, size, and style.

6.

Click OK.
The text is inserted. You can adjust the positioning manually by dragging the text block.

Text adjustment options
Show on all Pages
If this option is activated, the text is shown on all pages. The “Except First” checkbox
allows you to exclude the very first page.
Show on First Page
If this option is selected, the text is only shown on the first page.
Line
This determines how the text is aligned. For example, if you place several texts on
“Top/Left”, you can sort them by entering the desired number of lines.
Toggle Position
When the Left or Right position option is selected to the right, activating this
checkbox makes the text alternate between left and right alignment on even/odd
pages.
Position buttons
Determines where on the page you want the text, vertically (Top/Bottom) and
horizontally (Left, Center, Right).

Inserting variables
When you enter the text, you can also insert special characters or “place holders” for different
attributes. When the text is displayed, these characters are replaced by their actual values. The
following variables are available:
%p
The current page number.
%l (lower case L)
The long staff name.
%s
The short staff name.
%r
The name of the project.
For example, if you enter the text “%l, %r, Page %p”, these variables might be shown as “1st
Violin, Quartet No.2, Page 12” in the score.

Using the Score Settings (Text page)
In the Score Settings dialog on the Text page, you can find a number of text-related settings. The
symbol buttons correspond to the symbols found in the Other section of the Symbols Inspector.
●

On the Layer pop-up menu, select the layer that you want to use.
The text symbols available for this layer are displayed to the left of the pop-up menu.

●

You can use the text symbols in the same way as you would use symbols from the
Inspector or a symbol palette.
When you select a text symbol and move the mouse pointer over the score, the pointer
changes to a pencil, and you can enter text at the position you click on.
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RELATED LINKS
Symbol details on page 126

The Notepad tab and the Selection tab
Below the text symbols and the Layer pop-up menu, you can find two tabs with large text entry
fields.
●

Use the Notepad tab to enter longer text passages. When you are happy with the text in
terms of wording and length, select all or part of the text, and select a note in the score.
Now, the Insert Lyrics button below the Notepad tab becomes available.
When you click Insert Lyrics, the selected text is entered into the score, starting from the
note you selected.

●

When you select text in the score and open the Selection tab, the selected words are
shown in the text field. You can now change the wording of the text, and use the text
format options to the left to change the appearance of the selected text. When you are
done, click Apply to apply your changes to the selected text in the score.

Text functions
In addition to the text symbols that you can add to the different layers, you have other text
functions at your disposal that support you while working on the score. These are described in
the following sections.

The Words Section
If you have certain words that you use a lot, you can save these as dedicated symbols in the
Words section. This saves time, since you do not have to type the same word over and over
again.

Storing a word
PROCEDURE
1.

Open the Words symbol section.
This section is hidden by default.

2.

Type in the desired words in the text field at the top of the dialog.

3.

Specify the text type (regular text or lyrics) with the Type pop-up menu.

4.

Make settings for font, size, and style.
You can also use a text attribute set if you like.

5.

Click Exit.
The words that you entered appear in the selected symbol field in the Words section.

Right-clicking one of the fields opens a context menu with a number of options:
●

Select “Edit” to open the Custom Text Editor dialog.

●

Select “New” to add a new empty symbol to the Words section.

●

Select “Remove” to delete any unwanted symbols from the Words section.

●

Select “Open As Palette” to open the Words symbol palette.
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RELATED LINKS
Showing/Hiding Symbols Inspector Sections on page 105

Inserting a word
You insert words from the Words section as you would insert any regular symbol, by selecting
the appropriate word and clicking in the score. However, you can edit the word after inserting it,
just as with text inserted by typing.

Find and replace
This function allows you to replace all occurrences of a certain word or group of words, with
another word or group of words. The replacement is done once and for all, for all text symbol
types, regardless of font, size, and style settings.
PROCEDURE
1.

Open the Scores menu and select “Find and Replace” from the Functions submenu.
The Find and Replace dialog opens.

2.

In the Find value field, enter the words to replace.

3.

If you want all instances of the words to be replaced, regardless of upper/lower case,
deactivate the “Case Sensitive” option.

4.

If you do not want to replace the words if they are a part of another word, activate the
“Entire Word” option.
For example, if you want to replace the word “string” but not the word “stringendo”, you
should activate “Entire Word”.

5.

In the “Replace” field, enter the words that are to be used as replacement.

6.

Click OK.
Now all occurrences of the “Find” words are replaced with the “Replace” words.

Staff names
You can make settings for staff names in several places:
●

In the Score Settings dialog on the Layout page, you specify whether the staff names are
shown at all and whether to use the names of the actual edited tracks in the score.
In a multi-track layout, you can choose for which tracks the staff names are shown by
clicking in the “N” column for each track.

●

You specify a long and short staff name in the Score Settings dialog, on the Staff page
(Main tab).
These are used if you do not use the “From Tracks” option on the Layout page of the Score
Settings dialog. The long name is displayed for the first system only, and the short name
for the following systems. If you want a name at the top of the page only, leave the “Short”
name field empty.
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IMPORTANT
If the “Show Long Staff Names on new Pages” option is activated in the Score Settings dialog on
the Project–Notation Style subpage (Staff Names category), the long name is displayed for the
first system on every page.

Selecting a font for staff names
PROCEDURE
1.

Open the Score Settings dialog on the Project page and select the Font Settings subpage.

2.

Select the Project Text tab.

3.

Use the “Font For” pop-up menu to select “Staff Names”.

4.

Select font, size, and styles for the staff names (or use a text attribute set).

5.

Click Apply and close the Score Settings dialog.

Additional staff name settings
●

If you activate the “Show Staff Names to Left of Staff” option in the Score Settings dialog on
the Project–Notation Style subpage (Staff Names category), the staff names are shown to
the left of the staves, instead of above them.

●

You can define separate subnames for the upper and the lower staff in a polyphonic or
split system.

●

You can fine-tune the vertical and horizontal position of staff names with some of the
options on the Project–Spacings subpage of the Score Settings dialog.

RELATED LINKS
Staff names on page 150

Bar Numbers
Bar Number settings can be made in several places as well.

General settings
PROCEDURE
1.

Open the Score Settings dialog on the Project page and select the Notation Style subpage.

2.

Scroll down the list to the “Bar Numbers” category.

3.

Use the “Show every” setting to specify how often bar numbers are shown.
The options are “First Bar” (bar numbers shown for the first bar on each staff), “Off” (no bar
numbers shown), and any number. Click in the State column and use the mouse wheel to
select the desired option.

4.

If you like, activate the “Show Range with Multi-Rests” option.
If this option is activated, and you have a multi-rest, the bar number at the beginning of
the multi-rest shows a range, indicating the length of the multi-rest.

5.

If you want the bar numbers to be displayed below the barlines, activate the “Below
Barlines” option.

6.

Click Apply and close the Score Settings dialog.
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Font settings
As with many of the other fixed text elements, you can select a font, size, and style for bar
numbers in the Score Settings dialog, on the Project–Font Settings subpage.

Spacing
On the Project–Spacings subpage of the Score Settings dialog, you can find four settings that
relate to bar numbers:
First Bar Number – Horizontal Offset
Sets the horizontal distance between the bar number and the barline for the first bar
on each staff.
First Bar Number – Vertical Offset
Sets the vertical distance between the bar number and the barline for the first bar on
each staff.
Other Bar Numbers – Horizontal Offset
Sets the horizontal distance between the bar number and the barline for all other
bars.
Other Bar Numbers – Vertical Offset
Sets the vertical distance between the bar number and the barline for all other bars.

Offsetting bar numbers
If you double-click on a bar number, a dialog appears, allowing you to skip a number of bars in
the otherwise continuous bar numbering.

This is used for example when a section repeats. Say, you have a repeat of bar 7 and 8, and want
the first bar after the repeat to have the number 11, not 9. To achieve this, you double-click on
the “9” and insert an offset of “2”.
It is also useful if the score starts with an upbeat, and you want the first “real” bar to be
numbered 1. In that case you would specify an offset of “-1” for the second bar, and make sure
that the bar number for the upbeat bar is hidden.
●

Bar number offsets belong to the Project layer and are shown for all tracks and layouts.

Settings for other fixed text elements
You can make settings for virtually all text and numbers that appear in the score.
PROCEDURE
1.

Open the Score Settings dialog on the Project page and select the Font Settings subpage.

2.

Select the Project Text tab.

3.

Use the “Font For” pop-up menu to select a text type to make settings for.

4.

Use the options in the dialog to change the settings.

5.

Click Apply to apply the settings to all elements of the selected type.
To close the dialog, click the close button at the top right of the dialog window.
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Bar Numbers before and after changing their font settings.

You can also define text attribute sets on the Font Settings subpage, as a means to quickly
change text.
Note that you can select a defined attribute set from the context menu opened when rightclicking on a text element.

RELATED LINKS
Text attribute sets on page 142
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About this chapter
In this chapter you will learn:
●

What layouts are and what they contain.

●

How to create layouts.

●

How to use layouts for opening combinations of tracks.

●

How to apply, load, save and delete layouts.

●

How to import and export layouts.

●

An example of how layouts can be used.

Background: Layouts
Layouts can be viewed as “presets” containing settings for the layout layer: staff spacing,
barlines, layout symbols, etc.

When to use layouts
●

You need to format the score differently when you print the entire score and when you
extract parts for single instruments (or groups of instruments). Layouts allow you to keep
different sets of “looks” for the same track or set of tracks. You might for example have
one layout for each single instrument and one for the entire score.

●

By selecting another layout on the Layout page of the Score Settings dialog, you can switch
to another combination of tracks without having to leave the Score Editor.

What makes up a layout?
A layout contains the following items and properties:
●

The inserted Layout symbols.

●

All settings on the Layout page of the Score Settings dialog.

●

The vertical spacing of the staves.

●

Barline spacing.

●

Broken barlines.

NOTE
Note that Project symbols, barline types and bar number offsets are part of the Project layer, and
appear in all layouts.
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RELATED LINKS
The available symbols on page 106

How layouts are stored
Layouts are created automatically when you edit a single track or a combination of tracks. They
are an integral part of the specific track combination, which means you do not have to save them
separately.

Creating a layout
Layouts are created automatically when you open a new combination of tracks for editing.
Each track may have been edited before, individually or together with other tracks, it does not
matter. What matters is that you open precisely these tracks. For example, to create a layout for
a string quartet, select parts on the corresponding tracks and press Ctrl/Cmd-R.
IMPORTANT
The order of the tracks does not matter – you can reorder them in the Project window without
removing the layout. However, the spacing of the staves in the layout is related to the order of
the tracks.

Opening a layout
The “Open Layout” command on the Scores menu opens a dialog listing all available layouts for
the Project.
●

Select the desired layout in the list and click OK to open the tracks contained in the layout
in the Score Editor.
This is a quick way for opening several tracks in the Score Editor directly from the Project
window.

Layout operations
The Score Settings dialog contains a Layout page, where you can make settings for the different
layouts. To the left of the dialog, all existing layouts in the project are listed (this is the same list
as in the Open Layout dialog, see above). The layout used is highlighted in the list.
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Opening the tracks in a layout
To select another combination of tracks for editing, select the corresponding layout in the list.
●

You can keep the dialog open while you are editing, and use this function for selecting
which tracks to edit.

Importing layout symbols
By selecting another layout and selecting “Get Form” from the Functions pop-up menu below the
list, you import all Layout symbols (inserted from the Layout section in the Symbols Inspector)
from the selected layout into the current layout.

Managing layouts
●

To rename a layout, select it in the list and enter the desired name in the Name field to the
right in the dialog.
Initially, a layout gets the name of one of the edited tracks – it may be a good idea to give
each layout a more informative name.

●

To remove a layout you no longer need, select it in the list and select “Remove” on the
Functions pop-up menu.

●

To remove all layouts for which there no longer are track combinations, select “Clean Up”
on the Functions pop-up menu.

Importing and exporting layouts
By selecting a layout and selecting “Export” or “Import” from the Functions pop-up menu below
the list, you can export or import a Layout. Note that all Staff settings are taken into account,
when exporting or importing a layout.

Working with Display Transpose
You can specify for each staff in a layout whether it should use Display Transpose. In the Score
Settings dialog on the Layout page, click in the D column to activate or deactivate the option.
Note that this setting affects this layout only.

Using layouts – an example
The following text outlines the basic steps for extracting a musical part from a full score.
PROCEDURE
1.

Prepare the entire score, including all formatting.
This might include inserting project layer block text for the score title, setting the barline
type, etc.

2.

Open the Score Settings dialog on the Layout page and enter the desired name in the
Name field (for example “Full Score”).

3.

Close the Score Editor.

4.

Open a single track, for example a woodwind part.
The Project layer settings automatically appear in the new single track layout.

5.

Prepare a layout for the woodwind part.
You might for example move barlines, add endings, activate multiple rests, etc.
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You can also import all layout symbols from the “Full Score” layout, by opening the Score
Settings dialog on the Layout page, selecting the “Full Score” layout in the list to the left,
and selecting “Get Form” from the Functions pop-up menu.
IMPORTANT
Be careful not to change any of the properties which are not part of the layout. This
modifies the “Full Score”, too.
6.

Enter the desired name for the new layout in the Name field on the Layout page of the
Score Settings dialog and click “Apply”.

RELATED LINKS
Importing layout symbols on page 156

Marker Track to Form
If you have created markers in the Project window which denote the start of each new “section”
in your music (verse, bridge, chorus, etc.), you can automatically transfer these markers into the
current layout.
PROCEDURE
1.

Open the Scores menu, open the Advanced Layout submenu and select “Marker Track to
Form”.
Now, rehearsal marks and double barlines are inserted in the score, at the position of each
marker.

2.

If you want the names of the markers shown as well, open the Advanced Layout submenu
again and select “Display Markers”.
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Introduction
MusicXML is a music notation format developed by Recordare LLC in 2000 based primarily on
two academic music formats. It allows the representation of scores in the current symbolic
representation of western music notation, used since the 17th century. With Cubase you can
now import and export MusicXML files created with version 1.1. This makes it possible to share
and exchange sheet music with people who are using score writing programs such as Finale and
Sibelius.
NOTE
As MusicXML is supported to various degrees by different programs, you always have to do
manual adjustments.

What is MusicXML used for?
The MusicXML file format can be used for the following purposes:
●

Representation and printing of sheet music

●

Exchange of sheet music between various score writing programs

●

Electronic distribution of musical scores

●

Storage and archiving of scores in an electronic format

Notational representation vs. musical performance
MusicXML is a music notation file format, that is, it deals especially with the layout of music
notation and the correct graphical representation, that is, how a piece of music should look.
However, MusicXML music data also contains elements that define how a piece of music should
sound. For example, these are used when creating a MIDI file from MusicXML. This means that
MusicXML has things in common with MIDI.
MIDI is a music interchange format for performance applications like Cubase or other
sequencers. The MIDI file format is designed for playback. The main focus of the MIDI file format
lies in the performance, not in the notation.

Is MusicXML better than MIDI?
The following sections inform you about the advantages of MusicXML and MIDI regarding note
representation and sound.
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Advantages of MusicXML
MIDI tracks hold MIDI notes and other MIDI data. A MIDI note in Cubase is only defined by its
position, length, pitch and velocity. This is not enough to decide how the note will be displayed in
a score. For a correct representation, Cubase also needs the following information:
●

Stem direction, beaming.

●

Expression marks (staccato, accent, ties and slurs).

●

Information about the instrument in the score.

●

Key and basic rhythm of the piece.

●

Grouping of notes, etc.

MusicXML can save a great part of this information. However, you have to adjust the scores with
the tools available in the Score Editor.

Advantages of MIDI
Although MusicXML has obvious advantages in the representation of musical scores, there are
also restrictions in sound. This is due to the fact that MusicXML as a music notation format has a
graphical background and is designed for exchanging representation, not sound.
When playing back MusicXML files in Cubase, the following parameters, among others, are not
considered:
●

On and Off velocities

●

Dynamics

●

Controller data

●

SysEx

●

Standard MIDI file meta events

●

Audio

●

All Cubase-specific data like automation, MIDI effects, Input Transformer, etc.

Importing and exporting MusicXML files
Cubase can import and export MusicXML files, which makes it possible to transfer musical scores
to and from applications that support this file format. However, there are some restrictions
concerning the parameters supported by Cubase.
Importing and exporting Notes
Parameter

Export

Import

Pitch

Yes

Yes

Length

Yes

Yes

Staves

Yes

Up to two per staff

Voices

Yes

Up to four per staff

Accidentals

Yes

Yes

Ties

Yes

No
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Parameter

Export

Import

Dots

Yes

No

Stem

Yes

Yes

Beams

Yes

No

Grace notes

Yes

Yes

Rests

Yes

Yes

Importing and exporting Layouts
Parameter

Export

Import

Page size

Yes

No

Page margins

Yes

Yes

Page scaling

Yes

Yes

Page breaks

Yes

No

System breaks

Yes

Yes

Distance between staves and
systems

Yes

Yes

Left/right inset

Yes

No

Distance between measures

Yes

No

Hidden staves

Yes

Yes

x and y positions of symbols

Yes

Yes

Importing and exporting Symbols
Parameter

Export

Import

Keys

Yes

Yes

Clefs

Yes

Yes

Time signature

Yes

Yes

Dynamics

Yes

Yes

Ornaments

Yes/incomplete

Yes/incomplete
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Parameter

Export

Import

Articulations

Yes/incomplete

Yes/incomplete

Technicals

Yes/incomplete

Yes/incomplete

Lyrics

Yes

Yes

Chord symbols

Yes

Yes

Damper pedal

Yes

Yes

Dynamics

Yes

Yes

Rehearsals

Yes

Yes

Text

Yes

Yes

Layout text

Yes

N.A.

Project text

Yes

“Credits”

Dashes

Yes

Yes

Endings

Yes

Yes

Octave shift

Yes

Yes

Barline types

Yes

Yes

Slurs

Yes

Yes

Hammer-on/pull-off

No

No

Importing and exporting Formats
Parameter

Export

Import

Display transpose

Yes

Yes

Drum notation

Yes

Yes

Short/long staff names

Yes

Yes

Program changes

Yes

N.A.

Music font

Yes (if Jazz font)

Yes

Tablature (including String
tunings)

Yes

Yes
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Importing MusicXML files
PROCEDURE
1.

Open the File menu and open the Import submenu.

2.

On the submenu, select “MusicXML…”.

3.

In the file dialog that opens, locate and select the MusicXML file and click “Open”.

4.

Another file dialog opens in which you can select the project folder for the new project.
Select an existing project folder or create a new one by clicking “Create” and entering a
name in the dialog.

5.

A new project is created with the name of the MusicXML file.

Exporting MusicXML files
PROCEDURE
1.

Set up the score the way you want it in the Score Editor of Cubase.

2.

Open the File menu and open the Export submenu.

3.

On the submenu, select “MusicXML…”.
Note that this option is only available when the Score Editor is open.

4.

A file dialog opens in which you can choose an existing empty folder or create a new folder
for saving the MusicXML file (with the extension “.xml”).
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About this chapter
In this chapter you will learn:
●

How to change the staff size.

●

How to create multi-rests.

●

How to add and edit barlines.

●

How to create upbeats.

●

How to set measure spacing and the number of bars across the page.

●

How to control staff and grand staff spacing.

●

How to use the Auto Layout dialog.

●

How to use the Reset Layout function.

●

How to break barlines.

IMPORTANT
Before you start designing the score page layout, you should open the Page Setup dialog on the
File menu, and make settings for paper size, print scale and margins!

Layout settings
The Layout page of the Score Settings dialog contains a number of settings that affect the display
of the current layout.
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The track list
The track list lists the tracks included in the layout and allows you to make the following settings:
Brackets
These two columns allow you to add braces or brackets, encompassing any number
of staves in the layout.
T
This is relevant if the “Modern Time Sign.” option is activated to the right. In that
case, you use this column to specify for which tracks the time signature is shown.
N
This option lets you specify for each staff in a layout whether the staff name is
shown.
L
If this is activated, any layout symbols are shown; otherwise they are hidden. For
example, this allows you to have rehearsal marks shown for the top staff only in a
multi-staff layout.
D
This option lets you specify for each staff in a layout whether it should use Display
Transpose.
C
This option lets you specify which staff should show the chord track symbols. The
chord track symbols can only be shown on one staff.
RELATED LINKS
Adding brackets and braces on page 176
Displaying the Chord Symbols from the Chord Track on page 176

Equal Spacing
Activate this option if you want a note to take up space according to its note value. If Equal
Spacing is activated, two sixteenth notes take up as much space as one eighth note, for example.

Size
Changes the size of all staves.
RELATED LINKS
Staff size on page 165

Multi-Rests
Whenever more than one-bar rests occur, the program can replace these with a multi-rest
symbol. This parameter allows you to set how many empty bars are “allowed” before Cubase
collects them into a multi-rest. “Off” means “never”.
RELATED LINKS
Multiple rests on page 168
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Real Book
If this option is activated, clef symbols are not set out at the beginning of each staff, only on the
first staff on each page.

Staff Separators
If this option is activated, separator symbols are inserted at the beginning of each grand staff.

Modern Time Signature
If this option is activated, time signatures are shown above the staves rather than in them. You
can set the size of the modern time signature in the Time Sign section on the Project–Notation
Style subpage of the Score Settings dialog. When modern time signature is selected, you use
the “T” column in the track list in the Layout page to specify for which tracks time signatures are
displayed.

●

If you prefer to display the score in a more modern way, check out the other options on
the Notation Style subpage.
For descriptions of the options use the Help button in the dialog.

Staff size
You can set the staff size as a percentage value of the normal size.

For one staff
To set the staff size for one staff, proceed as follows:
PROCEDURE
1.

Make sure that the staff you want to edit is active.

2.

Open the Score Settings dialog on the Staff page and select the Options tab.

3.

Adjust the Size parameter in the System Sizes section.
The values range from 25 % up to 250 % of the normal size.

4.

Click Apply.

For all tracks in a layout
To set the staff size for all tracks in a layout, proceed as follows:
PROCEDURE
1.

Open the Score Settings and select the Layout page.

2.

Change the Size parameter.
The values range from 25 % up to 250 % of the normal size.
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3.

Click Apply.

RESULT
All staves now get the desired size. Staves that have individual size settings (see above) still are
proportionally smaller/larger.
This setting is part of the layout and can be used when printing a full score slightly smaller than
the parts for each instrument, for example.

Hiding/showing objects
Any object on a page can be hidden, including notes, rests, symbols, clefs, barlines, even entire
staves.
This can be useful in the following situations:

Printing scales
If you want to create scale examples, enter the notes and hide time signatures, barlines and
other unwanted objects.

Graphic notation
By hiding barlines, you can produce graphic notation.

Hiding notes meant for playback only
If you have recorded your music, you may have added glissandos, falls, etc. that sound fine
but result in a lot of unnecessary notes. You probably want to hide those notes and insert the
suitable symbols instead.

Hiding
To hide items, proceed as follows:
PROCEDURE
1.

Select all the items you want to hide.

2.

Select “Hide/Show” from the Score menu or click the Hide button on the extended toolbar.

Notes can also be hidden by selecting them, clicking the “i” button on the extended toolbar
and ticking the Hide Note checkbox in the Set Note Info dialog.
IMPORTANT
If the Hide option in the filter bar is activated, hidden objects are shown in a lighter tone so
that they are still visible and you can select them.

RELATED LINKS
Other note details on page 84
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Hiding in the current layout only
If you want the hiding to be “local” to the current layout, hold down Ctrl/Cmd when selecting
“Hide/Show”.
IMPORTANT
This is not possible when hiding notes, only other symbols.
NOTE
You can also move hidden objects to the layout by right-clicking the “Hide” marker and selecting
“Move to Layout”.

Viewing hidden objects
The filter bar (shown by clicking the “Set up Window Layout” button on the toolbar and activating
the Filters option) contains two options related to hidden objects:
●

If you activate the “Hidden Notes” option, all hidden notes in the score are shown.
Deactivating “Hidden Notes” hides the notes again.

●

If you activate the “Hide” option, all hidden objects (except notes) are indicated by a “Hide”
text marker.

Showing one object
PROCEDURE
1.

Make sure that “Hide” is activated on the filter bar.

2.

Click the “Hide” text marker below the object you want to display again.
The text is selected.

3.

Press Backspace or Delete.
The object appears. Undo is available if you change your mind.

Showing all objects
If you select “Hide/Show” from the Scores menu again, all hidden objects are displayed.
●

You can also use the Reset Layout function to permanently display hidden notes and
objects.

RELATED LINKS
Reset Layout on page 179

Showing a hidden note
While all hidden notes can be made visible by ticking the Hidden Notes checkbox on the filter bar,
you may want to make some of them “permanently” visible again:
PROCEDURE
1.

Activate the Hidden Notes checkbox on the filter bar.

2.

Select the notes that you want to “un-hide”.
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In the Preferences dialog (Scores–Colors for Additional Meanings) you can set the color for
hidden notes.
3.

Double-click one of the notes.

4.

Deactivate the Hide Note option in the Set Note Info dialog and click Apply.

Coloring notes
You can use the color pop-up menu on the toolbar to colorize selected notes. This is useful for
educational purposes, for example.
RELATED LINKS
Coloring notes on page 86

Multiple rests
Multiple consecutive rests can be automatically displayed as multi-rests.
PROCEDURE
1.

Open the Score Settings and select the Layout page.

2.

Set the Multi-Rests option to the number of empty bars that are “allowed” before Cubase
displays them as a multi-rest.
For example, a value of 2 means that three or more consecutive empty bars are displayed
as a multi-rest. If you set this to “Off”, multi-rests are not used.

3.

Click Apply and close the dialog.

RESULT
The multi-rests now appear in the score.

Splitting multi-rests
To divide one long multiple rest into several shorter ones, proceed as follows:
PROCEDURE
1.

Double-click the multi-rest symbol.
The Split Multi-Rest dialog appears:

2.

In the dialog, enter the bar number where you want the first split.

3.

Click OK.
If you need more splits, double-click any multi-rest symbol and proceed as above.
IMPORTANT
The program automatically splits multi-rests at time signature changes, double barlines,
repeat signs and rehearsal marks.
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Multi-rest appearance
The Project page in the Score Settings dialog contains several subpages, on which you can make
settings for multi-rests:
●

The subpage “Notation Style” contains the following settings concerning multi-rests:

Multi-Rests – Church Style
If this option is activated, multi-rests are shown in “church style” (vertical bars),
rather than with the regular, horizontal symbols.
Multi-Rests – Numbers above Symbol
If this option is activated, the numbers are shown above the multi-rest symbol,
instead of below it.
Multi-Rests – Snap Rests moved with the Layout tool
If this option is activated, rests automatically snap to “intelligent” positions, that
is, positions used in regular notation when moved with the layout tool. If this is
deactivated, rests can be positioned freely.
Bar numbers – Show Range with Multi-Rests
If this option is activated, and bar numbers are displayed, the bar numbers of a
multi-rest are shown as a range.
●

On the Spacings subpage of the dialog, you can adjust the height and width of multi-rest
symbols.

●

On the Font Settings subpage, you can select a font for the multi-rest numbers (select
“Multi-Rests” in the “Font For” pop-up menu and make the desired settings).

Editing existing barlines
For each barline, you can choose whether you want a regular, single barline, a double barline, a
repeat sign, etc.:
PROCEDURE
1.

Double-click the barline for which you want to edit the settings.
A dialog appears with a number of barline types.

2.

If you want the barline to be shown with “brackets”, activate the Brackets checkbox.
This is only relevant for repeat signs.

3.

Click the desired barline type.
The dialog closes and the barline type is changed.

4.

If you do not want to display barlines at the beginning of the parts, open the Score
Settings dialog on the Project–Notation Style subpage (BarLines category) and activate the
“Hide First Barline in Parts” option.
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NOTE
The barline types are part of the Project layer – any changes you make are reflected in all
layouts.

Creating upbeats
The following methods describe how you can create upbeats in the Score.

By using the Pickup Bar feature
With this method, the upbeat actually contains exactly the number of beats displayed. That is, if
you have an upbeat of one beat, your project starts with one bar in 1/4 time.
PROCEDURE
1.

Change the time signature of the first bar to the length of the upbeat.

2.

Insert a time signature of the correct kind (the time signature used throughout the project)
in the second bar.
To insert a time signature, select it in the “Time Signature” section in the Symbols Inspector
and click in the Score with the Draw tool.

3.

Enter the notes in the upbeat into the first bar.

The first bar before making any adjustments

4.

Double-click the time signature for the upbeat bar.
The Edit Time Signature dialog appears.

5.

Activate the “Pickup Bar” option and click OK.

Now, the time signature of the first bar takes on the look of the second bar’s signature,
while the time signature in the second bar is hidden.

6.

If you use bar numbers, double-click the first bar number and enter an offset of -1.

7.

Adjust the display of bar numbers and hide the “0” in the first measure.

By hiding rests
With this method, the first bar actually gets the same time signature as the following bars – it
only looks like an upbeat bar:
PROCEDURE
1.

Enter the notes in the upbeat into the first bar.
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The first bar before making any adjustments

2.

Hide the rests that precede the notes.

3.

Drag the barline between measure one and two to adjust the width of the bar.

After hiding the rest and dragging the barline

4.

If you like, move the notes in the upbeat measure, using the Layout tool.

5.

If you use bar numbers, adjust them.

The final upbeat

Setting the number of bars across the page
You can specify how many bars you want to display across the page.

Automatically
●

When you open a new combination of tracks for editing, the number of bars across the
page is determined by the “Default Number of Bars per Staff” setting in the Preferences
dialog (Scores–Editing page).

●

In the Auto Layout dialog, you can set the maximum number of bars across the staff.

RELATED LINKS
Auto Layout on page 177

Manually
In Page Mode, you have full control over the number of bars appearing across the page, by using
the Number of Bars dialog or the tools.
NOTE
If you want to use the “Max. number of Bars” option in the Auto Layout dialog, you should do this
before you adjust the number of bars manually.

RELATED LINKS
Auto Layout on page 177

Using the Number of Bars dialog
PROCEDURE
1.

Make a staff active in the system where you want to make changes.
This means that if everything looks fine until for example the fifth system, activate one of
the staves in this system.

2.

Open the Scores menu and select “Number Of Bars” from the Advanced Layout submenu.
The Number of Bars dialog opens.
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3.

Set the desired number of bars across the page.
●

To change the number of bars for the active staff only, click “This Staff”.

●

To change the number of bars for the active staff and all following staves, click “All
Staves”.
In other words, to set all systems on all pages to the same number of bars, make
the very first staff active and use the All Staves option.

Using the tools
●

To make a bar “fall down” on a new staff, use the Split tool to click its barline.

Before and after moving the third bar one staff down

●

To bring the bar back up to the previous staff, use the Glue tool to click the last barline on
the upper of the two staves.
This in fact moves all measures in the lower staff to the upper staff.

Moving barlines
The following operations can be made using the regular Object Selection tool or the Layout tool.

Moving a barline
If you drag a barline to the left or right, the surrounding bars are adjusted proportionally.

Moving barlines on all staves
If you hold down Alt when dragging a barline, all barlines below the one you drag are moved
accordingly.
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Moving a single barline separately
If you hold down Ctrl/Cmd while dragging a barline, the widths of the surrounding bars are not
affected.

Making an indent on one line
●

To create an indent, simply drag the first or last barline on a staff.
The sizes of all measures are adjusted proportionally.

Before and after dragging the first barline on the first staff

Making indents on several lines
If you hold down Alt and drag the first or last barline in a system, all following systems get the
same indent. If you want all lines on all pages to be modified in the same way, hold down Alt and
drag the appropriate barline on the first system of the score.

The last barline in the score
Cubase attempts to move the last barline and space the bars on the last line in a sensible way.
But you can change this manually by dragging the last barline if you like. To change the type of
the last barline, double-click it and select the desired type.

Resetting bar spacing
To reset the bar spacing to standard values for several lines, proceed as follows:
PROCEDURE
1.

Locate the first line for which you want to reset the bar spacing, and make one staff in that
system active.

2.

Select “Number of Bars” from the Advanced Layout submenu on the Scores menu.

3.

Specify the number of bars that you already have on the line.

4.

Click “This Staff”.
Clicking “All Staves” resets the lines of all staves in the score.

5.

Close the dialog.
The bar spacing is reset for the selected staff and all following staves.

RELATED LINKS
Using the Number of Bars dialog on page 171

Dragging staves
For the following operations, you can use the Object Selection tool or the Layout tool.

173

Designing your score: additional techniques
Dragging staves
NOTE
Dragging staves can only be done in Page Mode.

Adding space between two grand staves
PROCEDURE
1.

Locate the first staff in the lower of the two systems that you want to spread apart.

2.

Click just to the left of the first barline and keep the mouse button pressed.
The entire staff is selected.

3.

Drag downwards until you have reached the desired distance between the staves and
release the mouse button.

Before and after dragging the upper system.

Setting the same distance between all grand staves
PROCEDURE
1.

Hold down Alt and drag the first staff of the second system, until you have reached the
desired distance between this and the first system.

2.

Release the mouse button.
The distances between all the systems are adjusted accordingly.
IMPORTANT
This operation affects the system you drag and all following systems.

Setting the distance between staves within a grand staff
PROCEDURE
1.

Locate the lower staff in the grand staff that you want to spread apart.

2.

Click just to the left of its first barline and keep the mouse button pressed.
The entire staff gets selected.

3.

Drag downwards or upwards and release the mouse button.
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Dragging apart the staves in a piano system.

The new distance is set for the two staves.

Setting the same distance between staves in several systems
PROCEDURE
1.

Hold down Alt and drag the desired staff.

2.

Release the mouse button.
The corresponding staves in all following systems are moved accordingly.

Moving one staff only
You may want to move one staff without affecting any other staff in any way:
PROCEDURE
1.

Hold down Ctrl/Cmd.

2.

Drag any staff.

Moving staves between pages
By using the “Move to Next/Previous Page” commands on the Staff context menu, you can
quickly edit the page breaks.

Moving staves to the next page
PROCEDURE
1.

Locate and activate the staff you want to move to the top of the next page.
This can be any staff except the first staff on the page.

2.

Right-click the rectangle to the left of the staff, and select “Move to Next Page” from the
context menu.
The active staff (and any following staves on the page) are moved to the next page.

Moving staves to the previous page
PROCEDURE
1.

Make the staff at the top of the page the active staff.
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If any other staff is active, the “Move to Previous Page” option cannot be used. Also, the
function does not work for the first staff on the first page.
2.

Right-click the rectangle to the left of the staff, and select “Move to Previous Page” from
the context menu.
The active staff, and as many of the following staves as there are room for, are moved to
the previous page. If the previous page is already “full”, nothing happens.

Adding brackets and braces
Brackets and braces are added on the Layout page of the Score Settings dialog. The settings you
make are specific for the current layout, that is, you can have different brackets or braces set up
for different track configurations.
PROCEDURE
1.

Open the Score Settings and select the Layout page.
In the track list, you can find columns for braces { and brackets [.

2.

Click in one of the columns and drag downwards in the list to encompass the desired
staves.
The column indicates graphically which staves are encompassed by the brace or bracket.
Click at the first staff for which you want a bracket or brace, and drag downwards in the list
to enclose the desired staves.

3.

Close the dialog.
The score is displayed with brackets or braces according to the settings you made.
●

You can edit brackets and braces in the dialog by dragging the ends of the indicator
in the list.

●

To remove a bracket or brace, click its indicator in the list.

You can automatically get broken barlines based on the brackets you have added.
If the “Show Braces in Edit Mode” option is activated in the Preferences dialog (Scores–
Editing page), brackets and braces are shown in Edit Mode as well.

RELATED LINKS
Breaking barlines on page 180

Displaying the Chord Symbols from the Chord Track
You can display the chord symbols from the chord track. Chord symbols can be viewed, edited,
and printed out in Page Mode.
PROCEDURE
1.

To show the Chord Track symbols, open the Scores menu, and from the Advanced Layout
submenu select “Show Chord Track”.
On the Layout page of the Score Settings dialog you can specify which staff should display
the chord track.
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2.

To edit a chord symbol, double-click it.
NOTE
Moving chord symbols in the staff only affects the display. The position of the chords on
the chord track remains unaffected.

RELATED LINKS
Layout settings on page 163

Auto Layout
This item on the Scores menu brings up a dialog with several options. Activating one of these
makes the program “go through” the score and make adjustments to measure widths, staff
distances, etc. Exactly which parts and properties of the score are affected depends on which
option you activate/deactivate.

IMPORTANT
The automatic layout adjustments are done just as if you yourself had made them manually. This
means that if there is something you do not like, you can always change it manually.
NOTE
You can also open the Auto Layout dialog by clicking the Auto Layout button on the extended
toolbar.

Move Bars
This option looks at the active grand staff, and attempts to adjust the measure widths, so that
all notes and symbols get as much room as possible. The number of bars on the staff is not
affected.
●

You can perform this function for several staves in one go, by dragging a selection
rectangle over their left edges, and then selecting Move Bars.
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Move Staves
This changes the measure width (as with Move Bars) but also the vertical staff distance, of the
active staff and all following staves.

Spread Page
This corrects the vertical layout of the staves on the current page, so that they “fit onto the page”.
In other words, this removes space at the bottom of the page.

Hide Empty Staves
This hides all empty staves, from the active staff to the end of the score. Note that polyphonic/
split staves are in this case treated as one entity if the clef in the upper system differs from that in
the lower system. That is, a piano staff is considered “empty” only if there are no notes on either
staff.
●

If you have activated the “Hidden” option on the filter bar, hidden staves are indicated by a
marker with the text “Hide:Name” (where “Name” is the staff name).
To display hidden staves, delete their “Hide” markers.

●

If you activate the “Auto Layout: Don’t hide first staff” option in the Preferences dialog
(Scores–Editing page), staves in the very first grand staff are not hidden, even if they are
empty.
This is useful for example if you are creating an orchestra score, and want to show the
complete “layout” of the orchestra on the first page of the score, without hiding anything.

All Pages
Activate this if you want to apply the options above to all pages. Please note that this setting is
applied to the active staff and onwards. If you want all pages in the score to be affected, you
have to make the very first staff (the first staff on the first page) the active staff.

Move Bars and Staves
This is a combination of “Move Bars”, “Move Staves”, and “All Pages”, plus automatic calculation
of the number of bars across the page – the function tries to optimize the number of bars across
the page for each staff (with the maximum number of bars as set in the dialog).

Optimize All
All of the above in one fell swoop. This procedure might take some time but usually yields great
results.

Other functions
In the lower part of the dialog, the following options are available:
Auto Space/Page Mode
The higher the value, the more space is allowed for each element in the score (and
thus, the fewer the bars across the page).
Minimum Distance between Staves
When you use an Auto Layout function that moves staves (changes the vertical staff
distance), this setting determines the minimum distance between the staves.
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Minimum Distance between Grand Staves
This sets the minimum distance between Grand Staves in the same way.
Add to Auto Layout Distance
This number is added to the distance between staves that is added when you use
any of the Auto Layout functions. The higher the number, the larger the distance
between staves.
‘Spread Page’ Bottom Distance
This is added to the white space that appears on the bottom of a page when using
the Spread Page functions.
Max. Number of Bars
This allows you to specify the maximum number of bars per staff when using the
“Bars and Staves” or “Optimize All” functions.
NOTE
The functions “Move Bars” and “Move All Bars” (“Move Bars” + “All Pages”) can also be accessed
via the Staff context menu (opened by right-clicking the rectangle to the left of the active staff).

Reset Layout
This function allows you to delete invisible layout elements, which in effect restores the score to
default settings.
PROCEDURE
1.

Select “Reset Layout…” from the Scores menu.
The Reset Layout dialog appears.

2.

Activate the items you want to delete or reset to standard settings.

3.

Click “This Staff” to clean up the active staff only, or on “All Staves” to clean up all staves in
the score.

Reset Layout Options

Hidden Notes
Makes all hidden notes permanently visible again.
Hidden
Makes all other hidden objects permanently visible again.
Quantize
Deletes all Display Quantize elements.
Layout Tool
Resets all positions of notes, clefs, slurs and ties altered using the Layout tool.
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Grouping
Resets the grouping under beams to standard values.
Cutflag
Deletes all cutflag events.
Stems/Beams
Resets the length of all stems and reset the slant of beams that have been manually
adjusted.
Coordinates
Removes all manual spacing of note symbols and slurs.

Breaking barlines
Sometimes you may not want a barline to stretch all the way across a grand staff. If this is the
case, you have the possibility to “break it”.

Manually
You can break the barlines in one grand staff or in several grand staves and re-connect them.

Breaking barlines in one grand staff
PROCEDURE
1.

Select the Erase tool.

2.

Click a barline connecting the two staves.

Before and after splitting the barlines between two staves.

All barlines between these two staves (except the first and last) are broken. To break the
first or last barline in a grand staff, you need to click directly on these.

Breaking barlines in several grand staves
If you hold down Alt and click a barline, the corresponding barlines are broken in all following
grand staves.

Re-connecting broken barlines
If you have broken the barlines, you can use the Glue tool to connect them again.
PROCEDURE
1.

Select the Glue tool.

2.

Click one of the barlines in the staff above the broken barlines.
All barlines between these staves in this grand staff are connected.
To re-connect barlines in several grand staves, hold down Alt and click with the Glue tool.
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Breaking barlines
The barlines between the corresponding staves are connected in all following grand
staves.

Automatically
If you have added brackets for some staves on the Layout page of the Score Settings dialog, you
can have barlines broken between each bracketed “section”, giving a clearer indication of which
staves belong together:
PROCEDURE
1.

Open the Score Settings dialog from the Score menu and, on the Project page, select the
“Notation Style” subpage.

2.

In the Barlines section, locate and activate the “Break Barlines with Brackets” option.
The option Break Last Brackets determines whether the breaking of barlines should also
apply to the barline at the end of each row.

RELATED LINKS
Adding brackets and braces on page 176
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About this chapter
In this chapter you will learn:
●

How to set up the drum map.

●

How to set up a staff for drum notes.

●

How to enter and edit drum notes.

●

How to use a single line drum staff.

Background: Drum maps in the Score Editor
When scoring for drums, you can assign a unique note head to each pitch. There is even the
possibility to set up different note heads for different note values!
However, to be able to fully use this function, you need to understand a bit about drum maps,
and the use of these in the Score Editor.

About drum maps
Cubase handles drum editing by means of drum maps. In the Score Editor, the drum map
displays different note heads for different pitches.
You access the drum map by selecting “Drum Map Setup” from the MIDI menu.
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Use Score Drum Map on/off
For the drum map settings to be used in the score, you need to activate the “Use Score Drum
Map” option in the Score Settings dialog on the Staff page (Options tab).

Setting up the drum map
To set up the drum map, proceed as follows:
PROCEDURE
1.

Open the Score Editor for the drums track.
This should be a MIDI track to which you have assigned a drum map.

2.

Open the Score Settings dialog and select the Staff page.

3.

Select the Options tab and activate the “Use Score Drum Map” option.

4.

On the MIDI menu, select “Drum Map Setup”.
The Drum Map Setup dialog appears.

5.

Make settings for the sounds/MIDI notes you need.
IMPORTANT
Please note that many different drum maps can be created for a project. Which one
you get depends on which drum map is assigned to the edited track. These drum maps
are totally independent of one another, that is, each pitch can have different settings in
different drum maps.

Score related options
Pitch
This corresponds to the I-note of the sound in the drum map, and cannot be edited
here.
Instrument
The name of the drum sound in the map.
Display Note
The display pitch, that is, the pitch at which the note is shown in the score. For
example, you typically want all three hi-hat sounds to be shown on the same system
line in the score (but with different symbols). Therefore, you set these to the same
display pitch.
Head Symbol
Clicking in this column opens a window in which you can select a note head symbol
for the sound. If “Use Head Pairs” is activated in the dialog, you can select a note
head pair instead.
Voice
This allows you to make all notes with this pitch belong to a certain voice, so that
they get a common rest handling and stem direction, for example.
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Using note head pairs
Not only can you have different drum sounds displayed with different note heads, you can also
display different note heads for different note values:
PROCEDURE
1.

Activate the “Use Head Pairs” checkbox.
The “Head Symbol” column now shows two head symbols for each drum sound.

All head symbols are arranged in pairs – by default an “empty” head and a “filled” head.
Just as with regular notes, the “empty” note heads are used with half notes and larger note
values, and the “filled” heads are used with quarter notes and smaller note values.
2.

To select a head pair for a drum sound/note, click in the Head symbol column to open the
pop-up menu and choose the new head pair.

Customizing note head pairs
If you do not like the default pairs of note heads, you can edit these:
PROCEDURE
1.

On the Functions pop-up menu, select “Edit head pairs”.

2.

To change a symbol in a pair, click on it and select a new symbol from the pop-up menu.

3.

Click Exit.

Editing the drum map in the score
If you activate the “Edit in Scores” option in the Drum Map Setup dialog, you can change the
settings for the score drum map directly in the score:
●

Transposing a note changes the display pitch of its drum sound – the actual note is not
transposed.

●

Double-clicking a note allows you to make note head settings for that drum sound.

●

Using the “Move to Voice” function changes the voice assignment of the drum sound.
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NOTE
This requires that you leave the Drum Map Setup dialog open – closing the dialog automatically
deactivates this option, allowing you to perform normal editing.

Setting up a staff for drum scoring
PROCEDURE
1.

Open the Score Settings dialog on the Staff page and select the Options tab.

2.

Make sure that “Use Score Drum Map” is activated.

3.

If you want a single line drum staff, activate the corresponding option.

4.

If you want flat beams, activate the corresponding option.

5.

If you want all stems to end at the same position, activate Fixed Stems and set a length for
up/down stems.

You may also want to use polyphonic voices to handle rest and stem separately.
However, you can still activate the “Fixed Stems” option if you like.

RELATED LINKS
Using “Single Line Drum Staff” on page 185
Polyphonic voicing on page 199
Handling beaming on page 88

Entering and editing notes
This is like entering notes on a normal note system. However, Notes are edited using their
display pitch when the drum map is used. This means that when you move a note vertically,
you move it to another display pitch. What actual pitch it gets depends on which pitch uses the
display pitch you now “dropped it on”.
NOTE
If the drum map contains two notes with the same pitch (for example open and closed hi-hat),
you can get the second note by holding Ctrl/Cmd.

Using “Single Line Drum Staff”
If this option is activated on the Options tab of the Staff page in the Score Settings dialog, there
is only one line in the system. Furthermore, notes can only appear below the line, on the line and
above the line.
To decide which notes go where, proceed as follows:
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PROCEDURE
1.

Open the Score Settings dialog on the Staff page and select the Options tab.

2.

Activate “Use Score Drum Map” and “Single Line Drum Staff”.

3.

Set up the two pitch values to decide which pitches go on the line.
Notes below this range automatically wind up below the line and notes above wind up
above the line.
IMPORTANT
When you enter and edit the pitch of notes on a single line drum staff, the best way is to
drag the note up or down while watching the Mouse Note Position display in the status
line.
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About this chapter
In this chapter you will learn:
●

How to create tablature, automatically and manually.

●

How to control the appearance of the tablature notes.

●

How to edit tablature.

Cubase is able to produce score in tablature format. This can be done automatically, by
“converting” recorded MIDI information. You can also create a tablature staff from scratch and
enter the notes “by hand”.
IMPORTANT
Even though we use the term “converting” in this chapter, please note that tablature is a mode.
You can switch between regular notation and tablature at any time.

Creating tablature automatically
This assumes you have a regular score on screen already. We also suggest you perform
basic editing like quantizing to make the score as legible as possible as regular notes before
converting into tablature.
PROCEDURE
1.

Make sure that the notes in the score are inside the range of the instrument.
Notes with a pitch lower than the open tuning of the lowest string cannot be converted.

2.

Open the Score Settings dialog on the Staff page and select the Tablature tab.

3.

Activate “Tablature Mode”.
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4.

Select one of the predefined instruments from the pop-up menu.
●

If you are not using one of the predefined instruments, set the open tuning of each
string using the value fields.
You can create tablature for up to 12 strings. To disable a string, set it to Off, the
lowest value.

5.

If you want to use a capodaster on the forth fret, for example, enter the corresponding
value in the Capo field.
The tablature changes accordingly.

6.

Make the desired settings for “No Stems/Rests” and “MIDI Channel 1–6”.
No Stems/Rests gives you a score where the notes have no stems and where all the rests
are hidden. The “MIDI Channel 1–6” feature is described below.

7.

Click Apply.
The tablature appears. You get as many note lines as you have activated strings. All the
notes now have a fret number instead of their regular note heads.

Before and after activating tablature mode.

8.

Edit the score, if needed.
You can make Display Quantize settings, add symbols, etc. as usual. However, editing the
actual notes is a bit different from regular note editing.

Using “MIDI Channel 1–6”
This feature makes notes automatically appear on the correct string according to their MIDI
channel value.
Normally, the program automatically decides on which string to display a note, by looking at the
pitch and then putting the note at the lowest possible string. You can then either manually move
a note to the correct string, or use the “MIDI Channel 1–6” option to let the program move the
notes automatically.
PROCEDURE
1.

Many guitar synthesizers are able to transmit each string on a different MIDI channel. If
you have such an instrument, set it up so that the high E string transmits on MIDI channel
1, the B string transmits on MIDI channel 2, etc.
This feature can be used for MIDI string instruments with up to six strings.

2.

Record the project. Quantize and edit it as desired.

3.

Make sure that the “MIDI Channel 1–6” option is activated and convert the notes into
tablature.

4.

The notes are automatically placed on the right strings.
For example if you played a “B” on the low E-string, it appears as a “7” on that string, not as
a “2” on the A-string.
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Creating tablature manually
To set up an empty system for inputting tablature, proceed as follows:
PROCEDURE
1.

Double-click on the clef symbol in the score to open the Edit Clef dialog.

2.

Change the clef to the tablature symbol.

3.

Open the Score Settings dialog on the Staff page and select the Options tab.

4.

Set the “System Lines” to as many strings as the instrument you are scoring for has.

5.

Raise the Add Space value to 1 or 2.
You need a little extra space between note lines to make room for the numbered note
heads.

Suggested system line settings for guitar tablature

6.

On the Tablature tab, activate “Tablature Mode”.

7.

Set up whatever other parameters you need in the dialog, and click Apply.

8.

Select the Insert Note tool and move the pointer over the score.

9.

Press the mouse button and drag up and down until the note appears on the desired
string with the correct fret number (you can also verify the pitch on the toolbar, as usual).
When you drag up and down, the program automatically selects the lowest possible string.
If you want a fret number higher than 4 on a guitar tablature, for example, you have to use
“Move To String”.

Setting the correct pitch. Use the Mouse Note Position display in the status line as an additional guide.

10.

Release the mouse button.
The note is displayed.
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Tablature number appearance
In the Score Settings dialog on the Project–Font Settings subpage, you can find settings for
the tablature numbers. In the “Font For” pop-up menu, select “Tablatures” and then select the
desired font, size, and style for the number note heads.

Editing
Tablature can be edited like any other score. You can move notes, handle beaming, stem
direction, etc.

Moving notes to another string
If you want for example a “C” to appear as an “8” on the low E-string rather than a “3” on the Astring on a guitar, proceed as follows:
PROCEDURE
1.

Select one note or a number of notes that you want to move to a new string.

2.

Right-click on one of the selected notes and, from the “Move to String” submenu, select the
desired string.
The Fret number is automatically adjusted according to the tuning of the instrument (as
set up on the Tablature tab of the Staff page in the Score Settings dialog).

Moving notes
Moving notes in pitch in a tablature score is working the same way as entering notes manually,
see above.

Editing on the info line
You can change the pitch of notes on the info line as usual. The string and fret number are
updated automatically in the score.

Note head shape
If you only want to enter a fret number for your notes (Tablature mode off), you can use the Set
Note Info dialog on regular notes.
PROCEDURE
1.

Double-click on the head of a note.
The Set Note Info dialog appears.

2.

Activate the Tablature option and set a fret number in the value field to the right.

3.

Click Apply.
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In Cubase you can display your score in rhythmic notation. This is useful if you want to focus on
rhythmic information only. Rhythmic notation can also help you to create lead sheets.
You can display your full score or selections of it in rhythmic notation. The smallest possible
selection that you can show in rhythmic notation is a bar. Even if you only select one note, the
display for the whole bar changes.

In split systems you can display one staff in regular notation and the other one in rhythmic
notation.

If you work with polyphonic voices, you can display one voice in regular notation and the other
one in rhythmic notation.

IMPORTANT
Rhythmic notation is a display function and therefore non-destructive. You can switch between
regular notation and rhythmic notation at any time.

RELATED LINKS
Moving notes between voices on page 73

About this Chapter
In this chapter you will learn:
●

How to show rhythmic notation in your score.

●

How to change the appearance and style of rhythmic notation.
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RELATED LINKS
Showing Rhythmic Notation on page 192
Notation Style on page 194

Showing Rhythmic Notation
You can show regular notation as rhythmic notation.
PREREQUISITE
You have opened your score in Cubase and you have performed basic editing to make the score
as legible as possible.
PROCEDURE
1.

Select the notes that you want to display as rhythmic notation.

2.

Select Scores > Rhythmic Notation > Show Rhythmic Notation.

RESULT
The selected notation is displayed in rhythmic notation:
●

Note heads change shape.

●

Pitches are suspended so that all rhythm note heads are shown at the same vertical
position.

●

Chords are suspended and represented by a single note head.

●

Ties between rhythm notation and regular notation bars are suspended.

●

Bars that do not contain notes are filled with as many slashes as correspond to the
numerator of the time signature.

RELATED LINKS
Notation Style on page 194
Showing Regular Notation on page 193

Rhythm Bar Indicators
Rhythm bar indicators display markers in the score where rhythmic notation is shown instead of
regular notation.
You can show rhythm bar indicators in your score by activating the Cut/Rhythm option in the
Filter bar in the Score Editor.

To hide rhythm bar indicators, deactivate the Cut/Rhythm option.
NOTE
Rhythm bar indicators are not printed.
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RELATED LINKS
Showing Rhythmic Notation on page 192

Showing Regular Notation
You can suspend rhythmic notation and show the regular notation again.
PREREQUISITE
Parts of your score are shown in rhythmic notation.
PROCEDURE
1.

Select the notes that you want to display as regular notation.

2.

Select Scores > Rhythmic Notation > Show Regular Notation.

RESULT
The selected notation is displayed as regular notation.
●

Rhythm note heads are shown as regular note heads.

●

Note pitches, chords and ties are shown.

●

Bars that are filled with slashes are shown with rests.

RELATED LINKS
Showing Rhythmic Notation on page 192

Clearing Bars
You can clear one or more bars so that notes and rests are hidden. This allows you to focus on
specific parts of your score, without deleting these bars that you do not want to show.
PROCEDURE
1.

Select one or more notes of the bar that you clear.

2.

Select Scores > Rhythmic Notation > Clear Bar.

RESULT
All notes and rests are hidden from the bar. The bar itself is still displayed.
NOTE
Clearing bars is a display option that does not affect playback. All notes and rests are played back
as usual.
AFTER COMPLETING THIS TASK
To recover your regular or rhythmic notation, select the bar by clicking the rhythm bar indicator
and show rhythmic or regular notation as usual.
RELATED LINKS
Rhythm Bar Indicators on page 192
Showing Rhythmic Notation on page 192
Showing Regular Notation on page 193
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Showing Repeat Bar Signs
You can show a repeat bar sign that replaces the regular or the rhythmic notation in one or more
bars.
PROCEDURE
1.

Select one or more notes.

2.

Select Scores > Rhythmic Notation > Show Bar Repeat Sign.

RESULT
All notes and rests are hidden from that bar and a repeat bar sign is shown instead.
NOTE
Showing a repeat bar sign is a display option that does not affect playback. All notes and rests
are played back as usual.
AFTER COMPLETING THIS TASK
To show the regular or the rhythmic notation again, right-click the bar repeat sign and select
Show Regular Notation or Show Rhythmic Notation.

Notation Style
The Notation Style page in the Score Settings dialog contains options that allow you to change
the appearance of the rhythmic notation.
●

To open the Rhythmic Notation options, select Scores > Settings and in the Pages list to
the left, select Notation Style.

Filled Note Head
Allows you to select a note head for quarter notes, eighth notes, sixteenth notes, etc.
Outlined Note Head
Allows you to select a note head for whole notes and half notes.
Display Ties Across Barlines
If you activate this option, notes that are tied across barlines in regular notation are
shown with a tie symbol in rhythmic notation.
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About this chapter
In this chapter you will learn:
●

How to use the Arranger mode to have the playback follow the structure of the score.

●

How to use the “mapped” Dynamics symbols.

NOTE
You can also play back articulations in the Score using the Expression Map and Note Expression
functions.

Scores and the Arranger mode
Repeats (barlines) appear in all layouts, as well as Project symbols like Segnos, Codas, Da Capo,
endings, etc. To have the playback in Cubase follow these directions, proceed as follows:
PROCEDURE
1.

Add the desired repeats and project symbols to the score.

2.

Right-click the toolbar in the Score Editor and make sure that “Arranger” is ticked.
This adds the Arranger buttons to the toolbar.

3.

Click the “Activate Arranger Mode” button on the toolbar and start playback.
Playback follows the repeats and Project symbols in the score – sections within repeat
symbols are repeated, the playback position jumps to the beginning when encountering a
Da Capo symbol, and so on.

Working with mapped dynamics
Apart from the dynamics symbols found in the Dynamics section, you can also use 12 “mapped”
Dynamics symbols. These make use of the Note Expression functionality in Cubase. Mapped
Dynamics symbols can be played back using three different methods: by modifying the velocity
values in percentages, by sending volume controller messages or by sending additional generic
controllers. These methods can also be combined.

Setting up the symbols
You can make settings for the symbols in the Dynamics Mapping Setup dialog. On the left in the
upper section, the available symbols are listed.
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●

To open the dialog, right-click on one of the symbols in the Dynamics Mapping section in
the Symbols Inspector and select “Dynamics Mapping…”.
When mapped dynamics symbols have been added to the score, you can also double-click
on a symbol to open the dialog.

In the dialog, you can make the following settings:

Change Velocities
You can create dynamics by defining different velocities for the different symbols.
PROCEDURE
1.

Activate the “Change Velocities” checkbox in the lower section of the dialog.

2.

Set up a percentage value (positive or negative) in the Velocity column to specify by how
much the corresponding symbol will raise or reduce the current velocity value of a note.

Send Volume
You also have the possibility to define the dynamics by sending Volume controller values.
PROCEDURE
1.

Activate “Send Volume” in the lower section of the dialog, and select whether you want to
use the MIDI controllers 7 or 11 or the VST 3 parameter Volume (if the instrument you are
using is compatible with VST 3).

2.

Set up a percentage value (positive or negative) in the Volume column to specify by how
much the corresponding symbol will raise or reduce the current volume of a note.
NOTE
If “Send Volume” is activated and set to VST 3 Volume, the VST 3 volume events in the notes
are being merged with the volume specified for the Dynamics symbols, according to the
Merge Mode setting. However, make sure that the edited part does not contain events for
MIDI controller 7 (Main Volume) or 11 (Expression) on the controller lane.
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The Merge modes
When you use the parameter VST 3 Volume in the notes and for the dynamics symbols, the result
depends on the Merge Mode. The following modes are available:
Average
When this is selected, the average of the two volume messages will be used for the
notes.
Merge
When this is selected, the VST 3 Volume setting for the Dynamics symbols modulates
the existing VST 3 Volume setting of the notes. Higher settings increase the volume
and low settings decrease the volume set for the note.

Send Controller
You can also send an additional MIDI controller (except MIDI controllers 7 and 11, which are used
for the “Send Volume” function).
If you combine this with the “Send Volume” function, you can set up a sound which gets brighter
as it gets louder, which is useful when working with strings or woodwind and brass instruments.
PROCEDURE
1.

Activate “Send Controller” and specify the controller you want to use in the pop-up menu.
You can select any of the available MIDI controllers, but also VST 3 parameters (except
Volume, Pan, and Pitch).

2.

Set up a percentage value (positive or negative) in the Controller column to specify by how
much the corresponding symbol will raise or reduce the controller value of a note.

Initializing the Dynamic Range
You can specify the dynamic range for the work with mapped dynamics symbols using the popup menu in the middle section of the dialog.

If you select “pp-ff”, the extreme Dynamics symbols (pppp, ppp, ffff, and fff) do not have an
effect. If you select “pppp-ffff”, the whole dynamic range will be used.

Using dynamics symbols in the Score Editor
Once you have set up the dynamics as desired, you can use the symbols in the Score Editor.

Inserting dynamics symbols
When you insert dynamics symbols, note the following:
●

Select the desired symbol in the Inspector section and click at the position in the Score
Editor at which you want to insert the symbol.
Note that the “mapped” dynamics symbols have a different color scheme than the regular
dynamics symbols.

●

Crescendi and Decrescendi are updated intelligently, that is, when you have inserted a
crescendo between two dynamics symbols and the order of these symbols is reversed, the
decrescendo automatically becomes a crescendo.
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●

When you insert a crescendo symbol which is not preceded by a Dynamic symbol, the
“assumed” start value is mezzo forte (mf).

●

Likewise, if a crescendo symbol is not followed by a dynamic symbol, an end value will be
calculated automatically.
For a crescendo, this is one value above the start value, and for a decrescendo one value
below the start value.

Modifying/Editing dynamics symbols
You can change the settings for the dynamics symbols at any time in the Dynamics Mapping
Setup dialog.
●

You can step between the available dynamics symbols by using the commands “One up”
and “One down” on the context menu, by using the corresponding key commands, or by
clicking the “+” and “-” buttons on the toolbar.
When several dynamics symbols are selected, they will all be modified accordingly.
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Overview
This chapter provides useful information about editing techniques and answers to a number
of questions that might arise when you use the Score Editor. For more information about the
functions referred to, please use the index and check the previous chapters.

Useful editing techniques
Use this section to find out more about some editing techniques that help you to use the score
functions more efficiently.

Moving a note without transposing it
If you hold down Ctrl/Cmd while moving a note (or several notes), only horizontal movements
are possible, so that you do not have to worry about the notes being transposed. You can also
set up a key command for this. This is done in the Key Commands dialog (Nudge category).

Moving and spacing several staves
If you have a number of staves that you want displayed with an equal distance (for example, all
strings of a grand staff in a full orchestra score), this can be done using the Position Info window:
PROCEDURE
1.

Open the Preferences (Scores–Editing page) and deactivate the “Global staff Spacing with
Alt-Ctrl/Cmd” option.

2.

In the score, select the staves you want to set to an equal distance.

3.

Open the Position Info window by clicking on the ruler.

4.

Use the To Previous Staff or To Next Staff settings to specify the desired distance between
the staves.
All selected staves are spaced according to your settings.
If you do this when the “Global staff Spacing with Alt-Ctrl/Cmd” option is activated, all
staves in the score are affected.

Polyphonic voicing
If you are working on a full score with more than one instrument in one staff (2 flutes, 2
trumpets, etc.), you should use polyphonic voices. And even if both instruments play the same
notes, you should insert notes for both instruments (you can mute the notes of the second voice
if playback is an issue). If you do this, it is much easier to extract single parts later by using the
“Extract Voices” command.
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Using the bar handles
Double-clicking a bar handle opens the Bar Copy dialog. This function is great for copying
accents, but you can also use it for copying drum phrases, etc.
●

If you hold down Shift and double-click on a bar handle, this and the next bar are selected.
This is handy when copying phrases of two or more bars in one go.

RELATED LINKS
Moving and duplicating with the bar handles on page 121

Copying a section with “invisibles”
If you want to copy and paste a section which contains hidden elements, adjusted beams and
stems, etc., there are two ways to proceed:
●

Use the filter bar to make indicators appear in the score. Then select these indicators
together with the notes before you copy.
This ensures the notes are copied with their formatting, etc.

●

Double-click the bar handle of one of the bars, and make sure all relevant event types are
activated in the dialog. Then select the bars you want to copy by clicking their bar handles,
and copy them by Alt-dragging the bar handles.

RELATED LINKS
Moving and duplicating with the bar handles on page 121

Using “Scores Notes To MIDI”
This function converts the score data, as displayed, into MIDI data. Let’s say for example that
you have set up the score so that it is displayed to 99 % the way you want it to be. Yet, that last
1 % forces you to deactivate some of the Staff Settings (like Clean Lengths, No Overlap, or Auto
Quantize), which makes other parts of the score illegible. In this case, try using the “Scores Notes
To MIDI” function. Note that you should work on a copy of the track!
RELATED LINKS
Using "Scores Notes To MIDI" on page 37

Optimizing rests
If you have a number of consecutive empty bars, you can replace them with one multiple rest.
RELATED LINKS
Multi-Rests on page 164

Zero system lines
Having no system lines at all might seem like a stupid idea to start with. But this option allows
you to create chord sheets really quickly.

A lead sheet created by specifying “0” system lines
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RELATED LINKS
Using Make Chord Symbols on page 136

Examples and scales
If you are creating scale examples and similar, you can use the Real Book option and manually
hide all symbols at the beginning of the first staff to make the score appear like separate
unconnected “lines”.
Remember you can also hide the barlines.

An example scale without barlines.

Controlling the order and appearance of grace notes
Normally, grace notes are beamed. Their order under the beam is controlled by their order in the
track. It is enough to put a grace note one tick before the next grace note to make them appear
in the desired order under the beam.
Initially the grace notes are put in with a 32nd note beam. By double-clicking the note and
changing the “flag” type in the Set Note Info dialog, you can change this.

Complex grace notes

Speeding up inserting key changes
If you have a grand staff with many instruments, inserting key changes one by one can take a lot
of time.
In this case, activate “Key Changes for the entire Project” on the Key context menu or in the Score
Settings dialog, on the Project–Notation Style subpage (Keys category). This way, all changes
made to the key always affect the entire project.

Speeding up inserting staccato and accents
Symbols linked to notes can also be put in for a number of notes at the same time, even on
different staves.
RELATED LINKS
Adding a symbol to several notes using the Draw tool on page 109

Setting the distance between staves in a piano score
Drag the first bass staff on the first page. This copies the spacing to all staves. Please note that
this can only be done in Page Mode.
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Frequently asked questions
In this section, you can find some answers to questions concerning adding and editing of notes
as well as the handling of symbols and layouts.

I enter a note with one value and it is shown as a note with another
value.
Set the Rests value for Display Quantize to a smaller note value. Try deactivating Auto Quantize,
especially if you do not have any triplets or triplets only.

Notes are not displayed at the correct positions.
Try changing the Notes value for Display Quantize.

There are a number of short rests after my notes.
Your Rests value for Display Quantize might be set to too small a note value. Raise it. Also check
the “Clean Lengths” setting.

When I change the length of a note, nothing happens.
This is because the Display Quantize value puts a restriction on what note values can be
displayed. Check that Display Quantize is set to the smallest note value you have in your project.

I have adjusted Display Quantize and the other staff settings best I
can. The notes are still shown with the wrong values.
You might need to use one of these three features: inserting Display Quantize events, using
polyphonic voicing, or applying “Scores Notes To MIDI”.

In the Score Settings dialog, I change the Display Quantize settings
on the Staff page (Main subpage) and nothing happens.
Did you remember to click Apply? Maybe you have already inserted Display Quantize events in
the score? These override the staff settings.

Suddenly many Display Quantize events appear in the score.
This is not a malfunction. If you had Auto Quantize on and start inserting Display Quantize
events, the auto quantizing is automatically transformed into Display Quantize events.

One long note is shown as many tied notes.
Do other notes occur at the same positions but with different lengths? Then you need to use
polyphonic voicing. Are the notes syncopated? Then you should try the syncopation feature.

Even though I’ve tried the above, notes are not tied as I want them.
The way notes are tied in Cubase follows basic notation rules. You may need to make exceptions
to these rules, by using the Cut Notes tool.

202

Tips and Tricks
Frequently asked questions

I have an unnecessarily large amount of rests.
Especially with polyphonic voicing, superfluous rests may be created. Try deactivating rests for
one or more voices. You might also leave the rests activated in the Score Settings dialog on the
Staff page (Polyphonic tab) and then hide the rests you do not need, one by one.

When using polyphonic voices, a number of rests are drawn on top
of each other.
As above, you should try hiding rests in the Score Settings dialog on the Staff page (Polyphonic
tab), center rests and possibly manually moving or hiding rests.

In polyphonic voices, notes that are on the same musical position
are not displayed exactly vertically above each other.
This is not a malfunction. Cubase has built-in automatic algorithms for making the score as
legible as possible. Sometimes this includes adjustments of the “graphic” position of notes,
especially with small intervals like seconds. You can always move the notes using the Layout tool.

When using polyphonic voices, notes with small intervals “collide”.
Cubase tries to avoid this, but only for voices 1 and 2 in the upper staff and voices 5 and 6 in the
lower. For other voices, please use the Layout tool to manually move the notes.

When I select a note, nothing is shown on the info line.
The note is probably tied to another note. This means that the second note does not really exist,
it is just a graphic indication that the main note is long. Try selecting the main note instead.

Symbols from the Layout Symbols section are sometimes invisible
when I open the score.
This is not a malfunction. Those symbols are part of a layout. If you open the score with another
layout, for example because you open another combination of tracks, you can see another layout
which might not contain any Symbols at all.
RELATED LINKS
Working with layouts on page 154

I can’t select an object on the screen, or I can’t select an object
without selecting another object.
Drag a selection rectangle around the objects. Then hold down Shift and deselect all the objects
you do not want included, by clicking on them. You should also check out the lock layer function.

Symbols have disappeared.
Are they layout symbols? Then maybe they belong to another layout than the one you are editing
now.
If that is not the reason, maybe you have inserted the symbol into the wrong staff.
RELATED LINKS
Important! – Symbols, staves, and voices on page 107
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A symbol doesn’t move with its staff. Auto Layout produces far too
wide spacing.
Maybe you have inserted the symbol into the wrong staff.
RELATED LINKS
Important! – Symbols, staves, and voices on page 107

A note symbol appears too far from the note I wanted it inserted on.
Have you activated the correct voice? Note symbols are inserted into voices, just like notes.

The note I recorded is displayed with the wrong length. For example,
I recorded a sixteenth and got a quarter note.
You probably have the wrong Display Quantize value set. Open the Score Settings dialog and
select the Staff page. If Auto Quantize is activated, deactivate it, unless you have mixed triplets
and regular notes. Also check the Notes and Rests Display Quantize values. If the settings are too
“coarse”, change them to a smaller note value. If you for example need the program to display
an eighth note rest, Rests Display Quantize must be set to “8” or a smaller value. If No Overlap is
activated, you might want to turn it off.
RELATED LINKS
How the Score Editor works on page 8

There is a pause after a note that I don’t want.
You probably added a note with the wrong note value. Either lengthen the note (physically or
graphically) or delete the one you have and add a new one with the correct note value. If this
problem occurs a lot in your score, try selecting a larger Rests Display Quantize value.
RELATED LINKS
Changing the length of notes on page 51
Deleting notes on page 57
Using Rests as Display Quantize setting on page 10

There is no pause after the note although there should be one.
Either the note is too long (use Clean Lengths or change the current note’s length), or Rests
Display Quantize is set to too high a value. Open the Score Settings, select the Staff page and
lower the value.

The note has an accidental when it shouldn’t, or it doesn’t when it
should.
Maybe the note is simply of the wrong pitch? Click on it (using the Object Selection tool) and look
at the info line. Move it to the correct pitch. If this is not the reason, maybe you have the wrong
key set? And finally, you can also use enharmonic shifting.
RELATED LINKS
The info line on page 18
Editing pitches of individual notes on page 50
Accidentals and enharmonic shift on page 82
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Notes are not grouped under beams the way I want it.
Normally the program groups eighth notes, sixteenths, etc. under beams. This can be
deactivated. There is also detailed control of which notes are grouped under a beam.
RELATED LINKS
Handling beaming on page 88

If you wish you had a faster computer
Here are some tips for those who find some operations slower than they would like:
●

Work on a smaller section of the score at a time. Break the project up into parts and work
on those parts individually until the final layout stage.

●

Switch on multi-rests as late as possible.

●

When working in Edit Mode, set Default Bars Across The Staff to a small value, for example
2.

●

In Edit Mode, resize the window so that only one grand staff at a time is visible.

●

Consider upgrading your computer hardware.
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